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Chapter 1: Installation and Configuration

Chapter 1:

Installation and Configuration

Files and Directories

File Naming Conventions

The following file naming conventions have been adopted for the various files dis-
tributed with and used by Dyalog APL/W.

Extension Description

.DWS Dyalog APL Workspace

.DSE Dyalog APL Session

.DCF Dyalog APL Component File
DXV Dyalog APL External Variable
.DIN Dyalog APL Input Table
.DOT Dyalog APL Output Table
.DFT Dyalog APL Format File
.DXF Dyalog APL Transfer File
.DLF Dyalog APL Session Log File
.dyalog Dyalog APL SALT file

.dyapp Dyalog APL SALT application file
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Unicode and Classic Editions

Dyalog APL continues to be available in two separate editions; Unicode and
Classic.

e The Unicode edition is intended for users who need to develop Unicode
applications now, and are prepared to make the necessary (usually small)
changes to existing applications in order to support new Unicode character
types.

e The Classic edition is intended for customers who want to take advantage
of other product enhancements, but do not wish to use Unicode at this time.

The two different editions are maintained from the same source code, and every effort
will be made to ensure that they are identical except for the handling of character
arrays, and the transfer of data into and out of the workspace.
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APL Fonts

Unicode Edition

The default font for the Unicode Edition is APL385 Unicode! which isa TrueType
font and is installed as part of Dyalog APL. APL385 Unicode is the font used to print
APL characters in this manual. In principle, you may use any other Unicode font that
includes the APL symbols, such as Arial Unicode MS (available from Microsoft).

Classic Edition

In the Classic Edition, there are two types of APL font provided; bitmap (screen) and
TrueType. There are also two different layouts, which referred to as Std and A/¢.

The bitmap fonts are designed for the screen alone and are named Dyalog Std and
Dyalog Alt. The TrueType fonts have a traditional 274 1-style italic appearance and
are named Dyalog Std TT and Dyalog Alt TT!.

The Std layout, which was the standard layout for Versions of Dyalog APL up to Ver-
sion 10.1 contains the APL underscored alphabet A-Z. The underscored alphabet is
a deprecated feature and is only supported in this Version of Dyalog APL for back-
wards compatibility.

The Alt layout, which replaced the Std layout as the standard layout for Version 12.0
Classic Edition onwards, does not have the underscored alphabet, but contains addi-
tional National Language characters in their place. Note that the extra National Lan-
guage symbols share the same [JAV positions with the underscored alphabet. If, for
example, you switch from the Std font layout to the alternative one, you will see the
symbol A (A-acute) instead of the symbol A (A-underscore).

You may use either a bitmap font or a TrueType font in your APL session (see "Ses-
sion Operations " on page 120 for details). You MUST use a TrueType font for print-
ing APL functions.

IThe Dyalog Std TT, Dyalog Alt TT, and APL385 Unicode fonts are the copyright of
Adrian Smith.
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Interoperability

Introduction

Workspaces and component files are stored on disk in a binary format (illegible to
text editors). This format differs between machine architectures and among versions
of Dyalog. For example a file component written by a PC may well have an internal
format that is different from one written by a UNIX machine. Similarly, a workspace
saved from Dyalog Version 13.1 will differ internally from one saved by a previous
version of Dyalog APL.

It is convenient for versions of Dyalog APL running on different platforms to be able
to interoperate by sharing workspaces and component files. From Version 11.0, com-
ponent files and workspaces can generally be shared between Dyalog interpreters run-
ning on different platforms. However, this is not always possible, for example:

e Component files created by Version 10.1 can often not be shared across plat-
forms, even when used by later versions.

e Small-span (32-bit) component files become read-only when opened on a
different architecture from that on which they were created.

Note however that the system function JF COPY can be used to make a logically iden-
tical copy of an old file, which is fully inter-operable.

The following sections describe other limitations in inter-operability:

Code

Code which is saved in workspaces, or embedded within (JORs stored in component
files, can generally only be read by the version which saved them and later versions
of the interpreter. In the case of workspaces, a load (or copy) into an older version
would fail with the message:

this WS requires a later version of the interpreter.

Every time a [JOR object is read by a Version later than that which created it, time
may be spent in converting the internal representation into the latest form. Dyalog
recommends that [JOR should not be used as a mechanism for sharing code or objects
between different versions of APL

"Ordinary" Arrays

With the exception of the Unicode restrictions described in the following par-
agraphs, Dyalog APL provides inter-operability for arrays which only contain
(nested) character and numeric data. Such arrays can be stored in component files - or
transmitted using TCPSocket objects and Conga connections, and shared between
all versions and across all platforms.



Chapter 1: Installation and Configuration

As mentioned in the introduction, full cross-platform interoperability of component
files is only available for large-span component files (see the following section), and
for small-span component files created by Version 11.0 or later.

32 vs. 64-bit Component Files

Large-span (64-bit-addressing) component files are inaccessible to versions of the
interpreter that pre-dated their introduction (versions earlier than 10.1).

The second item in the right argument of [JF CREATE determines the addressing type
of'the file.

"small'fcreate 1 32 A create small-span file.
‘large'[dfcreate 1 64 A create large-span file.

If the second item is missing, the file type defaults to 64-bit-addressing. In versions
prior to 12.0, the default was 32-bit-addressing.

Note that small-span (32-bit-addressing) component files cannot contain Unicode
data. Unicode editions of Dyalog APL can only write character data which would be
readable by a Classic edition (consisting of elements of [JAV).

External Variables

External variables are implemented as small-span (32-bit-addressing) component
files, and subject to the same restrictions as these files. External variables are unlikely
to be developed further; Dyalog recommends that applications which use them
should switch to using mapped files or traditional component files. Please contact
Dyalog if you need further advice on this topic.

32 vs. 64-bit Interpreters

From Dyalog APL Version 11.0 onwards, there are two separate versions of programs
for 32-bit and 64-bit machine architectures (the 32-bit versions will also run on 64-
bit machines running 64-bit operating systems). There is complete inter-operability
between 32- and 64-bit interpreters, except that 32-bit interpreters are unable to work
with arrays or workspaces greater than 2GB in size.

Unicode vs. Classic Editions

From Version 12.0 onwards, a Unicode edition is available, which is able to work
with the entire Unicode character set. Classic editions (a term which includes ver-
sions prior to 12.0) are limited to the 256 characters defined in the atomic vector,

OAV).
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Component files have a Unicode property. When this is enabled, all characters will
be written as Unicode data to the file. The Unicode property is always off for small-
span (32-bit addressing) files, which may not contain Unicode data. For large-span
(64-bit addressing) component files, the Unicode property is on by default but can be
toggled on and offusing OF PROPS.

When a Unicode edition writes to a component file which may not contain Unicode
data, character data is mapped using [JAVU, and can therefore be read without prob-
lems by Classic editions.

A TRANSLATION ERROR will occurifa Unicode edition writes to a non-Unicode
component (that is either a 32-bit file, or a 64-bit file when the Unicode property is
currently off) if the data being written contains characters which are not in JAVU.

Likewise, a Classic edition (Version 12.0 or later) will issue a TRANSLATION
ERROR ifit attempts to read a component containing Unicode data not in JAVU from
a component file. Version 11.0 cannot read components containing Unicode data
and issues a NONCE ERROR.

A TRANSLATION ERROR will also be issued when a Classic edition ) LOADs or
) COPYs a workspace containing Unicode data which cannot be mapped to [JAV
using the [JAVU in the recipient workspace.

TCPSocket objects have an APL property which corresponds to the Unicode prop-
erty of a file, if this is set to Clas s i c (the default) the data in the socket will be
restricted to [JAV, if Unicode it will contain Unicode character data. As a result,
TRANSLATION ERRORSs can occur on transmission or reception in the same way as
when updating or reading a file component.

AVU changes

The implementation of the function Right in Version 13.0 led to the discovery that
OAVU incorrectly defined JAV[59+0I0] as x (QUCS 164 ) rather than + (Right
Tack,[JUCS 8866). This error has been corrected in the default JAVU and in work-
space AVU. dws. If you are operating in a mixed Unicode/Classic environment, this
error will have caused earlier Classic editions to map JAV[59+[]I0] to the wrong
Unicode character (x). This may cause TRANSLATION ERRORs when a Version
13.0 Classic system attempts to read the data, as it will not be able to represent x in
the Atomic Vector.

DECFs and Complex numbers

Version 13.0 introduced two new data types; DECFs and Complex numbers.
Attempts to read components of these types in earlier interpreters will result in a
DOMAIN ERROR.
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Very large array components

The maximum size (in bytes) of a component written by Version 12.1 and prior is
2GB. This is the size of the component as held on disk which may be different than
the size reported by OSIZE. In Version 13.0 the maximum size of a component
written by a 64-bit interpreter is 4GB. From Version 13.1 onwards, the limit on the
size of arrays or components is so large that for most practical purposes, there is effec-
tively no limit.

An attempt to read a component greater than 2GB in 32-bit interpreters will result in
aWS FULL. An attempt to read such a component in 64-bit Versions 12.0 and 12.1
patched after Ist April 2011 will result in a NONCE ERROR; earlier patches generate
aFILE COMPONENT DAMAGED error.

File Journaling

Version 12.0 introduced File Journaling (level 1), and 12.1 added journaling levels 2
and 3 and checksumming. Versions earlier than 12.0 cannot tie files which have any
form of journaling or checksumming enabled. Version 12.0 cannot tie files with jour-
naling levels greater than 1, or checksumming enabled. Attempting to tie such files
will resultina FILE NAME ERROR. Files can be shared with earlier versions by
using JFPROPS to amend the journaling and checksumming levels.

TCPSockets

TCPSockets used to communicate between differing versions of Dyalog APL are sub-
ject to similar limitations to those described above for component files. In particular
TCPSockets with ‘Style' 'APL' will only be able to pass arrays that are sup-
ported by both versions.

Auxiliary Processors

A Dyalog APL process is restricted to starting an AP of exactly the same architecture.
In other words, the AP must share the same word-width and byte-ordering as its inter-
preter process.

Session Files

Session (.dse) files may only be used on the platform on which they were created and
saved.
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The APL Command Line

The command line for Dyalog APL is as follows:

dyalog [ options ] [ debug ][ file ] [param] [param] [param]...

where:

[options]
-X No [LX execution on workspace loads.
-a Start in USER mode.
-b Suppress the banner in the Session..
-Fxx Default to creating xx-bit files (where xx is 32 or 64).
- Disable the Session. This option is ignored in Windows versions.
-q Don't quit APL on error (used when piping input into APL).
- Signifies a command-line comment. All characters to the right are

ignored.

[debug]
-Dc  Check workspace integrity after every callback function.
-Dw  Check workspace integrity on return to session input.
DW Check workspace integrity after every line of APL (application will

run slowly as a result)

-DK  Log session keystrokes in (binary) file APLLOG.

[file]
The name of a Dyalog APL workspace to be loaded. Unless specified, the file
extension .DWS is assumed.

[param]
A parameter name followed by an equals sign (=) and a value. Note that the
parameter name may be one of the standard APL parameters described below,
or a name and value of your own choosing (see Object Reference,
GetEnvironment method).

Examples:

c:\program files\..\dyalog.exe myapp maxws=64000
c:\program files\..\dyalog.exe session file=special.dse

c:\program files\..\dyalog.exe myapp aplt=mytrans.dot myparam=42
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APL Exit Codes

When APL or a bound .EXE terminates, it returns an exit code to the calling envi-
ronment. If APL is started from a desktop icon, the return code is ignored. However, if
APL is started from a script (UNIX) or a command processor, the exit code is avail-
able and may be used to determine whether or not to continue with other processing
tasks. The return codes are:

0 successful JOFF, )OFF, ) CONTINUE, graphical exit from GUI

APL failed tostart. This will occur if there was a failure to read a
1 translate file, there is insufficient memory, or a critical parameter is
incorrectly specified or missing.

APL was terminated by SIGHUP or SIGTERM (UNIX) or in response
to a QUIT WINDOWS request. APL has done a clean exit.

3 APL issued a syserror.

Runtime violation. This occurs if a runtime application attempts to
4 read input from the Session. Only a development version has a
Session.

Notes:

Under UNIX exit codes greater than 127 indicates (127+signal number) of the
untrapped signal which caused the process to terminate.

APL applications can generate a custom return code by specifying an integer value to
the right of JOF F. Dyalog recommends using values greater than 10 for this purpose.

Configuration Parameters

Introduction

Dyalog APL/W is customised using a set of configuration parameters which are
defined in a registry folder.

In addition, parameters may be specified as environment variables or may be spec-
ified on the APL command line.

Furthermore, you are not limited to the set of parameters employed by APL itself as
you may add parameters of your own choosing.

Although for clarity parameter names are given here in mixed case, they are case-inde-
pendent under Windows. Under Unix and Linux, Dyalog parameters must be spec-
ified as environment variables and must be named entirely in upper-case.



Chapter 1: Installation and Configuration 10

Setting Parameter Values

You can change the parameters in 4 ways:

e Using the Configuration dialog box that is obtained by selecting Configure
from the Options menu on the Dyalog APL/W session. See "The Con-
figuration Dialog Box" on page 123 for details.

e By directly editing the Windows Registry using REGEDIT.EXE or
REGEDIT32.EXE.

e By defining the parameters as DOS environment variables.

e By defining the parameters on the APL command line.

This scheme provides a great deal of flexibility, and a system whereby you can over-
ride one setting with another. For example, you can define your normal workspace
size (maxws) in your . INT file or Registry, but override it with a new value specified
on the APL command line. The way this is done is described in the following sec-
tion.

How APL Obtains Parameter Values

When Dyalog APL/W requires the value of a parameter, it uses the following rules.

1. If the parameter is defined on the APL command line, this value is used.

2. Otherwise, APL looks for an environment variable of the same name and
uses this value.

3. Otherwise, if the parameter in question is inifile, the default value of
Software\Dyalog\Dyalog APL/W 13.0 Unicode (Unicode Edi-
tion) or Software\Dyalog\Dyalog APL/W 13.0 Classic (Classic
Edition) is assumed.

4. Otherwise, if the parameter in question is dyalog, the name of the directory
from which the Dyalog APL program was loaded is assumed.

5. The value of any other parameter is obtained from the registry folder defined
by the value of inifile.

Note that the value of a parameter obtained by the GetEnvironment method (see
Object Reference) uses exactly the same set of rules.

The following section details those parameters that are implemented by Registry
Values in the top-level folder identified by inifile. Values that are implemented in
sub-folders are mainly internal and are not described in detail here. However, any
Value that is maintained via a configuration dialog box will be named and
described in the documentation for that dialog box in Chapter 2.
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APL_CODE_E_MAGNITUDE

Version 13.0 introduced decimal floating point numbers which have greater pre-
cision than IEEE floating point numbers. This increased the maximum allowable
print precision from 17 to 34 and this had the side effect of changing the way
numbers in function bodies are descanned!. For example, the number one sextillion
(1021 in a function is descanned by Version 12.1 as 1E21 and by Version 13.0 as
1000000000000000000000.

Note that only numbers X in the range (10%x17) < X <(10*34) are affected.

Whilst this change has no other deleterious effect, it means that code that contains
such numbers is harder to read, and the result of [JCR (and other character rep-
resentations) of the same function may have changed between Version 12.1 and Ver-
sion 13.0 causing undesired affects in code management systems.

The APL_CODE_E_MAGNITUDE parameter allows the user to choose between
current (Version 13.0 and onwards) and earlier behaviour.

Ifthe APL_CODE_E_MAGNITUDE parameter is undefined or set to 0 (the
default), numbers are descanned and displayed as normal.

IfAPL_CODE_E_MAGNITUDE is ~ 1, numbers greater than or equal to 10!7 will
be displayed using exponential format, as in Version 12.1.

The effect of setting this parameter to any other value is undefined.

1Descanning refers to the internal process used to convert the internal representation of APL code
into a character array. For numbers in function statements, this process uses the maximum value of

Print Precision.
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APL_COMPLEX_AS_V12

Support for Complex Numbers means that some functions produce different results
from previous Versions of Dyalog APL. fAPL._COMPLEX_AS V12 issetto 1 the
behaviour of code developed using Version 12.1 or earlier will be unchanged; in par-
ticular:

e Power (*) and logarithm (®) do not produce Complex Numbers as results
from non-complex arguments.

e [IVFI will not honour "J" or "j" as part of a number.

e ~hoY will be evaluated as (~ 1+Y*2)%0.5, which is positive for negative
real arguments.

IfAPL_COMPLEX AS V12 is set to any other value or is not set at all then code
developed using version 12.1 or earlier may now generate Complex Numbers.

Note that this feature is provided to simplify the transition of older code to Version

13.0. It does not prevent the generation and use of Complex Numbers using features
new to 13.0 (such as explicitly specifying a Complex Number literal), and it will be
removed in a future release of Dyalog APL.

APL_FCREATE_PROPS_C

This parameter specifies the default chksum level for newly-created component files.
Ifunspecified, the default checksum level is 1.

APL_FCREATE_PROPS_J

This parameter specifies the default journaling level for newly-created component
files. If unspecified, the default journaling level is 1.



Chapter 1: Installation and Configuration 13

APL_FAST_FCHK

This parameter specifies whether Dyalog APL should optimise [JF CHK by allowing it
to reliably determine whether a component file had been properly untied and there-
fore does not need to be checked (this is overridable using the [JF CHK option 'force").

Optimising [JF CHK in this way has a performance impact on JFUNTIE and it is rec-
ommended this optimisation is switched off if your application frequently ties and
unties files.

Note: this only affects component files with journaling enabled.

The values of the parameter are:

0 | Do not optimise [JF CHK (optimise JFUNTIE instead)
1 |Optimise OF CHK

The default values of the parameter reflect the existing behaviour in Version 12.1: 0
on Windows and 1 on Linux / AIX. On Windows, setting the value 1 has no effect.

APL_EXTERN_DECF

By default, arrays of type DECF (128-bit decimal) will be passed unchanged to Aux-
iliary Processors, and to DLLs using A or Z argument types. However, if APL_
EXTERN_DECF is set to 0, DECF arrays will be converted to DOUBLE before
they are passed to AP's and DLL's. This will allow user-written Auxiliary Processors
and DLLs to continue to work at least temporarily while users determine how to
change their code to cater for the new data type. This parameter will not be supported
beyond Version 13.0.

APL_FHIST_TIE

This boolean parameter specifies whether or not the time of the latest file tie is
recorded so that it can be reported by JFHIST.

Note that the collection of this statistic involves writing to the file which may be
undesirable.

The default is 1. Setting APL_FHIST_TIE to 0 stops file ties being recorded and
means that the 4th row of JFHISTwill be 0. This prevents problems with incre-
mental backups and other non-APL versioning software. From 13.2 onwards Dyalog
intends to always set the fourth row of JFHISTto all zeros and to never update the
file with the tie time.

Currently, the second row of the result (undefined) contains (0 0).
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ApiCoreName

This parameter may be a string or a Boolean value. If it is a string, it specifies the

directory and name of'the file in which the aplcore should be saved. The optional
wild-card character (*) is replaced by a unique string when the file is written. For
example:

APLCORENAME=C:\mycores\aplcore*.dat

If AplCoreName is set to Boolean 0, the generation of an aplcore file is suppressed
and the application simply terminates with an exit code of 3.

aplk

(Classic Edition Only)

This parameter specifies the name of your Input Translate Table, which defines your
keyboard layout. The keyboard combo in the Configure dialog box displays all the
files with the .DIN extension in the APLKEY'S sub-directory. Y ou may choose any
one of the supplied tables, and you may add your own to the directory. Note that the
FILE.DIN table is intended for input from file, and should not normally be chosen as
a keyboard table. Classic Edition only

aplkeys

(Classic Edition Only)

This parameter specifies a search path for the Input Translate Table and is useful for
configuring a run-time application. It consists of a string of directories separated by
the semicolon (;) character. Its default value is the APLKEY'S sub-directory of the
directory in which Dyalog APL/W is installed (defined by dyalog)

aplnid

Under Windows, this parameter specifies the user number that is used by the com-
ponent file system to control file sharing and security. If you wish to share com-
ponent files and/or external variables in a network it is essential that each user has a
unique aplnid parameter. It may be any integer in the range 0 to 65535. Note that an
aplnid value of 0 causes the user to bypass APL’s access control matrix mechanism.

Under UNIX, the user number is obtained from the Operating System (UID) and
aplnid is not used. If the user is "root", APL's access control mechanism is ignored.

When a user creates a component file, his user number is recorded in the file to iden-
tify him as its owner.
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aplt

This parameter specifies the name of the Output Translate Table. The default is
WIN.DOT and there is rarely a need to alter it.

apltrans

This parameter specifies a search path for the Output Translate Table and is useful for
configuring a run-time application. It consists of a string of directories separated by
the semicolon (;) character. Its default value is the sub-directory APLTRANS in the
directory in which Dyalog APL/W is installed.

auto_pw

This parameter specifies whether or not the value of [JPW is derived automatically
from the current width of the Session Window. If auto_pw is 1, the value of JPW
changes whenever the Session Window is resized and reflects the number of char-
acters that can be displayed on a single line. If auto_pw is 0 (the default) PW is inde-
pendent of the Session Window size.

AutoFormat

This parameter specifies whether or not you want automatic formatting of Control
Structures in functions. The default value is 1 which means that formatting is done
automatically for you when a function is opened for editing or converted to text by
OCR,ONR and OVR. Automatic formatting first discards all leading spaces in the func-
tion body. It then prefixes all lines with a single space except those beginning with a
label or a comment symbol (this has the effect of making labels and comments stand
out). The third step is to indent Control Structures. The size of the indent depends
upon the TabStops parameter. To turn off automatic formatting, set AutoFormat to

0.

Autolndent

This parameter specifies whether or not you want semi-automatic indenting during
editing. The default value is 1. This means that when you enter a new line in a func-
tion, it is automatically indented by the same amount as the previous line. This
option simplifies the entry of indented Control Structures.
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ClassicMode

This parameter specifies whether or not the Session operates in Dyalog Classic mode.
The default is 0. If this parameter is set to 1, the Editor and Tracer behave in a manner
that is consistent with previous versions of Dyalog APL.

CMD_PREFIX and CMD_POSTFIX

These parameters defines strings within which operating system commands specified
as the arguments to [JCMD and [JSH, and ) CMD and ) SH, are wrapped. Its purpose is
to run the command arguments under a non-standard command shell.

See Language Reference for implementation details.

confirm_abort

This parameter specifies whether or not you will be prompted for confirmation when
you attempt to abort an edit session after making changes to the object being edited.
Its value is either 1 (confirmation is required) or 0. The default is 0.

confirm_close

This parameter specifies whether or not you will be prompted for confirmation when
you close an edit window after making changes to the object being edited. Its value
is either 1 (confirmation is required) or 0. The default is 0.

confirm_fix

This parameter specifies whether or not you will be prompted for confirmation when
you attempt to fix an object in the workspace after making changes in the editor. Its
value is either 1 (confirmation is required) or 0. The default is 0.

confirm_session_delete

This parameter specifies whether or not you will be prompted for confirmation when
you attempt to delete lines from the Session Log. Its value is either 1 (confirmation is
required) or 0. The default is 1.
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CreateAplCoreOnSyserror

This parameter specifies whether or not an aplcore file is generated when APL exits
with a system error.

default_div

This parameter specifies the value of DIV in a clear workspace. Its default value is
0.

DefaultHelpCollection

If UseDefaultHelpCollection is 1, Dyalog attempts to use the Microsoft Document
Explorer and online help, for example from Visual Studio (if installed), to display
help for external objects, such as .Net Types. In most cases the default settings of "ms-
help://ms.mscc.v80" will be sufficient. On some configurations it may be necessary
to change this. See " UseDefaultHelpCollection" on page 28

default_io

This parameter specifies the value of JI0 in a clear workspace. Its default value is 1.

default_ml

This parameter specifies the value of [JML in a clear workspace. Its default value is 0.

default_pp

This parameter specifies the value of PP in a clear workspace. Its default value is 10.
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default_pw
This parameter specifies the value of [JPW in a clear workspace. Its default value is 76.
Note that JPW is a property of the Session and the value of default pw is overridden
when a Session file is loaded.

default_rl
This parameter specifies the value of JRL in a clear workspace. It must be a scalar and
its default value is 16807.

default_rtl
This parameter specifies the value of JRTL in a clear workspace. Its default value is
0.

default_wx

This parameter specifies the value of JWX in a clear workspace. This in turn deter-
mines whether or not the names of properties, methods and events of GUI objects are
exposed. If set (WX is 1), you may query/set properties and invoke methods directly
as if they were variables and functions respectively. As a consequence, these names
may not be used for global variables in GUI objects.

DMXOUTPUTONERROR

This parameter specifies in which windows DMX error messages are displayed. It is
an integer whose value is the sum of the sspecified windows where 1 = Status Win-
dow and 2 = Session Window.

DockableEditWindows

This parameter specifies whether or not individual edit windows can be undocked
from (and docked back into) the (MDI) Editor window. Its default value is 0. This
parameter does not apply if ClassicMode is set to 1.

DoubleClickEdit

This parameter specifies whether or not double-clicking over a name invokes the
editor. Its default is 1. If DoubleClickEdit is set to 0, double-clicking selects a word
and triple-clicking selects the entire line.
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dyalog
This parameter specifies the name of the directory in which Dyalog APL/W is
installed.
DyalogEmailAddress
This parameter specifies the contact email address for Dyalog Limited.
DyalogHelpDir
This parameter specifies the full pathname of the directory that contains the Dyalog
APL help file (dyalog.chm).
DyaloginstaliDir
This parameter specifies the full pathname of the directory in which Dyalog APL is
installed.
DyalogWebSite

This parameter specifies the URL for the Dyalog web site.

edit_cols, edit_rows

These parameters specify the initial size of an edit window in character units.

edit_first_x, edit_first_y

These parameters specify the initial position on the screen of the first edit window in
character units. Subsequent edit windows will be staggered. These parameters only
apply if ClassicMode is 1.
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edit_offset_x, edit_offset_y

These parameters specify the amount by which an edit window is staggered from the
previous one.

ErrorOnExternalException

This is a Boolean parameter that specifies the behaviour when a System Exception
occurs in an external DLL. If this parameter is set to 1, and an exception occurs in a
call on an external DLL. APL generates an EXTERNAL DLL EXCEPTION error
(91), instead of terminating with a System Error. This error may be trapped.

EditorState

This is an internal parameter that remembers the state of the last edit window (normal
or maximised). This is used to create the next edit window in the appropriate state.

greet_bitmap

This parameter specifies the filename of a bitmap to be displayed during initialisation
ofthe Dyalog APL application. It is used typically to display a product logo from a
runtime application. The bitmap will remain until either an error occurs, or it is
removed using the GreetBitmap method of the Root object.

greet bitmap=c:\myapp\logo.bmp

history_size

This parameter specifies the size of the buffer in Kb used to store previously entered
(input) lines in the Session.
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inifile

This parameter specifies the name of the Windows Registry folder that contains the
configuration parameters described in this section. For example,

INIFILE=Software\Dyalog\mysettings

If the parameter is not defined, inifile defaults to the current directory.

InitialKeyboardLayout (Unicode Edition Only)

This parameter specifies the name of the keyboard to be selected on startup. When
you start an APL session, this layout will automatically be selected as the current key-
board layout if the value of InitialKeyboardLayoutInUse is 1.

InitialKeyboardLayoutinUse (Unicode Edition Only)

This Boolean parameter specifies whether or not the keyboard specified by Initial-
KeyboardLayout is selected as the current keyboard layout when you start an APL
session.

InitialKeyboardLayoutShowAll (Unicode Edition Only)

This Boolean parameter specifies whether or not all installed keyboards are listed in
the choice of keyboards in the Configuration dialog box (Unicode Input tab).

input_size

This parameter specifies the size of the buffer in Kb used to store marked lines (lines
awaiting execution) in the Session.
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KeyboardinputDelay

This parameter specifies the delay (in milliseconds) before the system reacts to a user
keystroke by:

e updating the name of the Current Object in the Session statusbar. See "The
Current Object" on page 63
o offering a list of names for auto-completion. See "Auto Complete Tab" on

page 145

lines_on_functions

This parameter specifies whether or not line numbers are displayed in edit and trace
windows. It is either O (the default) or 1.

Note that this parameter determines your overall preference for line numbering, and
this setting persists between APL sessions. You can however still toggle line num-
bering on and off dynamically as required by clicking Line Numbers in the Options
menu on the Session Window. These temporary settings are not saved between APL
sessions

localdyalogdir

This parameter specifies the name of the directory in which Dyalog APL/W is
installed on the client, in a client/server installation

log_file

This parameter specifies the full pathname of the Session log file.

log_file_inuse

This parameter specifies whether or not the Session log is saved in a session log file.

log_size

This parameter specifies the size of the Session log buffer in Kb.
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mapchars

(Classic Edition Only)

In previous versions of Dyalog APL, certain pairs of characters in JAV were mapped
to a single font glyph through the output translate table. For example, the ASCII pipe
I and the APL style | were both mapped to the APL style |. From Version 7.0
onwards, it has been a requirement that the mapping between [JAV and the font is
strictly one-to-one (this is a consequence of the new native file system). Originally,
the mapping of the ASCII pipe and the APL style, the APL and ASCII quotes, and the
ASCII " and the APL ” were hard-coded. The mapping is defined by the mapchars
parameter.

mapchars is a string containing pairs of hexadecimal values which refer to 0-origin
indices in [JAV. The first character in each pair is mapped to the second on output.
The default value of mapchars is DBODEBA7EECO00BEO which defines the fol-
lowing mappings.

From To
Hex Hex Symbol
DB 219 ¢ 0D 13 '
EB 235 A A7 167 A
EE 238 0 Co 192
0B 11 . EO 224

Decimal Symbol Decimal

To clear all mappings, set MAPCHARS=0000.

maxws

This parameter determines your workspace size in kilobytes and is the amount of
Windows memory allocated to the workspace at APL start-up. MAXWS is specified
as an integer number followed optionally by the letter k, m or g (in upper or lower
case) to indicate kilobytes, megabytes or gigabytes. If omitted, the default is kil-
obytes.

The default value is 16384 (16 Mb). If you want a larger (or smaller) workspace you
must change this value. For example, to get a 64 MB workspace:

MAXWS=64m
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Dyalog APL places no implicit restriction on workspace size, and the virtual memory
capability of MS-Windows allows you to access more memory than you have phys-
ically installed. However if you use a workspace that greatly exceeds your physical
memory you will encounter excessive paging and your APL programs will run
slowly.

Note that the memory used for the workspace must be contiguous memory, and,
under Windows, this is typically limited to a maximum of 1.6GB. This is a Windows
restriction, and not one that is imposed by Dyalog APL.

OverstrikesPopup (Unicode Edition Only)

This is a Boolean parameter that specifies whether or not the Overstrikes popup is
enabled.

PassExceptionsToOpSys

This is a Boolean parameter that specifies the default state of the Pass Exception
check box in the System Error dialog box.

pfkey_size

This parameter specifies the size of the buffer in Kb that is used to store pro-
grammable function key definitions. See DPFKEY.

ProgramFolder

This parameter specifies the name of the folder in which the Dyalog APL program
icons are installed.

PropertyExposeRoot

This parameter specifies whether or the names of properties, methods and events of
the Root object are exposed. If set, you may query/set the properties of Root and
invoke the Root methods directly as if they were variables and functions respec-
tively. As a consequence, these names may not be used for global variables in your
workspace.
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PropertyExposeSE

This parameter specifies whether or the names of properties, methods and events of
the Session object are exposed. If set, you may query/set the properties of JSE and
invoke [0SE methods directly as if they were variables and functions respectively. As
a consequence, these names may not be used for global variables in the JSE names-
pace.

qcmd_timeout

This parameter specifies the length of time in milliseconds that APL will wait for the
execution of a DOS command to start. Its default value is 5000 milliseconds.

ResolveOverstrikes (Unicode Edition Only)
Specifies whether or not the user may enter an APL composite symbol using over-
strikes.

RunAsService

When RunAsService is set to 1 (the default is 0) Dyalog APL will not prompt for con-
firmation when the user logs off, and the interpreter will continue to run across the
logofflogon process

SaveContinueOnExit

Specifies whether or not your current workspace is saved as CONTINUE . DWS before
APL terminates.

SaveLogOnExit

Specifies whether or not your Session log is saved before APL terminates.

SaveSessionOnExit

Specifies whether or not your current Session is saved in your Session file before APL
terminates.
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Serial

Specifies your Dyalog APL/W Serial Number.

session_file

This parameter specifies the name of the file from which the APL session (OSE) is to
be loaded when APL starts. If not specified, a .DSE extension is assumed. This ses-
sion file contains the JSE object that was last saved in it. This object defines the
appearance and behaviour of the Session menu bar, tool bar(s) and status bar, together
with any functions and variables stored in the [JSE namespace.

ShowStatusOnError

Specifies whether or not the Status window is automatically displayed (if required)
when APL attempts to write output to it.

SingleTrace

Specifies whether there is a single Trace window, or one Trace window per function.
This applies only if ClassicMode is 1.

StatusOnEdit

Specifies whether or not a status bar is displayed at the bottom of an Edit window.

sm_cols, sm_rows

These parameters specify the size of the window used to display [JSM when it is used
stand-alone. They are not used if the window is specified using the SM object.

TabStops

This parameter specifies the number of spaces inserted by pressing the Tab key in the
editor. Its default value is 4.
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trace_cols, trace_rows

These parameters specify the initial size of a trace window in character units.

trace_first_x, trace_first_y

These parameters specify the initial position on the screen of the first trace window
in character units. Subsequent trace windows will be staggered. This applies only if
ClassicMode is 1.

trace_offset_x, trace_offset_y

These parameters specify the amount by which a trace window is staggered from the
previous one. These apply only if ClassicMode is 1 and SingleTrace is 0.

Trace _level warn

This parameter specifies the maximum number of Trace windows that will be dis-
played when an error occurs and Trace_on_error is set to 1. Ifthere are a large
number of functions in the state indicator, the display of their Trace windows may
take several seconds. This parameter allows you to restrict the potential delay to a rea-
sonable value and its default is 16. If the number of Trace windows would exceed

this number, the system instead displays a warning message box. This parameter is
ignored if you invoke the Tracer explicitly. This parameter applies only if Clas-
sicMode is 1 and SingleTrace is 0.

Trace_on_error

This parameter is either 0 (the default) or 1. If set to 1, Trace_on_error specifies that
the Tracer is automatically deployed when execution of a defined function halts with
an error. A stack of Trace windows is immediately displayed, with the top Trace win-
dow receiving the input focus.
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TraceStopMonitor

This parameter specifies which ofthe JTRACE (1),JSTOP (2) and JMONITOR (4) col-
umns are displayed in Trace and Edit windows. Its value is the sum of the cor-
responding values.

UnicodeToClipboard

This parameter specifies whether or not text that is transferred to and from the Win-
dows clipboard is treated as Unicode text. If UnicodeToClipboard is 0 (the default),
the symbols in [JAV are mapped to ASCII text (0-255). In particular, the APL symbols
are mapped to ASCII symbols according to their positions in the Dyalog APL font. If
UnicodeToClipboard is 1, the symbols in JAV are mapped to Unicode text and the
APL symbols are mapped to their genuine Unicode equivalent values.

UseDefaultHelpCollection

This parameter specifies whether or not Dyalog attempts to use the Microsoft Doc-
ument Explorer and online help to display help for external objects, such as .Net
Types. See "DefaultHelpCollection " on page 17.

WantsSpecialKeys (Unicode Edition Only)

This parameter specifies a list of applications (e.g. "putty.exe") that use the command
strings in the Input Translate Tables.

wspath

This parameter defines the workspace path. This is a list of directories that are
searched in the order specified when you ) LOAD or ) COPY a workspace and when
you start an Auxiliary Processor. The directory paths are specified using Operating
System specific conventions and separated by ";" (Windows) or ":" (UNIX).

The following Windows example causes ) COPY, ) LOAD and ) LIB to look first in
the current directory, then in D: \MYWS, and then in the (normal) installation work-
space directory.

wspath=.;D:\MYWS;C:\Program Files\Dyalog\Dyalog APL 13.1
Unicode\ws

XPLookAndFeel

This parameter is not used directly. See "Native Look and Feel" on page 125.
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XPLookAndFeelDocker

This parameter specifies whether or not the title bars in docked windows honour
Native Look and Feel, if this is enabled at the Windows level. If unspecified, the
default is 0.

yy_window

This parameter defines how Dyalog APL is to interpret a 2-digit year number. If yy_
window is not set (the default) then under Windows, Version 13.1 onwards will
adhere to the rules specified in the Windows Region and Language 2-digit year set-
tings.

Dyalog allows a choice of input date formats for JSM and GUI edit fields. If you have
chosen a 2-digit year format such as MM/DD/YY, then an input 0f 02/01/00 will by
default be interpreted as 15t February 1900 - not 15t February 2000.

If your application uses a 4-digit year format such as YYYY-MM-DD, the problem
will not arise.

You can use the yy_window parameter to cause your application to interpret 2-digit
dates in as required without changing any APL code.

Sliding versus Fixed Window
Two schemes are in common use within the industry: Sliding or Fixed date windows.

Use a Fixed window if there is a specific year, for example 1970, before which, dates
are meaningless to your application. Note that with a fixed window, this date (say
1970) will still be the limit if your application is running in a hundred years time.

Use a Sliding window if there is a time period, for example 30 years, before which
dates are considered too old for your application. With a sliding window, you will
always be able to enter dates up to (say) 30 years old, but after a while, specific years
in the past (for example 1970) will become inaccessible.

Setting a Fixed Window

To make a fixed window, set parameter yy_window to the 4-DIGIT year which is
the earliest acceptable date. For example:

YY WINDOW=1970

This will cause the interpreter to convert any 2-digit input date into a year in the
range 1970, 1971 ... 2069
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Setting a Sliding Window

To make a sliding window, set parameter yy_window to the 1- or 2-DIGIT year
which determines the oldest acceptable date. This will typically be negative.

YY WINDOW=-30
Conversion of dates now depends on the current year:
Ifthe current year is 1999, the earliest accepted date is 1999-30 = 1969.

This will cause the interpreter to convert any 2-digit input date into a year in the
range 1969, 1970 ... 2068.

However if your application is still running in the year 2010, the earliest accepted
date then will be 2010-30 = 1980. So in the year 2010, a 2-digit year will be inter-
preted in the range 1980, 1981 ... 2079.

Advanced Settings
You can further restrict date windows by setting an upper as well as lower year limit.
YY WINDOW=1970,1999

This causes 2-digit years to be converted only into the range 1970, 1971 ... 1999.
Any 2-digit year (for example, 54) not convertible to a year in this range will cause a
DOMAIN ERROR.

The sliding window equivalent is:
YY WINDOW=-10,10

This would establish a valid date window, ten years either side of the current year.
For example, if the current year is 1998, the valid range would be (1998-10) —
(1998+10), in other words: 1988, 1989, ~ 2008.

One way of looking at the yy_window variable is that it specifies a 2-element vector.
If you supply only the first element, the second one defaults to the first element + 99.

Note that the system uses only the number of digits in the year specification to deter-
mine whether it refers to a fixed (4-digits) or sliding (1-, or 2-digits) window. In fact
you can have a fixed lower limit and a sliding upper limit, or vice versa.

YY WINDOW=1990,10
Allows dates as early as 1990, but not more than 10 years hence.
YY WINDOW=0,1999

Allows dates from the current year to the end of the century.
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If the second date is before, or more that 99 years after the first date, then any date con-
version will result in a DOMAIN ERROR. This might be useful in an application
where the end-user has control over the input date format and you want to disallow
any 2-digit date input.

YY WINDOW=1,0

Registry Sub-Folders

A large amount of configuration information is maintained in the Windows Registry
in sub-folders of the main folder identified by inifile.

Many of'these values are dynamic, for example the position of the various Session
windows, is maintained in a Registry sub-folder so that their appearance is main-
tained from one invocation of APL to the next. These type of Registry values are con-
sidered to be internal and are therefore not described herein.

However, and Registry Value that is maintained via a configuration dialog box will
be named and described in the documentation for that dialog box in Chapter 2.

AutoComplete

This contains registry entries that describe your personal AutoComplete options. See
"Auto Complete Tab" on page 145.

Charts

This contains entries that control the way charts are produced and displayed when
you click one of the chart buttons. See " Object Operations" on page 118.

Colours

This contains entries that describe the colour schemes you have and your personal
preferences. See "Colour Selection Dialog" on page 153.

Event Viewer

This contains entries that describe your settings for the Event Viewer. See "The Event
Viewer" on page 255.

Explorer

This contains entries that describe your settings for the Workspace Explorer. See
"The Workspace Explorer Tool" on page 164.
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files

This contains the size of your recently used file list (see "General Tab" on page 123)
and the list of your most recently loaded workspaces.

KeyboardShortcuts

This contains the definitions of your Keyboard Shortcuts (Unicode Edition only).
See "Keyboard Shortcuts Tab" on page 131.

LanguageBar

This contains the definitions of the symbols, tips, and help for the symbols in the Lan-
guageBar.

Printing

This contains the entries for your Printer Setup options. See "Print Configuration
Dialog Box" on page 156.

SALT

This contains entries for SALT. See "SALT" on page 147.

Search

This contains dynamic entries for the Find Objects Tool. See "Find Objects Tool" on
page 198.

Threads

This contains entries to remember your preferences for Threads. See "The Threads
Menu" on page 112.

UnicodelME

This contains entries for the Dyalog Unicode IME.

ValueTips

This contains entries for your Value Tips preferences. See "Value Tips" on page 92.

WindowRects

This contains entries to maintain the position of various Session tool windows so
that they remain consistent between successive invocations of APL.
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Workspace Management

Workspace Size and Compaction

The maximum amount of memory allocated to a Dyalog APL workspace is defined
by the maxws parameter.

Upon )LOAD and )CLEAR, APL allocates an amount of memory corresponding to
the size of the workspace being loaded (which is zero for a clear ws) plus the work-
space delta.

The workspace delta is 1/16™ of maxws, except if there is less than 1/16™ of maxws
in use, delta is 1/64™ of maxws. This may also be expressed as follows:

delta<maxws{[a+>(w>a+16)d64 16}ws

where maxws is the value of the maxws parameter and ws is the currently allocated
amount of workspace. If maxws is 16384KB, the workspace delta is either 256KB or
1024 KB, and when you start with a cLear ws the workspace occupies 256KB.

When you erase objects or release symbols, areas of memory become free. APL man-
ages these free areas, and tries to reuse them for new objects. If an operation requires a
contiguous amount of workspace larger than any of the available free areas, APL reor-
ganises the workspace and amalgamates all the free areas into one contiguous block
as follows:

1. Any un-referenced memory is discarded. This process, known as garbage
collection, is required because whole cycles of refs can become un-ref-
erenced.

2. Numeric arrays are demoted to their tightest form. For example, a simple
numeric array that happens to contain only values 0 or 1, is demoted or
squeezed to have a [JDR type of 11 (Boolean).

3. All remaining used memory blocks are copied to the low-address end of the
workspace, leaving a single free block at the high-address end. This process
is known as compaction.

4. In addition to any extra memory required to satisfy the original request, an
additional amount of memory, equal to the workspace delta, is allocated.
This will always cause the process size to increase (up to the maxws limit)
but means that an application will typically achieve its working process
size with at most 4+15 memory reorganisations.

5. However, if after compaction, the amount of used workspace is less than
1/16 of the Maximum workspace size (maxws), the amount reserved for
working memory is reduced to 1/64th maxws. This means that workspaces
that are operating within 1/16th of maxws will be more frugal with memory
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Note that if you try to create an object which is larger than free space, APL reports WS
FULL.

The following system function and commands force a workspace reorganisation as
described above:

OWA, )RESET, )SAVE, )LOAD, )CLEAR

However, in contrast to the above, any spare workspace above the workspace delta
is returned to the Operating System. On a Windows system, you can see the process
size changing by using Task Manager.

The system function [JWA may therefore be used judiciously (workspace reor-
ganisation takes time) to reduce the process size after a particularly memory-hungry
operation.

Note that in Dyalog APL, the SYMBOL TABLE is entirely dynamic and grows and
shrinks in size automatically. There isno SYMBOL TABLE FULL condition.

Interface with Windows

Windows Command Processor commands may be executed directly from APL using
the system command ) CMD or the system function [JCMD. This system function is also
used to start other Windows programs. For further details, see the appropriate sections
in Language Reference.

Aucxiliary Processors

Introduction

Auxiliary Processors (APs) are non-APL programs which provide Dyalog APL users
with additional facilities. They run under the control of Dyalog APL.

Typically, APs are used where speed of execution is critical, for utility libraries, or as
interfaces to other products. APs may be written in any compiled language, although
C is preferred and is directly supported.
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Starting an AP

An Auxiliary Processor is invoked using the dyadic form of JCMD. The left argument
to JCMD is the name of the program to be executed; the value of the wspath param-
eter is used to find the named file. In Dyalog APL/W, the right argument to JCMD is
ignored.

"xutils' [OCMD ''

On locating the specified program, Dyalog APL starts the AP and initialises a mem-
ory segment for communication between the workspace and the AP. This com-
munication segment allows data to be passed from the workspace to the other
process, and for results to be passed back. The AP then sends APL some information
about its external functions (names, code numbers and calling syntax), which APL
enters in the symbol table. APL then continues processing while the AP waits for
instructions.

Using the AP

Once established, an AP is used by making a reference to one of its external func-
tions. An external function behaves as if it was a locked defined function, but it is in
effect an entry point to the AP. When an external function is referenced, APL trans-
mits a code number to the AP, followed by any arguments. The AP then takes over
and performs the desired processing before posting the result back.

Terminating the AP

An AP is terminated when all of its external functions are expunged from the active
workspace. This could occur with the use of ) CLEAR, ) LOAD, ) ERASE,[JEX, )OFF,
)CONTINUE or[JOFF.
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Example:

Start an Auxiliary Processor called EXAMPLE. This fixes two external functions
called DATE_TO_IDN and IDN_TO_DATE which deal with the conversion of Inter-
national Day Numbers to Julian Dates.

| JCLEAR |

|clear ws [

| | start AP .------------—- .
| "EXAMPLE' OCMD ''  |------------ >| AP EXAMPLE |
[ [ |- [
| | info about |Send info on |
| ¢ —- |lexternal fns |
| |  functions | |
[ )FNS | | wait [
|DATE_TO_IDN IDN_TO_DATE | | |
| | function code] [
| IDN_TO_DATE 19407 e >|call relevant |
| | 19407 | subroutine |
| wait ... | | |
| |<-18 Feb 53--| send result |
|18 Feb 53 | | |
| | terminate | |
| JCLEAR |---—=——————- > | EXIT |
[clear ws | and stop emm e .
[

Access Control for External Variables

External variables may be EXCLUSIVE or SHARED. An exclusive variable can
only be accessed by the owner of the file. If you are on a Local Area Network (LAN)
a shared external variable may be accessed (concurrently) by other users. The exclu-
sive or shared status of an external variable is set by the XVAR function in the UTIL
workspace.

Access to an external variable is faster if it has exclusive status than ifiit is shared.
This is because if several users are accessing the file data must always be read and
written directly to disk. If it has exclusive status, the system uses buffering and
avoids disk accesses where possible.
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Creating Executables

Dyalog APL provides the facility to package an APL workspace as a Windows
executable (EXE). This may be done by selecting Export ... from the File menu of the
APL Session window.

The system provides the following options:

e You may bind your EXE as a Dyalog APL run-time application, or as a Dya-
log APL developer application. The second option will allow you to debug
the application should it encounter an APL error.

e You may bind your EXE as a console-mode application. A console appli-
cation does not have a graphical user interface, but runs as a background
task using files or TCP/IP to perform input and output.

e You may specify whether or not your .EXE will honour Native Look and
Feel if this is enabled at the Windows level.

You can package the workspace as a stand-alone executable or as a .EXE file that
must be accompanied by the Dyalog APL Dynamic Link Library (dyalogl31.d11
ordyalogl3lrt.dll),in which case the DLL should be installed in the same
directory (as the EXE) or in the Windows System directory.

The following example illustrates how you can package the supplied workspace
calc.dws as an executable. Before making the executable, it is essential to set up
the latent expression to run the program using [JL X as shown. Notice that in this case
it is not necessary to execute [JOF F; the calc. exe program will terminate normally
when the user closes the calculator window and the system returns to Session input.
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[ C:\Program Files\Dyalog\Dyalog APL 13.0 Unicode\ws\CALC - ... |~ |05

File Edit Yiew Windows Session Log Action Options Tools Threads Help
ws [ = 0 E & | Object B B B85 ¥ b B | Tool || Edit| | Session
Language Bar il =1 ﬂ

l||||||IEII||||||f|l|||||||#||||||sé||||||l

Oyalog APLSW Yersion 13.0.8690
serial Mo @ Q000LZ
Unicode Edition

Mon-commercial License
Wed Mar 30 1e:bZ:bL 2011
clear ws
JLOAD CALC
C:“Praogram Files“DyalaoghDyalog APL 13.0 UnicodehwshCAL
For Dyalog AFL GUI Demonstration, trace:

CALC. RUM
9
< 2] |8
=
Debugger Slol= W
Ready... Ins
CurQbij: &l Opg:o  |OTRAP |O5I:0 |OIo:l OML:0

Then, when you select Export... from the File menu, the following dialog box is dis-
played.
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7= =5

Create bound file

Save_in:|_}ws [v] 3 1}' - m-

E ﬁcalc.exe

My Recent
Documents

=

Dezktop

&

My Docurents

or

by Computer
‘;‘] File name: |CALC.E>:E [V] [ Save l
i
by Metwark, Save as bpe: | Standalone Executable (includes interpreter EHE[V] [ Cancel ]

Fiuntime application [ ] Console application  [#]EEnable Mative Look and Feet

Command line;

In the example shown, the program is to be saved in ws, the (supplied workspaces)
directory from which the workspace was loaded (the default).

The Save as Type option has been set to Standalone Executable (includes interpreter
exe) which means that a single .EXE will be created containing the Dyalog APL
executable and the CALC workspace.

The Runtime application checkbox is checked, indicating that calc.exe isto
incorporate the runtime version of Dyalog APL..

As this is a GUI application, the Console application checkbox is left unset.

The Enable Native Look and Feel checkbox has been set so that calc.exe will hon-
our Native Look and Feel if it is enabled at the Windows level.
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Note that if you enter the name of a file containing an icon (use the Browse button to
browse for it) that icon will be bound with your executable and be use instead of the
standard Dyalog APL icon.

The Command Line box allows you to enter parameters and values that are to be
passed to your executable when it is invoked.

On clicking Save, the following message box is displayed to confirm success.

Dyalog APL/W

\!}) File iZ:\Program FilesiDvalogiDyvalog APL 13,0 UnicodelwsZALT, exe successtully created,

Version Information

You may embed version information into your .exe by clicking the Version button
and then completing the Version Informationn dialog box that is illustrated below.

__ Version Information
Indertifier | Y alue |
Cornrents | our comments here
Company ame Y'our Compary Mame
FileD'eszcription Your File Description
Fileterzion 1.0,0.0
Productyerzion 1,000
Praducth arme
InternalM arme “four Inkernal Filename
LegalCopyright Copyright [C] 2005
LegalTrademark.z Your Legal Trademarkz
PrivateBuild
SpecialBuild

ok | ’ Cancel
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Run-Time Applications and Components

Using Dyalog APL you may create different types of run-time applications and com-
ponents. Note that the distribution of run-time applications and components requires
a Dyalog APL Run-Time Agreement. Please contact Dyalog or your distributor, or
see the Dyalog web page for more information.

The following table shows a list of distributable components for the two Editions.
These are referred to in the remainder of this Chapter by the name shown in the first
column of'the table. It is essential that you distribute the components that are appro-
priate for the Edition you are using.

Name

File

32-bit Unicode

Dyalog APL 13.1 Unicode\

Run-Time EXE

dyalogrt.exe

Run-Time DLL

dyalogl3lrt unicode.dll

Bridge DLL

bridgel3l unicode.dll

Dyalog32 DLL

dyalog32.dl1l

DyalogNet DLL

dyalognet.dll

32-bit Classic

Dyalog APL 13.1 Classic\

Run-Time EXE

dyalogrt.exe

Run-Time DLL

dyalogl3lrt.dll

Bridge DLL

bridgel31l.d1l1l

Dyalog32 DLL

dyalog32.dl1l

DyalogNet DLL

dyalognet.dll
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Name

File

64-bit Unicode

Dyalog APL-64 13.1 Unicode\

Run-Time EXE

dyalogrt.exe

Run-Time DLL

dyalogl31l 64rt unicode.dll

Bridge DLL

bridgel31l-64 unicode.dll

Dyalog64 DLL

dyalog64.dll

DyalogNet DLL

dyalognet.dll

64-bit Classic

Dyalog APL-64 13.1 Classic\

Run-Time EXE

dyalogrt.exe

Run-Time DLL

dyalogl31l 64rt.dll

Bridge DLL

bridgel31-64.d11

Dyalog64 DLL

dyalog64.dll

DyalogNet DLL

dyalognet.dll

Stand-alone run-time

This is the simplest type of run-time to install. Using the File/Export menu item on
the Session window, you can create a standard Windows executable program file
(EXE) which contains your workspace and the Run-Time version of the Dyalog APL
interpreter. To distribute your application, you need to supply and install:

1. Your bound executable (EXE)

2. whatever additional files that may be required by your application
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The command-line for your application should simply invoke your EXE, with what-
ever start-up parameters it may require. Note that your application icon and any start-
up parameters for the Run-Time Interpreter are specified and bound with the EXE
when you make it.

If your application uses any component of the Microsoft .Net Framework, you must
distribute the Bridge DLL and DyalogNet DLLs. These DLLs must either be on the
system path or placed in the same directory as your EXE. If you are going to use your
application with ASP.NET, the DLLs must also be installed in the global assembly
cache (GAC)using the gacutil.exe utility program.

Bound run-time

This option requires the separate installation of the Run-Time DLL, but compared
with the stand-alone executable option, may save disk space and memory if your cus-
tomer installs and runs several different Dyalog applications. Using the File/Export
menu item on the Session window, you can create a standard Windows executable
program file (EXE) which contains your workspace bound to the Run-Time DLL. To
distribute your application, you need to supply and install:

1. Your bound executable (EXE)
2. The Run-Time DLL

whatever additional files that may be required by your application

The command-line for your application should simply invoke your EXE, with what-
ever start-up parameters it may require. Note that your application icon and any start-
up parameters for the Run-Time DLL are specified and bound with the EXE when
you make it.

If your application uses any component of the Microsoft .Net Framework, you must
distribute the Bridge DLL and DyalogNet DLLs. These DLLs must either be on the
system path or placed in the same directory as your EXE. If you are going to use your
application with ASP.NET, the DLLs must also be installed in the global assembly
cache (GAC) using the gacutil.exe utility program.

Workspace based run-time

A workspace based run-time application consists of the Dyalog APL Run-Time Pro-
gram (Run-Time EXE) and a separate workspace. To distribute your application, you
need to supply and install:

1. Your workspace
2. The Run-Time EXE
3. whatever additional files that may be required by your application
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The command-line for your application invokes the Run-Time EXE, passing it start-
up parameters required for the Run-Time EXE itself (such as MAXWS) and any start-
up parameters that may be required by your application. You will need to associate
your own icon with your application during its installation.

If your application uses any component of the Microsoft .Net Framework, you must
distribute the Bridge DLL and DyalogNet DLLs. These DLLs must either be on the
system path or placed in the same directory as your EXE. If you are going to use your
application with ASP.NET, the DLLs must also be installed in the global assembly
cache (GAC)using the gacutil.exe utility program.

Out-of-process COM Server
To make an out-of-process COM Server, you must:

1. Establish one or more OLEServer namespaces in your workspace, populated
with functions and variables that you wish to export as methods, properties
and events.

2. Use the File/Export ... menu item on the Session window to register the
COM Server on your computer so that it is ready for use.

The command-line for your COM Server invokes the Run-Time EXE, passing it start-
up parameters required for the Run-Time EXE itself (such as MAXWS) and any start-
up parameters that may be required by your application.

To distribute an out-of-process COM Server, you need to supply and install the fol-
lowing files:

1. Your workspace

2. The associated Type Library (.tlb) file (created by File/Export)

3. The Run-Time EXE

4. whatever additional files that may be required by your application

To install an out-of-process COM Server you must set up the appropriate Windows
registry entries. See Interface Guide for details.

In-process COM Server
To make an in-process COM Server, you must:

1. Establish one or more OLEServer namespaces in your workspace, populated
with functions and variables that you wish to export as methods, properties
and events.

2. Use the File/Export ... menu item on the Session window to create an in-
process COM Server (DLL) which contains your workspace bound to the
Run-Time DLL. This operation also registers the COM Server on your com-
puter so that it is ready for use.
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To distribute your component, you need to supply and install
Your COM Server file (DLL)

1. The Run-Time DLL
2. Whatever additional files that may be required by your COM Server.

Note that you must register your COM Server on the target computer using the
regsvr32.exe utility.

ActiveX Control

To make an ActiveX Control, you must:

1. Establish an ActiveXControl namespaces in your workspace, populated
with functions and variables that you wish to export as methods, properties
and events.

2. Use the File/Export ... menu item on the Session window to create an Acti-
veX Control file (OCX) which contains your workspace bound to the Run-
Time DLL. This operation also registers the ActiveX Control on your com-
puter so that it is ready for use.

To distribute your component, you need to supply and install
Your ActiveX Control file (OCX)

1. The Run-Time DLL
2. Whatever additional files that may be required by your ActiveX Control.

Note that you must register your ActiveX Control on the target computer using the
regsvr32.exe utility.

Microsoft .Net Assembly

A Microsoft .Net Assembly contains one or more .Net Classes. To make a Microsoft
Net Assembly, you must:

1. Establish one or more NetType namespaces in your workspace, populated
with functions and variables that you wish to export as methods, properties
and events.

2. Use the File/Export ... menu item on the Session window to create a Micro-
soft .Net Assembly (DLL) which contains your workspace bound to
the Run-Time DLL.

To distribute your .Net Classes, you need to supply and install
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Your Assembly file (DLL)

The Run-Time DLL

The Bridge DLL

The DyalogNet DLL

Whatever additional files that may be required by your .Net Assembly.

The Bridge DLL and DyalogNet DLLs must either be on the system path or
placed in the same directory as your EXE. If you are going to use your
Assembly with ASP.NET, the DLLs must also be installed in the global
assembly cache (GAC) using the gacutil.exe utility program.

Additional Files for SQAPL

If your application uses the SO4APL/EL ODBC interface, you must distribute and
install four additional files, according to the Edition you are using, as shown in the
tables below.

DN AW =

Name File

32-bit Unicode

Dyalog APL 13.1 Unicode\

SQAPL INI sgapl.ini
SQAPL ERR sgapl.err
SQAPL DLL cndya6lUni.dll

APLUNICD INI

aplunicd.ini

32-bit Classic

Dyalog APL 13.1 Classic\

SQAPL INI sgapl.ini
SQAPL ERR sgapl.err
SQAPL DLL cndya6l.dll

APLUNICD INI

aplunicd.ini
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Name File

64-bit Unicode Dyalog APL-64 13.1 Unicode\
SQAPL INI sqapl.ini

SQAPL ERR sqapl.err

SQAPL DLL cndya6lx64Uni.dll

APLUNICD INI

aplunicd.ini

64-bit Classic

Dyalog APL-64 13.1 Classic\

SQAPL INI sgqapl.ini
SQAPL ERR sqapl.err
SQAPL DLL cndya6lx64.d11l

APLUNICD INI

aplunicd.ini

The SQAPL DLL must be installed in the user’s Windows directory or be on the
user’s path.
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Miscellaneous Other Files
AUXILIARY PROCESSORS

If you use any of the Auxiliary Processors (APs) included in the sub-directory
XUTILS, you must include these with your application. Note that, like workspaces,
Dyalog APL searches for APs using the wspath parameter. If your application uses
APs, you must ensure that you specify wspath or that the default wspath is adequate
for your application..

DYALOG32 and/or DYALOG64

This DLL is used by some of the functions provided in the QUADNA . DWS workspace.
If you include any of these in your application this DLL must be installed in the
user’s Windows directory or be on the user’s path.

Registry Entries for Run-Time Applications

The Run-Time DLL does not obtain any parameter values from the Windows reg-
istry. If you need to specify any Dyalog APL parameter values, they must be defined
in the command line when you create an EXE.

The Run-Time EXE does obtain parameter values for the Windows registry, but does
not require them to be present. If the default values of certain parameters are inap-
propriate, you may specify their values on the command line. There is normally no
requirement to install registry entries for a run-time application that uses the Run-
Time EXE.

For example, your application may requires a greater or lesser maxws parameter
(workspace size) than the default value. This may be done by adding the phrase
MAXWS=nnnn (where nnnn is the required workspace size in kilobytes) after the
name of your application workspace on the command line, for example:

dyalogrt.exe MYAPP.DWS MAXWS=8096
Note that the default value of the DY ALOG parameter (which specifies where it

looks for various other files and sub-directories) is the directory from which the appli-
cation (dyalogrt.exe)isloaded.
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Nevertheless, registry entries will be required in the following circumstances.

1. If your Classic Edition run-time application requires that the user inputs
APL characters, you will need to specify input/output tables (parameters
APLK, APLT, APLKEYS and APLTRANS).

2. Ifyour application uses the NFILES Auxiliary Processor (now superseded
by the [INxxx system functions), you must specify a registry entry for the
APLKEYS parameter. This is required so that NFILES can find any trans-
late tables you may use. Note that NFILES cannot see the values of param-
eters specified on the APL command line, so you must specify APLKEYS
in the registry.

Installing Registry Entries

To specify parameters using the Registry, you must install a suitable registry folder
for each user of your application. By default, Version 13.1 will use the registry
folder:

HKEY CURRENT USER\Software\Dyalog\Dyalog APL/W 13.1 Unicode
or
HKEY CURRENT USER\Software\Dyalog\Dyalog APL/W 13.1

You may choose a different name for your registry folder if you wish. If so, you must
tell Dyalog APL the name of this folder by specifying the INIFILE parameter on the
command line. For example:

dyalogrt.exe MYAPP.DWS INIFILE=Software\MyCo\MyApplication
You may install entries into the registry folder in one of two ways:

1. Using a proprietary installation program such as InstallShield

2. Using the REGEDIT utility. This utility program installs registry entries
defined in a text file that is specified as the argument to the program. For
example, if your file is called APLAPP.REG, you would install it on your
user’s system by executing the command:

REGEDIT APLAPP.REG

An example 5-line file that specifies the APLNID and MAXWS
parameters might be as follows:

Windows Registry Editor Version 5.00

[HKEY CURRENT USER\Software\Dyalog\Dyalog APL/W 13.0]
"aplnidll:"42"
"maxws"="8096"
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COM Objects and the Dyalog APL DLL

Introduction

In each Edition, there are two versions of the Dyalog APL Dynamic Link Library,
named dyalogl31 unicode.dll anddyalogl3lrt unicode.dll (Uni-
code Edition) and dyalogl131.d11 and dyalogl31rt.d1l1 (Classic Edition).

dyalogl31l unicode.dll and dyalogl31l.dl1l are complete Dyalog APL
development systems packaged as Dynamic Link Libraries.

dyalogl31l unicode.dllanddyalogl3lrt unicode.dll and
dyalogl31lrt.dll arethe run-time versions of dyalogl31.d11.

In the remainder of this section, the term the Dyalog APL DLL is used to refer to any
one of these DLLs. The term COM object is used to refer to a Dyalog APL in-process
OLE Server (OLEServer object) or a Dyalog APL ActiveX Control (ActiveXControl
object).

The Dyalog APL DLL is used to host COM objects and .Net objects written in Dya-
log APL. Although this section describes how it operates with COM objects, much
of'this also applies when it hosts .Net objects. Further information is provided in the
.Net Interface Guide.

Classes, Instances and NameSpace Cloning

A COM object, whether written in Dyalog APL or not, represents a class. When a
host application loads a COM object, it actually creates an instance of that class.

When a host application creates an instance of a Dyalog APL COM object, the cor-
responding OLEServer or ActiveXControl namespace is cloned. If the host creates a
second instance, the original namespace is cloned a second time.

Cloned OLEServer and ActiveXControl namespaces are created in almost exactly the
same way as those that you can make yourselfusing [JOR and [WC except that they
do not have separate names. In fact, each clone believes itself to be the one and only
original OLEServer or ActiveXControl namespace, with the same name, and is com-
pletely unaware of the existence of other clones.

Notice that cloning does not initially replicate all the objects within the OLEServer
or ActiveXControl namespace. Instead, the objects inside the cloned namespaces are
actually represented by pointers to the original objects in the original namespace.
Only when an object is changed does any information get replicated. Typically, the
only objects likely to differ from one instance to another are variables, so only one
copy of the functions will exist in the workspace. This design enables many
instances of a Dyalog APL COM object to exist without overloading the workspace.
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Workspace Management

By default, the Dyalog APL DLL does not use a fixed maximum workspace size, but
automatically increases the size of'its active workspace as required. If you write a
run-away COM object, or if there is insufficient computer memory available to load a
new control, it is left to the host application or to Windows itselfto deal with the sit-
uation.

Nevertheless, it is possible to specify a value for MAXWS for the application in
which the Dyalog APL DLL is embedded. This is achieved by defining a Registry
key named:

HKLM\Software\Dyalog\Embedded\<appname>

where <appname> is the name of the application, containing a String Value named
maxws set to the desired size (in kb). If you were running an APL in-process server
from Microsoft Excel, the application name would be excel . exe.

When an application loads its first Dyalog APL COM object, it starts the Dyalog
APL DLL which initialises a CLEAR WS. It then copies the namespace tree for the
appropriate OLEServer or ActiveXControl object into its active workspace.

This namespace tree comprises the OLEServer or ActiveXControl namespace itself,
together with all its parent namespaces with the exception of the root workspace

itself. Note that for an ActiveXControl, there is at least one parent namespace that rep-
resents a Form.

For example, if an ActiveXControl namespace is called #.F .Dual, the Dyalog APL
DLL will copy the contents of #. F into its active workspace when the first instance
of'the control is loaded by the host application.

If the same host application creates a second instance of the same OLEServer or
ActiveXControl, the original namespace is cloned as described above and there is no
further impact on the workspace

If the same host application creates an instance of a different Dyalog APL COM
object, the namespace tree for this second object is copied from its DLL or OCX file
into the active workspace. For example, if the second control was named
X.Y.MyControl,the entire namespace X would be copied.
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This design raises a number of points:

1. Unless you are in total control of the user environment, you should design a
Dyalog APL COM object so that it can operate in the same workspace as
another Dyalog APL COM object supplied by another author. You cannot
make any assumptions about file ties or other resources that are properties of
the workspace itself.

2. If you write an ActiveXControl whose ultimate parent namespace is called
F, a host application could not use your control at the same time as another
ActiveXControl (perhaps supplied by a different author) whose ultimate par-
ent namespace is also called F.

3. Dyalog APL COM objects must not rely on variables or utility functions
that were present in the root workspace when they were saved. These func-
tions and variables will not be there when the object is run by the Dyalog
APL DLL.

4. A Dyalog APL COM object may create and subsequently use functions and
variables in the root workspace, but if two different COM objects were to
adopt the same policy, there is a danger that they would interfere with one
another. The same is true for [ISE.

Multiple COM Objects in a Single Workspace

If your workspace contains several OLEServer or ActiveXControl objects which
have the same ultimate parent namespace, the Dyalog APL DLL will copy them all
into the active workspace at the time when the first one is instanced. If the host appli-
cation requests a second COM object that is already in the workspace, the namespace
tree is not copied again.

If the workspace contains several OLEServer or ActiveXControl objects which have
different ultimate parents, their namespace trees will be copied in separately.

Parameters

With the exception of maxws (see above) the Dyalog APL DLL does not read param-
eters from the registry, command-line or environment variables. This means that all
such parameters will have their default values.
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System Errors

Introduction

Dyalog APL will display a System Error Dialog and (normally) terminate in one of
two circumstances:

e As aresult of the failure of a workspace integrity check
e As aresult of a System Exception

aplcore file

In these circumstances, APL saves an apl/core file which may be sent to Dyalog for
diagnosis. The default name and location of the aplcore file may be specified by the
AplCoreName parameter. This parameter may also be used to suppress generation of
the aplcore file.

Workspace Integrity

When you ) SAVE your workspace, Dyalog APL first performs a workspace integrity
check. If it detects any discrepancy or violation in the internal structure of your work-
space, APL does not overwrite your existing workspace on disk. Instead, it displays
the System Error dialog box and saves the workspace, together with diagnostic infor-
mation, in an aplcore file before terminating.

A System Error code is displayed in the dialog box and should be reported to Dyalog
for diagnosis.

Note that the internal error that caused the discrepancy could have occurred at any
time prior to the execution of ) SAVE and it may not be possible for Dyalog to iden-
tify the cause from this aplcore file.

If APL is started in debug mode with the —D¢, -Dw or —DW flags, the Workspace
Integrity check is performed more frequently, and it is more likely that the resulting
aplcore file will contain information that will allow the problem to be identified and
corrected.
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System Exceptions

Non-specific System Errors are the result of Operating System exceptions that can
occur due to a fault in Dyalog APL itself, an error in a Windows or other DLL, or
even as a result of a hardware fault. The following system exceptions are separately

identified.

Code | Description

Suggested Action

900 occurred

A Paging Fault has

As the most likely cause is a temporary
network fault, recommended course of
action is to restart your program.

991 |Run-Time DLL.

990 | An exception has occurred
& in the Development or

via [NA

An exception has occurred | Carefully check your [JNA statement and
995 |in a DLL function called the arguments that you have passed to

the DLL function

An exception has occurred
996 |in a DLL function called As above
via a threaded [ONA call

An exception has occurred
997 | while processing an
incoming OLE call

An exception has been
999 |caused by Dyalog APL or
by the Operating System

Recovering Data from aplcore files

Objects may often (but not always) be recovered from aplcore using ) COPY. Note
that because (by default) the aplcore file has no extension, it is necessary to explicitly
add a dot, or APL will attempt to find the non-existent file aplcore. DWS, i.e.

)JCOPY aplcore.
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Reporting Errors to Dyalog

If APL crashes and saves an aplcore file, please email the following information to
support@dyalog.com:

1. a brief description of the circumstances surrounding the error

2. details of your version of Dyalog APL: the full version number, whether it
is Unicode or Classic Edition, and the BuildID. This information appears in
the Help->About box; the Copy button copies this information into the clip-
board, from where it can be pasted into an email etc.

3. the aplcore file itself

If the problem is reproducible, i.e. can be easily repeated, please also send the appro-
priate description, workspace, and other files required to do so.

System Error Dialog Box

The System Error Dialog illustrated below was produced by deliberately inducing a
system exception in the Windows DLL function memcpy () . The functions used
were:

v foo
[1] goo

vV goo
[1] hoo

V hoo
[1] crash

V crash
[1] [ONA'dyalog32|MEMCPY u u u'
[2] MEMCPY 255 255 255
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-

Dyalog APL/W version 13.0.7041.0

An exception haz occurred in an external DLL.
|n warkzpace [process [D:23660]
Syzermor 395 code: O
Interpreter BuildiD: 0=51930699
|nterpreter Created: Feb 1 2017 at 18:38:07
Interpreter Yerzion 13.0.7841.0
Sernial Hurnber ; 000042

If pou chooze to generate an aplcore, it will be aved asz: "'C:A\Documents and
SettingzhPetehaplcore',

[t may be poszible to retrieve local varables and other objects from thiz file using [JC5

APL Stack trace-=

#.crash[2] MEMCPY 255 255 255
#.hooll] crazh

#t.gooll] hoo

#.fool[l] goo

[ Generate complete image core
[ Create trappable error

[w Create an aplcore file

Copy to clipboard |

[ Pasz exception on to operating system Continue
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Options
Item Parameter Description
CGoeélleEZiZ Dumps a complete core image with the
comp CreateAplCoreonSyserror | User Mode Process Dumper (a
image .
Microsoft tool) - see below.
core
If you check this box (only enabled on
Create System Error codes 995 and 996), APL
Trappable will not terminate but will instead
Error generate an error 91 (EXTERNAL DLL
EXCEPTION) when you press Dismiss.
Create an If this box is checked, an aplcore file
aplcore CreateAplCoreonSyserror | .
will be created.
file
Pass
exception If this box is checked, the exception
on to PassExceptionsToOpSys | will be passed on to your current
operating debugging tool (e.g. Visual Studio).
system
Copy to Copies the contents of the APL stack
clipboard trace window to the Clipboard.

Generate complete image core

The Generate complete image core option attempts to execute

[SYSDIR] \userdump.exe,where [SYSDIR] isthe windows system directory
(typically c:\windows\system32, and userdump . exe is the User Mode Process
Dumper, a Microsoft tool that can be downloaded from the following url (which you
may copy from Winhelp and paste into a browser):

http://www.microsoft.com/downloads/details.aspx?
FamilyID=e23cd741-d222-48df-9cd8-28796f414256&DisplayLang=en

The process creates a file called dyalog.core in the current directory. This file con-
tains much more debug information than a normal aplcore (and is much larger than an
aplcore) and can be sent to Dyalog Limited (zip it first please). Alternatively the file
can be loaded into Visual Studio .Net to do your own debugging.
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Debugging your own DLLs

If you are using Visual Studio, the following procedure should be used to debug your
own DLLs when an appropriate Dyalog APL System Error occurs.

Ensure that the Pass Exception box is checked, then click on Dismiss to close the Sys-
tem Error dialog box.

The system exception dialog box appears. Click on Debug to start the process in the
Visual Studio debugger.

After debugging, the system exception dialog box appears again. Click on Don't
send to terminate Windows' exception handling.

ErrorOnExternalException Parameter

This parameter allows you to prevent APL from displaying the System Error dialog
box (and terminating) when an exception caused by an external DLL occurs. The fol-
lowing example illustrates what happens when the functions above are run, but with
ErrorOnExternal Exception set to 1.

0«2 ONQ'.' 'GetEnvironment'
"ErrorOnExternalException’
1
foo
EXTERNAL DLL EXCEPTION
crash[2] MEMCPY 255 255 255
A

OEN
91

)SI
crash[2]x
hoo[1]
goo[1]
foo[1]
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Chapter 2:

The APL Environment

Introduction

The Dyalog APL Development Environment includes a Session Manager, an Editor,
and a Tracer all of which operate in windows on the screen. The session window is
created when you start APL and is present until you terminate your APL session. In
addition there may be a number of edit and/or trace Windows, which are created and
destroyed dynamically as required. All APL windows are under the control of Win-
dows and may be selected, moved, resized, maximised and minimised using the stand-
ard facilities that Windows provides.

APL Keyboards

The Classic and Unicode Editions of Dyalog APL for Windows use different tech-
niques for mapping keystrokes to APL characters and to special command shortcuts.

The Classic Edition uses a proprietary technique for these mappings. The Unicode
Edition uses Microsoft’s IME (Input Method Editor) technology. Many other appli-
cations use the same technology, which means that the Dyalog Unicode IME may be
used not only with Dyalog APL for Windows Unicode Edition, but also with word
processing applications, spreadsheets, terminal emulators etc. Therefore with the Dya-
log Unicode IME installed, and with a suitable font selected, APL characters can be
entered and viewed in many other applications.

In both Classic and Unicode Editions APL characters are generated when the user
presses certain combinations of meta keys in conjunction with the normal character
keys. Meta keys include Shift, Ctrl and Alt.

For both input techniques it is possible to alter the mapping of keystrokes to APL
characters, and to add support for new languages. It is also possible to alter the key-
strokes which define special command keyboard shortcuts. For further details, see
"Unicode Edition Keyboard" on page 64 or "Classic Edition Keyboard" on page 70
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Unicode Edition

Previous Unicode Editions of Dyalog APL used the Dyalog Ctrl or Dyalog AltGr
keyboard or the old IME to enter APL characters. With Version 13.1 the Dyalog Ctrl
and Dyalog AltGr keyboards are no longer issued and the Dyalog Unicode IME is
the sole input mechanism for APL characters. The Dyalog Unicode IME can be used
with previous Unicode Editions of Dyalog APL provided that they are patched to a
Version created on or after 15t April 2011.

Note that previous versions of Dyalog APL included the Comfort on-screen key-
board; which has been withdrawn.

Further details and a list of languages supported are described in the Dyalog Unicode
IME section below.

Classic Edition

The mapping for each of the JAV positions and its associated keystroke is defined by
a selectable translate table. JAV includes all the APL symbols used by Dyalog APL
as well as all the (non-APL) characters which appear on a standard keyboard. This
mapping only works with Classic Edition.

The Classic Edition installation also includes the Dyalog Unicode IME (described
below) so that users may enter APL characters into other applications; the Dyalog
Unicode IME is however not used by the Classic Edition itself.

The Classic Edition includes support for Danish, Finnish, French, German, Italian,
Swedish, and both British and American English keyboards. The default keyboard
mapping for unsupported languages is American English.

Dyalog Unicode IME

The Dyalog Unicode IME defines the mapping of keystrokes to Unicode characters.
Only keystrokes which resolve to characters that either do not appear on the standard
keyboard or which differ from those that appear on the standard keyboard are
included in the selectable translate table. In effect the Dyalog Unicode IME can be
regarded as an overlay of the standard keyboard which contains just APL characters.

Dyalog intends to extend the Dyalog Unicode IME to include a mechanism that will
allow any overstrike combination to be added, and that the Dyalog Unicode IME
will be made freely available and not be reserved just for Dyalog APL users.

This new Dyalog Unicode IME replaces the previously issued IME, as well as the
Dyalog Ctrl and Dyalog AltGr keyboards.

The Dyalog Unicode IME supplied with Version 13.1 includes support for Danish,
Finnish, French, German, Italian, Swedish and British and American English key-
boards, based on the Version 12.1 Dyalog Ctrl layouts.
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The Dyalog Unicode IME also has support for the Danish, British and American Eng-
lish physical keyboards, which are available from Dyalog Ltd. It also includes sup-
port for Spanish and German keyboards based on the layout of the Dyalog hardware
keyboard.

The default keyboard mapping for unsupported languages is American English.

The IME translate tables include mappings for the special command keystrokes used
by Dyalog APL.

These command keystroke mappings are ignored by applications unless the appli-
cation is explicitly named in the Dyalog Unicode IME configuration. It is expected
that only terminal emulators used for running UNIX-based versions of Dyalog APL
will use this feature.

In particular, Dyalog APL for Windows Unicode Edition does not use the mappings
in the translate tables; the mappings are defined under Options/Configure/Keyboard
Shortcuts (see "Keyboard Shortcuts Tab" on page 131).

To allow you to identify which IME you are using, the Dyalog Unicode IME uses a
different icon to that used in previous Versions as shown below:

The Dyalog Unicode IME

The old APL IME

Session Manager

The Dyalog APL/W session is fully configurable. Not only can you change the
appearance of the menus, tool bars and status bars, but you can add new objects of
your choice and attach your own APL functions and expressions to them. Functions
and variables can be stored in the session namespace. This is independent of the
active workspace; so there is no conflict with workspace names, and your utilities
remain permanently accessible for the duration of the session. Finally, you may set up
different session configurations for different purposes which can be saved and loaded
as required.

The session window is defined by an object called SE. This is very similar to a
Form object, but has certain special properties. The menu bar, tool bar and status bars
on the session window are in fact MenuBar, ToolControl and StatusBar objects
owned by [OSE. All of the other components such as menu items and tool buttons are
also standard GUI objects. You may use [JWC to create new session objects and you
may use OWS to change the properties of existing ones. OWG and OWN may also be
used with [JSE and its children.
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Components of the session that perform actions (Menultem and Button objects) do so
because their Event properties are defined to execute system operations or APL
expressions. System operations comprise a pre-defined set of actions that can be per-
formed by Dyalog APL/W. These are coded as keywords within square brackets. For
example, the system operation [WSClear] producesa clear ws, after first dis-
playing a dialog box for confirmation. Y ou may customise your session by adding or
deleting objects and by attaching system operations or APL expressions to them.

Like any other object, [SE is a namespace that may contain functions and variables.
Furthermore, JSE is independent of the active workspace and is unaffected by
)LOAD and ) CLEAR. It is therefore sensible to store commonly used utilities, par-
ticularly those utilities that are invoked by events on session objects, in [SE itself,
rather than in each of your application workspaces.

The possibility of configuring your APL session so extensively leads to the require-
ment to have different sessions for different purposes. To meet this need, sessions are
stored in special files with a .DSE (Dyalog Session) extension. The default session
(i.e. the one loaded when you start APL) is specified by the session_file parameter.

Y ou may customise this session and then save it over the default one or in a separate
file. You can load a new session from file at any stage without affecting your active
workspace.

Positioning the Cursor

The cursor may be positioned within the current APL window by moving the mouse
pointer to the desired location and then clicking the Left Button. The APL cursor
will then move to the character under the pointer.

Selection

Dragging the mouse selects the text from the point where the mouse button is
depressed to the point where the button is released. When you select multiple lines,
the use of the left mouse button always selects text from the start of the line. A con-
tiguous block of text can be selected by dragging with the right mouse button.

Double-clicking the left mouse button to the left of a line selects the whole line,
including the end-of-line character.

Scrolling

Data can be scrolled in a window using the mouse in conjunction with the scrollbar.
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Invoking the Editor

The Editor can be invoked by placing the mouse pointer over the name of an editable
object and double-clicking the left button on the mouse. If you double-click on the
empty Input Line it acts as "Naked Edit" and opens an edit window for the suspended
function (if any) on the APL stack. For further details, see "Invoking the Editor" on
page 207. See also "DoubleClickEdit " on page 18.

The Current Object

If you position the input cursor over the name of an object in the session window,
that object becomes the current object. This name is stored in the CurObj property of
the Session object and may be used by an application or a utility program. This
means that you can click the mouse over a name and then select a menu item or click
a button that executes code that accesses the name.

The Session Pop-up Menu

Clicking the right mouse button brings up the Session pop-up menu. This is
described later in this chapter.

Drag-and-Drop Editing

Drag-and-Drop editing is the easiest way to move or copy a selection a short distance
within an edit window or between edit windows.

To move text using drag-and-drop editing:

1. Select the text you want to move.

2. Point to the selected text and then press and hold down the left mouse but-
ton. When the drag-and-drop pointer appears, drag the cursor to a new loca-
tion.

3. Release the mouse button to drop the text into place.

To copy text using drag-and-drop editing:

1. Select the text you want to move.

2. Hold down the Ctrl key, point to the selected text and then press and hold
down the left mouse button. When the drag-and-drop pointer appears, drag
the cursor to a new location.

3. Release the mouse button to drop the text into place.

If you drag-and-drop text within the Session window, the text is copied and not
moved whether or not you use the Ctrl key.
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Interrupts

To generate an interrupt, click on the Dyalog APL icon in the Windows System
Tray; then choose Weak Interrupt or Strong Interrupt. To close the menu, click
Cancel. Altematively, to generate a weak interrupt, press Ctrl+Break, or select
Interrupt from the Action menu on the Session Window.

Unicode Edition Keybhoard

Introduction

Unicode Edition supports the use of standard Windows keyboards that have the addi-
tional capability to generate APL characters when the user presses Ctrl, Alt, AltGr (or
some other combination of meta keys) in combination with the normal character
keys.

Version 13.1 is supplied with the Dyalog Unicode IME keyboard for a range of dif-
ferent languages as listed below. These keyboards have the same mappings as the
Dyalog Ctrl keyboard layouts used in Version 12.1. The intention is that only APL
characters and characters that appear in locations different from the underlying key-
board are defined; any other keystroke is passed through as is.

Installation

During the Installation of Dyalog Version 13.1 Unicode Edition, setup installs the
Dyalog Unicode IME (IME). For any given Input Language the IME consists of an
additional service for that Input Language, and a translate table which maps key-
strokes for the appropriate keyboard to Unicode code points for APL characters

An IME service is installed for every Input Language that the user who installs Dya-
log APL has defined, as well as every Input Language for which Dyalog has support.

The keyboard mappings are defined for the following national languages:

e Danish, Finnish, French, German, Italian, Swedish and British and American
English keyboards (based on the Dyalog APL Version 12.1 Ctrl layouts)

e Danish, British and American English physical keyboards, as supplied by
Dyalog Ltd.

e German and Spanish keyboards based on the Dyalog hardware keyboard lay-
out

For any other Input Language the American English translate table is selected.

Note that some Input Languages are defined to be substitutes for other Input Lan-
guages; for example Australian English Input is a substitute for American English
Input, Austrian German Input a substitute for German German Input. In these cases
the IME will install the appropriate translate table.
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It is also possible to create support for new languages or to modify the existing sup-
port. See the IME User Guide for further details.
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Configuring the Dyalog APL IME

The following description uses screenshots taken from a Windows 7 PC with three
Input Languages configured for the current user: English (United Kingdom) - the
default Input Language, Danish (Denmark) and English (United States).

The Dyalog Unicode IME is added as an additional service to all keyboards defined
to the user and the administrator at the time that the IME was installed.

For each IME the underlying keyboard layout file will be the same as that defined for
the base keyboard. The layout file is a DLL created by Microsoft.

The language specified in the description of the IME is the name of the IME translate
table that has been associated with the IME for the specific keyboard. In the case of
languages not supported by the IME the keyboard will default to en-US. With the
IME as supplied with Version 13.1 altering this text requires editing the appropriate
Registry value.

The IME may be configured from within APL or from Windows.

From within Dyalog APL

To change the properties of the IME go to Options/Configure/Unicode Input tab and
select Configure Layout:

5B Dyalog APL/W Configuration
Trace /Edi ] Auto Complete SALT ] Uszer Commands ] Object Syntax I
General Unicode Input l Kevboard Shortouts ] wiorkspace ‘windows ] Session ] Log ]

[walog can automatically load youwr selected keyboard when the session window iz made wisible:

v iictivate selected keyhoard I~ Show keyboards for all languages
Kevboard:
|Dyalog APL IME [en-GE) |

LConfigure Layout. ..

QK | Catcel
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From Windows

Right click on either the Input Language icon or the Keyboard layout icon in the
TaskBar and select Settings:

Restore the Language bar

Additional icons in taskbar

Adjust the Language band position
¥ Auto Adjust

Setlings...

Close the Lenguage bar

General | language Bar | Advanced Key Seftings |

Default input language

Select one of the installed input languages to use as the default for all input
fields,

| English {United Kingdem} - United Kingdom -

Installed services

Select the services that you want for each input language shown in the list.
IUse the Add and Remove buttons to modify this list.

(5] English {United Kingdom) -
.5 Keyhoard E
~ = lnited Kingdom
- Dyalog APL IME {en-GE}

Gl Danish (Denmark)

REMoVE
~ = [yalog APL IME {da-DK}
(5} English {United States)

.‘él Kevhoard Mowe Lo
~ o 1S
~ »  [halog APL IME (en-US) * ||  Meve Down

Properties.

[ ok [ cancel || oov
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To alter the configuration of any of the installed IMEs, select that IME and click on

Properties:

Dyalog APL Input Method Editor Properties

Bx]

Input Tranzlate Table:

|E:'xF'rcugram FilezhDyalog'UnicodelME \aplkeyshen-GE. din

[v Enable Dwverstrikes
[ Owerstrikes do nat require the '05" introducer key [experimental]

[v Usze Overstike popup

Browsze. ..

k. | Cancel

Input translate table:

The translate table defines the mapping between APL characters and the keystrokes
that generate those APL characters. It is possible to alter the mapping or to create sup-
port for new keyboards by altering the translate table, or by selecting a different trans-

late table. See the IME User Guide for more details.

Overstrikes:

In the original implementations of APL, many of'the special symbols could only be
generated by overstriking one character on top of another as is reflected in the appear-
ance of the glyphs. For example, the symbol for Grade Up (4) is actually the symbol

for delta (A) superimposed on the symbol for vertical bar ()

In Dyalog APL such symbols can be generated either by a single keystroke, or (in
Replace mode) by overtyping one symbol with another. For example 4 may be gen-
erated using Shift+Ctrl+4, or by switching to Replace mode and typing the three key-

strokes Ctrl+h, Left-Cursor, Ctrl+m.

Using the Dyalog Unicode IME the character can also be entered by pressing
Ctrl+Bksp, Ctrl+m, Ctrl+h. Note that Ctrl+Bksp is the default Overstrike Introducer

Key (key code ONS).



Chapter 2: The APL Environment 69

Use Overstrike popup:

With this option selected, when the character following the Overstrike Introducer
Key is pressed, a popup box displays all the overstrikes which contain the last char-
acter typed: in the example below Ctrl+Bksp has been followed by Ctrl+h:

Lo =

b CLEAR WS - Dyalog APL/W N =

File Edit View Windows Session Log Action ™ Options Tools Threads

Help
ws D=0 E 2] ot BB By W b B2 | TCII'."|l:EE|I‘t_ Session
Language Bar ~lel=] EJ
[z l=e o]t 2] [Hr[t]efr[a]] [=lelsl<P[=l=l7] Va3 & |y
= | B
=)
Debugger slalx

Ready... Rep |NUM '

Curlbj: & (Ur |B:1 Oog:0 |OTRAP |OSI:0 |0IO:1 |OML:0

Note the fine (red) line under the A in the Session window. This indicates that an
overstrike creation operation is in progress.

The input of the symbol 4 can be completed by pressing Ctr+m, or by moving the
selection up and down the pop-up list using Cursor-Up or Cursor-Down
Overstrikes do not require the OS introducer key (exper-
imental):

With this option selected, the IME identifies characters which are part of a valid over-
strike, and when such a character is entered into the session, begins an overstrike cre-
ation operation. This mode is experimental in the IME supplied with Version 13.1.
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Classic Edition Keyboard

The standard Version 13.1 Classic Edition keyboard tables are files supplied in the
aplkeys sub-directory named cc.din where cc is the standard 2-character country
code,e.g. uk.din.

Note that the standard tables do not support the entry of APL underscored characters
AABCDEFGHIJKLMNOPQRSTUVWXYZ.

The standard table supports two modes of use; traditional (mode 0) and unified
(mode 1). The keyboard starts in mode 1 and may be switched between modes by
clicking the Uni/Apl field in the status bar or by keying * on the Numeric-Keypad.

Unified Layout

The following picture illustrates the standard UK keyboard Unified layout.

Fle Edt View Keyboard Options Help
| F1| F2| F3| Fa| Fs

'I1|2l31‘*|5I6|?|EI310|-l=|

Fe | F7| F8 | Fa| F1o] Fi1] Faz

ol o ef o] e o o] ifo]e]efa]™™]
R S N N L O S O
I‘T[\lz|x|c|u|b|n|m|,|.|,=|I“1‘|
 Ctrl | | (Blank? | m | ™ ctrl|
[ MO = M

C-\Program Files\Dyalog\Dyalog APL 12.1 Classichaplkeys\uk.din - Keyboard=UK * 241




Chapter 2: The APL Environment

4

APL symbols are entered using the Ctrl and Ctrl+Shift keys as illustrated below.

File Edt View Keyboard Oplions Help
Esc | F25| F26| 27| F28| F2s| Fao| Fa1| Faz| F3a| F34| Fas| Fas

SRR NN
0 I e I Y Y Y Y T

U T I S N 1 N

rt el | | faf~] ]| ]rt]

% ctrl | | {Blank? | roaiter | @ ctr |

| O Mo &

|C:\Program Files\Dyalog\Dyalog APL 12.1 Classichapkeys\uk din - Keyboard=UK* | 24,1

File Edt View Keyboard Options Help

2221 o
| =1 o] ] o] e | o] x| & 1]
] ] ) N
L2 N Y |Iﬂl-|=|-'|

i = EEIET =1 =T

8 |
Exec
o |

gl v| 4| ¢ X

|
hla
|

([

% Ctrl | | {Blank? | = oaiter | @ ctr|

! [CM0 @

C:\Program Files\Dyalog\Dyalog APL 121 Classichapkeys\uk. din - Keyboard=UK * | 2.4.1
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Traditional Layout

The following picture illustrates the standard UK keyboard Traditional layout.

Fle Edt View Keyboard Options Hep
Esc| F1| F2| Fa| Fa| Fs| re| F7| Fa| Fa| Fio| F11] Fi2|

| 1) 2| 3] afs]e|r]8fs|of ||
e | | o] o) e | ]

S LN R N N R B S I O Y

Fe | elz|x|c|luls|n|nu].] | |rt]
I ctel | | {Blank? | ImiALter | - ctrd |
I (& MO M1 |

C:\Program Files\Dyalog\Dyalog APL 12.1 Classichaplkeyshuk. din - Keyboard=UK. * 24.1

APL symbols are entered using the Shift and Ctrl+Shift keys as illustrated below.

Fle ESt View Keyboard Options Help
esc | F13| F14| Fis| Fie| Fiz| Fis| Fis| Fao| 21| F22| Fa3| Fa4

<3 ] Il ) ] ) ) I ] ) ) |
w21l 1A R 3 . R [N Y

S U3 N S S Y N I - S N

2 O Y I N [

Exec
|

I ctrl| | {Blank> | miauter | rctel|

I (& MO M|
C:\Program Files\Dyalog\Dyalog APL 12.1 Classicapkeys\uk.din - Keboard=UK* | 241
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Fle Edt View Keyboard Options Help

R e e v e o o v
g | I | e ) ) I e I el e
S T Y
(AN O O N O
S0 N N VU U Y Y O N
@ ctrl | | (Blank? | = | # ctr1|
| MO M
C:\Program Files\DyalogADyalog APL 12.1 Classichaplkeys\uk.din - Keyboard=UK * 241

Line-Drawing Symbols

Classic Edition includes 12 single-line graphics characters for drawing lines and
boxes. Line-drawing characters are entered using the keys on the numeric keypad in
conjunction with the Ctrl key as shown below. Num Lock must be on.

Normal Ctrl
7 8 9 r T L
4 5 6 F + i
1 2 3 L 4 d
0 : | —

Note:to accommodate other characters, line-drawing symbols are located in the non-
printable area of the font layout. Although these characters can normally be used in
output to the session (function: DISP in the UTIL workspace uses them), many
printer drivers and some display drivers will not display characters from these
positions in the font.
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Keyboard Shortcuts

The terms keyboard shortcut (Unicode Edition) and command (Classic Edition) are
used herein to describe a keystroke that generates an action, rather than one that
produces a symbol.

Unicode Edition

Unicode Edition provides a number of shortcut keys that may be used to perform
actions. For compatibility with Classic Edition and with previous Versions of Dya-
log APL, these are identified by 2-character codes; for example the action to start the
Tracer is identified by the code <TC>, and mapped to user-configurable keystrokes.

In the Unicode Edition, Keyboard Shortcuts are defined using Options/Con-
figure/Keyboard Shortcuts and stored in the Windows Registry. Note that the Uni-
code IME translate tables have definitions for the Keyboard Shortcuts too; these are
ignored by the interpreter, and are intended for use with terminal emulators being
used in conjunction with non-GUI versions of Dyalog APL.

To the right of the last symbol in the Language Bar is the Keyboard Shortcut icon

=1 If you hover the mouse over this icon, a pop-up tip is displayed to remind you of
your keyboard shortcuts as illustrated below.

f55 CLEAR WS - Dyalog APLIW M=%
Ele Edi Yiew MWindows Session Log Action Options Tools Threads Help
ws [ =0 E $] | obect B B Bg ¥ i B2 @ 2 || Tool O G [ | Edit X3 Cu || Session [ |4PLIBS Unicode  w|[ 16
Language Bar B =T ﬁ
[ITEREERRE] MMEH FRERREEE A[lRI0]ef] [+e[vol<] [LTel¢lole] PEELTe] DfElef] [Plallukl] = &
[Dyalog AFL/W Version 13.0.78L1
Serial Mo @ 000042 Aﬁ
Unicode Edition @ Other Keyboard Shortcuts
;;:';Z;ESZEIEZ;?EWZE;IB“‘“j QT: Quit (and lose changes): Shift+Ese
; TB: Tab between windows: (Hone)
crear we ET: Back Tab betwsen windows: (Mone)
EP: Exit (and save changes): Esc
RS: Right Scresn: (Hone)
LS: Left Screen: (Hone)
CT: Cut: (Hone)
CP: Copy: (Hone)
PT: Paste: (Hone)
RD: Reformat: Hum divide
DK: Delets Block: Control+Dslete
FD: Forward or Redo: Control+Shift+Enter
BK: Backward or Undo: Control+Shift+Back
SC: Search: (Hone)
RP: Replace: (Hone)
NX: Next: (Hone)
PY: Previous: (Hone)
ED: Edit: Shift+Enter
TC: Trace: Control+Enter
FX: Fix the current function: (Hone)
LH: Toggle Line numbers: Hum -
BH: Run tao exit (in tracer): (Hane)
BP: toggle breakpoint: (Hone)
RM: Rezume execution (in tracer): (Hone)
TL: toggle localisation: Control+Up
UA: undo all changes: (Hone)
A0: Add comments: (Hone)
DO: Del comments: (Hone)
BL: Go to Line: (Hone)
TO: Toggle outline: (Hone)
MO: Goto matching outline: (Mane)
S1: Exit script and fix entire script: (None)
$2: Exit soript and anly fix functions: (Mane) =]
. : . =
T — 0S: Begin overstrike sequence: (Mane) =
Ready...
CurObj: 3:l opba:o |[OTRAP Os1:o [OI0:1 [OML:o
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Classic Edition

Commands fall into four categories, namely cursor movement, selection, editing direc-

tives and special operations, and are summarised in the following tables. The input
codes in the first column of the tables are the codes by which the commands are iden-
tified in the Input Translate Table.

Table 1: Cursor Movement Commands

Input ..

Code Keystroke Description

LS Ctrl+PgUp Scrolls left by a page

RS Ctrl+PgDn Scrolls right by a page

uUsS PgUp Scrolls up by a page

DS PgDn Scrolls down by a page

LC Left Arrow Moves the cursor one character position to the left

RC Right Arrow Moves the cursor one character position to the
right

DC Down Arrow Moves t.he cursor to the currenF character position
on the line below the current line

uc Up Arrow Moves t.he cursor to the curren't character position
on the line above the current line

UL Ctrl-Home M'ove the cursor to the top-left position in the
window

DL Ctrl+End Move§ the cursor to the bottom-right position in
the window

RL End Moves the cursor to the end of the current line

L Home Moves the cursor to the beginning of the current
line

LW CtrltLeft Arrow Moves the cursor to the beginning of the word to
the left of the cursor

Ctrl+Right Moves the cursor to the end of the word to the
RW .
Arrow right of the cursor

TB Ctrl+Tab Switches to the next session/edit/trace window

BT Ctrl-Shifi+Tab SWltches to the previous session/edit/trace
window
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Table 2: Selection Commands

Input s
Code Keystroke Description
Le ShifttLeft Arrow Extends the selection one character position to
the left
Re Shift+Right Extends the selection one character position to
Arrow the right
L Ctrl+Shift+Left | Extends the selection to the beginning of the
W Arrow word to the left of the cursor
Ctrl+Shift+Right | Extends the selection to the end of the word to
Rw .
Arrow the right of the cursor
Uc Shift+Up Arrow Extf:r'lds the selec'tlon to the current chgracter
position on the line above the current line
De Shift+Down Extends the selection to the current character
Arrow position on the line below the current line
L Shift-Home Extends 'the selection to the beginning of the
current line
Rl ShifitEnd Extends the selection to the end of the current
line
Ul Ctrl-Shifi+ Home Extequ t.he selecFlon to the beginning of the
first line in the window
DI Ctrl-Shifi+End Extends 'the selection to the end of the last line
in the window
Us Shift+PgUp Extends the selection up by a page.
Ds Shift+PgDn Extends the selection down by a page
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Table 3: Editing Directives

g‘fgz Keystroke Description

DI Delete Deletes the selection

DK |Cutebelete | POe e cred ines i the Session Log.
CT Shifi+Delete 1;?3;,2;3 the selection and copies it to the
CP Ctrl+Insert Copies the selection into the clipboard

FD Ctrl+Shifi+Enter | Reapplies the most recent undo operation
BK Ctrl+Shift+Bksp | Performs an undo operation
st Come e oot e bt
OP Ctrl-Shifi+ Insert ir;s:r(tsdailtgia(r)lllfl}lli)ne immediately after the current
HT Tab Indents text

TH Shift+Tab Removes indentation

RD Keypad-slash Reformats a function (editor only)

TL Ctrl+Alt+L Toggles localisation of the current name
GL Ctrl+Alt+G Go to [line]

AO Ctrl+Alt+, Add Comments

DO Ctrl+Alt+. Delete Comments
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Table 4: Special Operations

215;; Keystroke Description

IN Insert Insert on/off

LN Keypad-minus |Line numbers on/off
ER Enter Execute

ED Shift+Enter Edit

TC Ctrl+Enter Trace

EP Esc Exit

QT Shift+Esc Quit
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The Session Colour Scheme

Within the Development Environment, different colours are used to identify different
types of information. These colours are normally defined by registry entries and may
be changed using the Colour Configuration dialog box as described later in this chap-
ter. In the Classic Edition, colours may alternatively be defined in the Output Trans-
late Table (normally WIN.DOT). This table recognises up to 256 foreground and 256
background colours which are referenced by colour indices 0-255. These colour
indices are mapped to physical colours in terms of their Red, Green and Blue inten-
sities (also 0-255). Foreground and background colours are specified independently
as Cnnn or Bnnn. For example, the following entry in the Output Translate Table
defines colour 250 to be red on magenta.

C250: 255 0 O + Red foreground
B250: 255 0 255 + Magenta background

The first table below shows the colours used for different session components. The
second table shows how different colours are used to identify different types of data
in edit windows.

Table 5: Default Colour Scheme - Session

Colour | Used for Default

249 Input and marked lines Red on White

250 Session log Black on White

252 Tracer : Suspended Function Yellow on Black

253 Tracer : Pendent Function Yellow on Dark Grey
245 Tracer : Current Line White on Red

Table 6: Default Colour Scheme Edit windows

Colour |Array Type Editable |Default

236 Simple character matrix Yes Green on Black
239 Simple numeric No White on Dk Grey
241 Simple mixed No Cyan on Dk Grey
242 Character vector of vectors Yes Cyan on Black
243 Nested array No Cyan on Dk Grey
245 [OR object No White on Red

248 Function or Operator No White on Dk Cyan
254 Function or Operator Yes White on Blue
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Syntax Colouring in the Session

As an adjunct to the overall Session Colour Scheme, you may choose to apply a syn-
tax colouring scheme to the current Session Input line(s). You may also extend syn-
tax colouring to previously entered input lines, although this only applies to input
lines in the current session; syntax colouring information is not remembered in the
Session Log.

Syntax colouring may be used to highlight the context of names and other elements
when the line was entered. For example, you can identify global names and local
names by allocating them different colours.

"Colour Selection Dialog" on page 153 for further details.
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The Session Window

The primary purpose of the session window is to provide a scrolling area within
which you may enter APL expressions and view results. This area is described as the
session log. Normally, the session window will have a menu bar at the top with a
tool bar below it. At the bottom of the session window is a status bar. However, these
components of the session may be extensively customised and, although this chapter
describes a typical session layout, your own session may look distinctly different. A
typical Session is illustrated below.
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A typical Session window

Window Management

When you start APL, the session is loaded from the file specified by the session_file
parameter. The position and size of the session window are defined by the Posn and
Size properties of the Session object JSE, which will be as they were when the ses-
sion file was last saved.

The name of the active workspace is shown in the title bar of the window, and
changes if you rename the workspace or ) LOAD another.

You can move, resize, minimise or maximise the Session Window using the standard
Windows facilities.
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In addition to the Session Window itself, there are various subsidiary windows
which are described later in the Chapter. In general, these subsidiary windows may
be docked inside the Session window, or may be stand-alone floating windows. You
may dock and undock these windows as required. The standard Session layout illus-
trated above, contains docked Editor, Tracer and SIStack windows.

Note that the session window is only displayed when it is required, i.e. when APL

requests input from or output to the session. This means that end-user applications

that do not interact with the user through the session, will not have an APL session
window.

Docking

Nearly all of the windows used in the Dyalog APL IDE may be docked in the Ses-
sion window or be stand-alone floating windows. When windows are docked in the
Session, the Session window is split into resizable panes, separated by splitters. The
following example, using the Status window, illustrates the principles involved. (The
use of the Status window is described later in this Chapter.)

To start with, the Status window is hidden. You may display it by selecting the
Status menu item from the Tools menu. It initially appears as a floating (undocked)
window as shown below.
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If you press the left mouse button down over the Status window title bar, and drag it,
you will find that when the mouse pointer is close to an edge of the Session window,
the drag rectangle indicates a docking zone as shown below. This indicates the space

that the window will occupy if you now release the mouse button to dock it.
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The next picture shows the result of the docking operation. The Session window is
now split into 2 panes, with the Status window in the upper pane and the Session log
window in the lower pane. You can resize the panes by dragging with the mouse.

You will notice that a docked window has a title bar (in this case, the caption is
Status) and 3 buttons which are used to Minimise, Maximise and Close the docked
window.
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The next picture shows the result of minimising the Status window pane. All that
remains of it is its title bar. The Minimise button has changed to a Restore button,
which is used to restore the pane to its original size.
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You can pick up a docked window and then re-dock it along a different edge of the

Session as illustrated below.
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Docking the Status window along the left edge of the Session causes the Session win-
dow to be split into two vertical panes. Notice how the title bar is now drawn ver-

tically.
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If you click the right mouse button over any window, its context menu is displayed.
Ifthe window is dockable, the context menu contains the following options:

Undocks the docked window. The window is displayed at

Undock whatever position and size it occupied prior to being docked.
Hlde. Hides the title bar of the docked window,
Caption

Specifies whether the window is currently dockable or is locked
Dockable | in its current state. You can use this to prevent the window from
being docked or undocked accidentally.

The last picture shows the effect of using Hide Caption to remove the title bar. In this
state, you can resize the pane with the mouse, but the Minimise, Maximise and Close
buttons are not available. However, you can restore the object's title bar using its con-

text menu.
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Entering and Executing Expressions

Introduction

The session contains the input line and the session log. The input line is the last line
in the session, and is (normally) the line into which you type an expression to be eval-
uated.

The session log is a history of previously entered expressions and the results they
produced.

Ifyou are using a log file, the Session log is loaded into memory when APL is started
from the file specified by the log_file parameter. When you close your APL session,
the Session log is written back out to the log file, replacing its previous contents.

In general you type an expression into the input line, then press Enter (ER) to run it.
After execution, the expression and any displayed results become part of the session
log.

You can move around in the session using the scrollbar, the cursor keys, and the
PgUp and PgDn keys. In addition, Ctrl+Home (UL) moves the cursor to the begin-
ning of the top-line in the Log and Ctrl+End (DL) moves the cursor to the end of the
last (i.e. the current) line in the session log. Home (LL) and End (RL) move the cursor
to the beginning and end respectively of the line containing the cursor.
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Language Bar

The Language Bar is an optional window which is initially docked to the Session
Window, to make it easy to pick APL symbols without using the keyboard.

If you hover the mouse pointer over a symbol in the APL Language Bar, a pop-up tip
is displayed to remind you of'its usage. If you click on a symbol in the Language Bar,
that symbol is inserted at the cursor in the current line in the Session.
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As you start to enter characters in an APL expression, the Auto Complete suggestions
pop-up window (AC for short) offers you a choice based upon the characters you
have already entered and the current context.

For example, if you enter a [1, AC displays a list of all the system functions and var-
iables. If you then enter the character r, the list shrinks to those system functions and
variables beginning with the letter r, namely Orefs,0r L, and Ort L. Instead of
entering the remaining characters, you may select the appropriate choice in the AC
list. This is done by pressing the right cursor key or (in PocketAPL) by tapping the
choice in the list.

If you begin to enter a name, AC will display a list of namespaces, variables, func-
tions, operators that are defined in the current namespace. If you are editing a func-
tion, AC will also include names that are localised in the function header.

If the current space is a GUI namespace, the list will also include Properties, Events
and Methods exposed by that object.
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As an additional refinement, AC remembers a certain number of previous auto com-
plete operations, and uses this information to highlight the most recent choice you
made.

For example, suppose that you enter the two characters ) c. AC offers you )clear
thru' ) cs, and you choose ) cs from the list. The next time you enter the two char-
acters ) c, AC displays the same list of choices, but this time ) cs is pre-selected.

You can disable or customise Auto Completion from the Auto Complete page in the
Configuration dialog box which is described later in this chapter.

Executing an Expression

To execute an expression, you type it into the input line, then press Enter (ER). Alter-
natively, you can select Execute from the Action menu. Following execution, the
expression and any displayed results become part of the session log.

Instead of entering a new expression in the input line, you can move back through
the session log and re-execute a previous expression (or line of a result) by simply
pointing at it with the cursor and pressing Enter. Alternatively, you can select
Execute from the Action menu. You may alter the line before executing it. If you do
so, it will be displayed using colour 249 (Red on White), the same as that used for the
input line. When you press Enter the new line is copied to the input line prior to
being executed. The original line is restored and redisplayed in the normal session
log colour 250 (Black on White).

An alternative way to retrieve a previously entered expression is to use
Ctrl+Shift+Bksp (BK) and Ctrl+Shift+Enter (FD). These commands cycle backwards
and forwards through the input history, successively copying previously entered
expressions over the current line. When you reach the expression you want, simply
press Enter to re-run it. These operations may also be performed from the Edit menu
in the session window.

Executing Several Expressions

You can execute several expressions, by changing more than one line in the session
log before pressing Enter. Each line that you change will be displayed using colour
249 (Red on White). When you press Enter, these marked lines are copied down and
executed in the order they appear in the log.

Note that you don't actually have to change a line to mark it for re-execution; you
can mark it by overtyping a character with the same character, or by deleting a lead-
ing space for instance.
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It is also possible to execute a contiguous block of lines. To do this, you must first
select the lines (by dragging the mouse or using the keyboard) and then copy them
into the clipboard using Shift+Delete (CT) or Ctrl+Insert (CP). You then paste them
back into the session using Shift+Insert (PT). Lines pasted into the session are always
marked (Red on White) and will therefore be executed when you press Enter. To
execute lines from an edit window, you use a similar procedure. First select the lines
you want to execute, then cut or copy the selection to the clipboard. Then move to
the session window and paste them in, then press Enter to execute them.

Session Print Width (PW)

Throughout its history, APL has used a system variable [JPW to specify the width of
the user's terminal or screen. Session output that is longer than [JPW is automatically
wrapped and split into multiple lines on the display. This feature of APL was
designed in the days of hard-copy terminals and has become less relevant in modern
Windows environments.

Dyalog APL continues to support the traditional use of [JPW, but also provides an
alternative option to have the system wrap Session output according to the width of
the Session Window. This behaviour may be selected by checking the Auto PW
checkbox in the Session tab of the Configuration dialog box.

Using Find/Replace in the Session

The search and replace facilities work not just in the Editor as you would expect, but
also in the Session. For example, if you have just entered a series of expressions
involving a variable called SALES and you want to perform the same calculations
using NEWSALES, the following commands will achieve it:

Enter SALES in the Find box,and NEWSALES in the Replace box. Now click the
Replace All button. You will see all occurrences of SALES change to NEWSALES.
Furthermore, each changed line in the session becomes marked (Red on White). Now
click on the session and press Enter (or select Execute from the Action menu).

Once displayed, the Find or Find/Replace dialog box remains on the screen until it is
either closed or replaced by the other. This is particularly convenient if the same oper-
ations are to be performed over and over again, and/or in several windows. Find and
Find/Replace operations are effective in the window that previously had the focus.
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Value Tips

If you hover the mouse pointer over a name in the Session or Debugger window, APL
will display a pop-up window containing the value of the symbol under the mouse
pointer.

For example, in the following picture the mouse pointer was moved over the name of
the variable HW in the Session window.
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The next picture illustrates the Value Tip displayed when the mouse is hovered over

the name of the variable MAT.
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Similarly, if you hover the mouse pointer over the name of a function, the system dis-

plays the body of the function as a pop-up, as illustrated below.
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Configuring Value Tips

You may enable/disable Value Tips and select other options from the General tab of
the Configuration dialog box as shown below.

You may experiment by changing the value of the delay before which Value Tips are
displayed, until you find a comfortable setting.

Note that the colour scheme used to display the Value Tip for a function need not
necessarily be the same colour scheme as you use for the function editor.

,
,ED Dyalog APL/W Configuration
Trace/Edit ] Auto Complete ] SALT ] Uger Commands ] Object Syntax ]
General l Unicode [nput ] Fepboard Shartcuts ] wiorkspace ] indows ] Session ] Leg ]

Recently used file list size: g

v Display Yalue Tips after; |500 [ms)

Calaur Scheme: |Default j

¥ Enable Mative Look and Feet

[ Apply Native Look and Feel to docked captions

Configuration saved in;
HKEY_CURREMT_USERMNSOFTwWARE DywalogiLiwalog APLAY 130 Unicode

0K | Cancel
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SharpPlot Graphics Tools

Introduction

Included with Dyalog APL (32-bit Windows versions only with the Microsoft .Net
Framework Version 2.0 or later installed) is the SharpPlot graphics library which is
part of the RainPro graphics package..

The Session includes 4 buttons which use SharpPlot to generate simple graphical pic-
tures of the contents of the Current Object (identified by the name under or to the left
of'the cursor).

For example, if you have a numerical matrix in a variable called MAT, you can plot it
by first positioning the cursor on the name MATin the Session window, and then click-
ing one of the 4 graphical buttons in the Session toolbar.

Data Structures
The charting function can plot variables with the following data structures:

e a simple numeric vector

e a vector of simple numeric vectors

e a simple numeric matrix

e a matrix whose first row contains simple character vectors and whose other
elements are simple numerics. In bar and line charts, the column headings in

row 1 are used as x-axis labels.

e a matrix whose first column contains simple character vectors and whose
other elements are simple numerics. In bar and line charts, the row headings
in column 1 are used as legends to annotate the different series.

e a matrix whose first row and first column both contain simple character vec-
tors and whose other elements are simple numerics. In bar and line charts,
the column headings in row 1 are used as x-axis labels, and the row head-
ings in column 1 are used as legends annotate the different series.
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Example: Bar Chart k&

Wine_Prices
1961 1964 1966
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Latour

8800 1342 1210
15400 2357.5 4600

Margaux 5980 672.5 920

Mouton

Rothschild 6710 713 2070

Haut-Brion 13225 1840 1323

a5l Causeway chart viewer
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Example: Line Chart &=

First_Growths
1961 1964 1966 1970 1975 1976 1978 ...
Lafite 8800 1342 1210 605 1380 2070 920 ...
Latour 15400 2357.5 4600 2760 1552 978 1058
Margaux 5980 672.5 920 632 900 800 1208

u Causeway chart viewer
File  Zoom
s al
First Growths
[ 8000
L6000
14000
12000
Lonon
000
6000
4000 4
2000
n 1 I 1 1 | 1 1 I 1 T
| 96 1970 1974 1981 1983 1986 1GR9 1994 1994 2000
—— Lafite —— Latour —— Murgaux
Implementation

The SharpPlot tools are implemented by four buttons in the Session toolbar. Each but-
ton has a Select callback which runs the function JSE .Chart .DoChart. This runs
[SE.Chart.Do which constructs and then runs a function named
[JSE.Chart.MyChart.

(SE.Chart.MyChart uses an instance of the SharpPlot graphics class to produce
a chart of your data, which it saves as a temporary file. It then calls the SharpPlot
viewer to display the file on your screen.
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SharpPlot is a library of graphical subroutines, (originally written in APL and
machine-translated into C#) which is implemented as a .Net Namespace named
Causeway and supplied in \bin\sharpplot.dll inthe Dyalog program direc-

tory.
Notes

Although SE.Chart .MyChart is overwritten by successive uses of the graphical
buttons, it is deliberately not erased each time. This allows you to use MyChart asa
simple template to develop your own custom graphics function.

The image is stored in Microsoft Enhanced Metafile Format in a temporary file whose
name and location are generated automatically. The system does not delete the tem-
porary file after use. For further details, See Get TempFileName in the Windows
documentation..

The default program used to display the EMF file is SharpView.exe. You can opt
to use a different EMF viewer by setting the Charts\ViewCMDregistry key to name
another program, such as Windows Picture and Fax Viewer.

An attempt to plot the contents of a variables with an unsupported data structure (see
above) is handled entirely by error trapping and will result in an error message box
and perhaps messages in the Status window.

The Session GUI Hierarchy

As distributed, the Session object [JSE contains two CoolBar objects. The first,
named [JSE . cb top runs along the top of the Session window and contains the tool-
bars. The second, named [SE . cbbot, runs along the bottom of the Session win-
dows and contains the statusbars.

The menubar is implemented by a MenuBar object named (JSE . mb.

The toolbars in JSE . cbtop are implemented by four CoolBand objects, bandtb1,
bandtb2,bandtb3 and bandtbl each containing a ToolControl named tb.

The statusbars in [JSE . cbbo't, are implemented by two CoolBand objects ,
bandtb1 and bandtb2, each containing a StatusBar named sb.
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The Session MenuBar

The Session MenuBar (OSE . mb) contains a set of menus as follows.

The File Menu

The File menu (OSE .mb . f i Le) provides a means to execute those APL System
Commands that are concerned with the active and saved workspaces. The contents of
a typical File menu and the operations they perform are illustrated below.

Mew
Qpen...
Copy...

Save

Save As...
Export, ..

Expart ta Memary

Drop...

Prinkt Setup...

Continue
Exit

1 Frihelpl 1. DVAPLGREG. DWS
2 Z:\Program FilesiDyalog)Drvalog APL 11, 0%wsyWDESTGM, DS
3 Z:\Program Files\DyalogiDrvalog APL 11, 0%wsiutil,DwW'S
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Table 7: File Menu Operations

Item Action Description

New [WSClear] Prompts for confirmation, then clears the
workspace

Open [WSLoad] irompts for a workspace file name, then loads
Prompts for a workspace file name, then

Copy [WSCopy] copies it

Save [WSSave] Saves the active workspace

Prompts for a workspace file name, then saves

Save As [WSSaveas] it

Creates a bound executable, an OLE Server,

Export [Makeexe] an ActiveX Control, or a .Net Assembly

Export to | [MakeMemory

Memory | Assembly] Creates an in-memory Net Assembly

Prompts for a workspace file name, then erases

Drop [WSDrop] it
Print . . .
Setup [PrintSetup] [Invokes the print set-up dialog box

Saves the active workspace in
CONTINUE.DWS and exits APL

Exit [Off] Exits APL

Continue |[Continue]
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Export

The Export... menu item allows you to create a bound executable, an OLE Server (in-
process or out-of-process), an ActiveX Control or a .Net Assembly.

The dialog box used to create these various different files offers selective options
according to the type of file you are making. The system detects which of these types
is most appropriate from the objects in your workspace. For example, if your work-
space contains an ActiveXControl namespace, it will automatically select the
ActiveX Control option.

Create bound file

Save in; |l'j' W [V] ) ? * [

E_ ﬁcalc.exe

My Recent
Documents

=

Deskiop

=

7

My Documents

s

ky Computer

File name: |CALC.E:-:B [v]

by Netwark Save a3 bipe: | Standalone Executable (includes interpreter EHE[V] [ Cancel l

Buntime application | Comsole application [ nable Mative Look and Feet

Command line:
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The Create bound file dialog box contains the following fields. These will only be
present if applicable to the type of bound file you are making.

Item Description
Allows you to choose the name for your bound file The name
File name | defaults to the name of your workspace with the appropriate
extension.
?;;: as Allows you to choose the type of file you wish to create.
If this is checked, your application file will be bound with the
Runtime Run-Time DLL. If not, it will be bound with the Development
application | DLL. The latter should normally only be used to permit
debugging.
Check this box if you want your executable to run as a console
Console . . . . L
. application. This is appropriate only if the application has no
application . .
graphical user interface.
Enable
Native If checked, Native Look and Feel will be enabled for your
Look and |bound file.
Feel
Allows you to associate an icon with your executable. Type in
Icon file the pathname, or use the Browse button to navigate to an icon
file.
For an out-of-process COM Server, this allows you to specify
Command |the command line for the process. For a bound executable, this
line allows you to specify command-line parameters for the
corresponding Dyalog APL DLL.
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Pressing the Version button brings up the Version Information dialog box shown
below.

This dialog box allows you to specify versioning information that will be stored in
your bound file.

— Yersion Information
Indentifier | Yalue |
Cornrents | four comments here
CompanyM ame Your Company Mame
FileD'ezcription Yaur File Description
File'ersion 1.0,0.0
Productyerzsion 1.0,0.0
ProductM ame
IntermalM amne “four Internal Filename
LegalCopyright Copyright [C] 2005
LeqalTrademark.z Your Leqgal Trademarks
PrivateBuild
SpecialBuild

ok | ’ Cancel




Chapter 2: The APL Environment 105

The Edit Menu

The Edit menu (OSE .mb . edi t) provides a means to recall previously entered input
lines for re-execution and for copying text to and from the clipboard.

Back. Ckrl+Shift+Bksp
Back. Forward Ctrl+Shift+Enter
Forward

Clear Ckrl+Delete
Cuk Copy Chrl+Insert
Copy Paste Shift+Inserk
Paste Paste Unicode
Find. . Paste Mon-Unicode
Replace... Eind...

Unicode Edition

Replace, ..

Table 8: Edit menu operations

Classic Edition

Item Action Description
Displays the previous input line. Repeated
Back [Undo] use of this command cycles back through the
input history.
Displays the next input line. Repeated use of
Forward | [Redo] this command cycles forward through the
input history.
Clear [Delete] Clears the selected text
Copy [Copy] Copies the selection to the clipboard
Pastes the text contents of the clipboard into
the session log at the current location. The
Paste [Paste] new lines are marked and may be executed
by pressing Enter.
Paste Same as Paste, but gets the Unicode text from
. [Pasteunicode] |the clipboard and converts to [JAV. Classic
Unicode .l
Edition only.
Paste Same as Paste, but gets the ANSI text from
Non- [Pasteansi] the clipboard and converts to [JAV. Classic
Unicode Edition only.
Find [Find] Displays the Find dialog box
Replace | [Replace] Displays the Find/Replace dialog box
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The View Menu

The View menu (OSE .mb . view) toggles the visibility of the Session Toolbar, Stat-
usBar, and Language Bar.

v Toolbar
v Statushar
v LanguageBar

Table 9: View menu operations

Item Action Description

Toolbar Shows/Hides Session toolbars

Statusbar Shows/Hides Session statusbars

LanguageBar Shows/Hides Language Bar
The Window Menu

This contains a single action (OSE .mb . windows) which is to close all of the Edit
and Trace windows and the Status window.

Close all windows

LanguageBar

Debugger
Editor »

Table 10: Window menu operations

Item Action Description

Close all Windows |[CloseAll] |Closes all Edit and Trace windows

Note that [CloseAl L] removes all Trace windows but does not reset the State Indi-
cator.

In addition, the Window menu will contain options to switch the focus to any sub-
sidiary windows that are docked in the Session as illustrated above.
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The Session Menu

The Session menu (OSE .mb . session) provides access to the system operations
that allow you to load a session (JSE) from a session file and to save your current ses-
sion (OSE) to a session file. If you use these facilities rarely, you may wish to move
them to (say) the Options menu or even dispense with them entirely.

Qpen, ..
Save
Save As,..

Table 11: Session menu operations

Item | Action Description

Prompts for a session file name, then loads the session
from it, replacing the current one. Sets the File
property of JSE to the name of the file from which
the session was loaded.

Open | [SELoad]

Saves the current session (as defined by (JSE) to the

Save | [SESave] session file specified by the File property of OSE.

Prompts for a session file name, then saves the current
[SESaveas] |session (as defined by [JSE) in it. Resets the File
property of JSE.

Save
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The Log Menu

The Log menu (OSE .mb . Log) provides access to the system operations that manip-
ulate Session log files.

Mew
open, ..,

Save
Save s,

Prink...

Table 12: Log menu operations

Item | Action Description

Prompts for confirmation, then empties the current

New | [NewLog] Session log.

Prompts for a Session log file, then loads it into

Open | [OpenLog] memory, replacing the current Session log

Saves the current Session log in the current log file,

Save L ine i i
ve | [Savelog] replacing its previous contents

Save Prompts for a file name, then saves the current
[SavelogAs] . .
As Session log in it.

Print [ [PrintLog] [Prints the contents of the Session log.

The Action Menu

The Action menu (OSE .mb . act ion) may be used to perform a variety of operations
on the current object or the current line. The current object is the object whose name
contains the cursor. The current line is that line that contains the cursor. The Edit,
Copy Object, Paste Object and Print Object items operate on the current object. For
example, if the name SALES appears in the session and the cursor is placed some-
where within it, SALES is the current object and will be copied to the clipboard by
selecting Copy object or opened up for editing by selecting Edit.
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Execute runs the current line; Trace traces it.

Edit...
Trace...
Execute

Copy Object
Paste Object

Clear Stops
Inkerrupk
Reset

Unicode Edition

Edit... Shift+Enter
Trace... Ckrl+Enker
Execute Enker

Copy Object
Paste Object

Clear Stops
Inkerrupk
Reset

Classic Edition

Table 13: Action menu operations

Item Action Description
Edit [Edit] Edit the current object

Executes the current line under the control of the
Trace [Trace]

Tracer
Execute | [Execute] Executes the current line
Copy . Copies the contents of the current object to the
Object [ObjCopy] clipboard.
Paste [ObjPaste] Pastes the contents of the clipboard into the
Object J current object, replacing its previous value
Print R . .
Object [ObjPrint] |Prints the current object.
Clear [ClearTSM] Clegrs all JSTOP, [JMONITOR and [JTRACE
Stops settings
Interrupt | [Interrupt] | Generates a weak interrupt
Reset [Reset] Performs )RESET
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The Options Menu

The Options menu (OSE .mb.options)provides configuration options.

Chject Synkax k| w Expose GUI Propetties
Expose Rookt Properties

Murm -
Expose Session Propetties

Line Murmbers

Configure. ..
Colours,..

Table 14: Options menu operations

Item Action Description
Expose GUI Exposes the names of properties,
Properties [ExposeGUI] methods and events in GUI objects
Expose Root Exposes the names of the properties,
Properties [ExposeRoot] methods and events of the Root object
;::sz(i)osrel [ExposeSession] Exposes the names of the properties,

. P methods and events of [JSE
Properties

Toggle the display of line numbers in

[LineNumbers] edit and trace windows on/off

Line Numbers

Displays the Configuration dialog

Configure box

[Configure]

Displays the Colours Selection dialog

[ChooseColors] box

Colours

The values associated with the Expose GUI, Expose Root and Expose Session options
reflect the values of these settings in your current workspace and are saved in it.

When you change these values through the Options menu, you are changing them in
the current workspace only.

The default values of these items are defined by the parameters default wx, Prop-
ertyExposeRoot and PropertyExposeSE which may be set using the Object Syntax
tab ofthe Configuration dialog.



Chapter 2: The APL Environment 11

The Tools Menu

The Tools menu (OSE .mb . too L s)provides access to various session tools and
dialog boxes.

Explarer...
Explarer... Seatch...
Search... Chiject List...
Skatus,.. Skakus,..
Aukastatus v BukosStatus
Event YWigwer Ewvent Wigwer

Kevboard Wiewer, ..
Unicode Edition Classic Edition

Table 15: Tools Menu Operations

Item Action Description

Explorer |[Explorer] Displays the Workspace Explorer tool
Search [WSSearch] Displays the Workspace Search tool
Status [Status] Displays or hides the Status window

Toggle; if checked, causes the Status
AutoStatus | [AutoStatus] |[window to be displayed when a new
message is generated for it

Event

Viewer [EventViewer] | Displays or hides the Event Viewer

Displays a property sheet for the current

Properties | [ObjProps] object

Keyboard Displays the APLTeam Keyboard Viewer.
Viewer Classic Edition only.
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The Threads Menu

The Threads menu (OSE .mb . threads) provides access to various session tools
and dialog boxes.

Show Threads. ..
Shiow Skack. .,
Show Taken Poal, .,
Auto Refresh

v Pause on Error
Pause all Threads
Resume all Threads
Restart all Threads

Table 16: Threads Menu Operations

Item Action Description

Show [Threads] Displays the Threads Tool

Threads Py

Show Stack |[Stack] Displays the SI Stack window
h Tok Displ he T P

Show Token [TokenPool ] isp ays the Token Pool

Pool window

Refreshes the Threads Tool on

Auto Refresh | [ThreadsAutoRefresh] every thread switch

Pause on

[ThreadsPauseOnError] | Pauses all threads on error
Error

Pause all

Threads [ThreadsPauseAll] Pauses all threads

Resume all

Threads [ThreadsResumeAl L] Resumes all threads

Restart all

Threads [ThreadsResrartAll] Restarts all threads
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The Help Menu

The Help menu (OSE .mb . he Lp) provides access to the help system which is pack-
aged as a single Microsoft HTML Help compiled help file named
help\dyalog.chm.

Documentation Center
Latest Enhancements

Language Help
GUi Help

Drvalog Web Site
Email Drvalog

Abouk Crvalog APL

Table 17: Help menu operations

Label Action Description
Opens your web browser on
Documentation help\index.html which displays an
[Decanter] . . .
Center index to the on-line PDF documentation
and selected internet links.
Opens help\dyalog.chm, starting at
Latest the first topic in the Version 13.1
[Reunites] Release Notes section. Note that
Enhancements

previous Release Notes are also
included for your convenience.

Language Help

[Lang Help]

Opens help\dyalog.chm, starting at
the first topic in the Language Reference
section.

Opens help\dyalog.chm, starting at

Gui Help [GuiHelp] the first topic in the Object Reference
section.

Dyalog Web [DyalogWeb] Opens your web browser on the Dyalog

Site home page.

Email Dyalog

[DyalogEmail]

Opens your email client and creates a
new message to Dyalog Support, with
information about the Version of
Dyalog APL you are running.

About Dyalog
APL

[About]

Displays an 4bout dialog box
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Session Pop-Up Menu

The Session popup menu (SE . popup) is displayed by clicking the right mouse but-
ton anywhere in the Session window. If the mouse pointer is over a visible object
name, the popup menu allows you to edit, print, delete it or view its properties. Note
that the name of the pop-up menu is specified by the Popup property of [JSE.

Edit Shift-+Enker |

Chart 3 Barchart
Linechart:
Pie
Scatter

Cuk Control+%

Copy Contral+Insert

Paste Shift+Insert

Paste Unicode
Paste Non-Unicode

Line Murnbers M -

Explorer...
Search...
Event Yiewer...
Threads...
Status...
Colours..

Inkerrupt

Table 18: Session popup menu operations

Item Action Description
Edit [Edit] Edits the current object
Print [ObjPrint] Prints the current object
Delete [ObjDelete] Erases the current object
. Displays the Object Properties dialog box
Properties | [GUIHelp] for the current object
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Item Action Description
Displays the help topic associated with the
Help [Helpl current object or the APL symbol under the
cursor
Line . :
Numbers [LineNumbers] [Toggles line numbers on/off
Copy [Copy] Copies the selection to the clipboard
Pastes the text contents of the clipboard into
Paste [Paste] the session log at the current location. The
new lines are marked and may be executed
by pressing Enter.
Paste [Pasteunicode] Same as Paste, but gets the Unicode text
Unicode from the clipboard and converts to JAV
II:IaOs;Ele_ [Pasteansi] Same as Paste, but gets the ANSI text from
. the clipboard and converts to [JAV
Unicode
Explorer |[Explorer] Displays the Workspace Explorer
Search [WSSearch] Displays the Find Objects tool
Event . . .
Viewer [EventViewer] |Displays the Event Viewer
Threads |[Threads] Displays the Threads Tool
Status [Status] Displays the Status window
Colours |[[ChooseColors] |Displays the Colour Selection dialog
Interrupt | [Interrupt] Generates a weak interrupt
Open Opens the URL or link using the appropriate
i rI1) K [OpenLink] program. See "Underline URLs and links" on
page 125
Copy Copies the URL or link to the Windows
link to [Copy_Link] Clipboard. See "Underline URLs and links"
clipboard on page 125
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The Session Toolbars

The Session toolbars are contained by four separate CoolBand objects, allowing you
to configure their order in whichever way you choose.

ws M EDE S
ot B s VE L E @
ool @3 G [ M
: Edit B v
- Session B | APL3ES Unicode v 16 i

The Session tool bars

The bitmaps for the buttons displayed on the session tool bar are implemented by
three ImageList objects owned by the CoolBar[JSE . cbtop. These represent the

ToolButton images in their normal, highlighted and inactive states and are named
iln,ilhand ili respectively.

These images derive from three bitmap resources contained in dyalog.exe named
tb_normal, tb_hot and tb_inactive. The statements that create these ImageL-
ist object in function BUILD_SESSION in BUILDSE.DWS are as follows.

:With '0OSE.cbtop’
"iln'0OWC'ImageList'('MapCols' 0)('Masked' 1)
"iln.bm'0OWC'Bitmap'('"' "tb_normal')('MaskCol' (192 192
192))
"ilh'0OWC'ImageList'('MapCols' 0)('Masked' 1)
"iylh.bm'OWC'Bitmap'('" "tb_hot')('MaskCol' (192 192
192))
"ili'0OWC'ImagelList'('MapCols' 0)('Masked' 1)
"ili.bm'OWC'Bitmap'("'"' 'tb_inactive')('MaskCol' (192
192 192))
:EndWith



Chapter 2: The APL Environment 117

[
Clear Workspace

'}

=
Load Workspace

Y
Copy Workspace

Save Workspace

el

Re-Export
Workspace

=

Print Workspace

Workspace (WS) Operations

Executes the system operation [WSClear] which asks
for confirmation, then clears the workspace.

Executes the system operation [WSLoad] which
displays a file selection dialog box and loads the
selected workspace.

Executes the system operation [WSCopy ] which
displays a file selection dialog box and copies the
(entire) selected workspace

Executes the system operation [WSSaveas] which
displays a file selection dialog box and saves the
workspace in the selected file.

Executes the system operation [REExport ] which re-
exports the workspace using the settings, parameters
and options that were previously selected using the
Create Bound File dialog.

Executes the system operation [PrintFnsInNS] that
prints all the functions and operators in the current
namespace.
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Object Operations

i Executes the system operation [Ob jCopy ] which

Copy Object copies the contents of the current object to the
clipboard.

- Executes the system operation [Ob jPaste] which

Paste Object copies the contents of the clipboard into the current
object, replacing its previous value.

=) Executes the system operation [ObjPrint] that

Print Object prints the current object.

N Executes the system operation [Edit] which edits the

Edit Object current object using the standard system editor.

Executes a defined function in OSE that edits the

Edit Numbers current object (which must be numeric) using a
spreadsheet like interface based upon the Grid object.

lub Executes a defined function in [JSE that displays the

Barchart value of the current object in a Barchart.

e Executes a defined function in JSE that that displays

Linechart the value of the current object in a Linechart.

2] Executes a defined function in JSE that that displays

Piechart the value of the current object in a Piechart.

I Executes a defined function in JSE that that displays

Scatterplot the value of the current object in a Scatterplot.
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Tools

By

Explorer

Q

Search

&

Line Numbers

H

Clear all Stops

Edit Operations

Copy Selection

!

Paste Selection

K
Recall Last

4 Recall Next

Executes the system operation [Explorer] which
displays the Workspace Explorer tool.

Executes the system operation [WSSearch] which
displays the Workspace Search tool.

Executes the system operation [LineNumbers]
which toggles the display of line numbers in edit and
trace windows on and off.

Executes the system operation [ClearTSM] which
clears all 0STOP, [IMONITOR and OTRACE settings

Executes the system operation [Copy ] which copies
the selected text to the clipboard.

Executes the system operation [Paste] which pastes
the text in the clipboard into the current window at the
insertion point.

Executes the system operation [UndoJwhich recalls
the previous input line from the input history stack

Executes the system operation [Redo] which recalls
the next input line from the input history stack.
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Session Operations
= Executes the system operation [ SELoad] which
Load Session displays a file selection dialog box and loads the

selected Session File.

APLAER Unicode + | Selects the font to be used in the Session window.

Select Font

| 16 = Selects the size of the font to be used in the Session

. window.
Select Font Size
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The Session Status Bar

The session status bar is represented by two CoolBands each of which contains a Stat-
usBar object. There are a number of StatusFields as illustrated below. Your own
status bar may be configured differently.

© Ready...

Ins  Uni MUM

CurObj: Describe (Uariabled

gl OpQ:0  OTRAP  OSI:0  OI0:1  OHL:O

Classic Edition
Ready... Ins  HUM
Curlbj: Describe (Yariable) &1 aog: OTRAP | OSI: OIo: amML =

Unicode Edition

The StatusField objects owned by the session StatusBar may have special values of
Style, which are used for operations relevant only to the Session. These styles are sum-
marised in the tables shown below.

Table 19: Session status fields : first row

StatusField | Style Description
. Displays hints for the session objects, or "Ready..."
hint None when APL is waiting for input
insrep InsRep Displays the mode of the Insert key (Ins or Rep)
Displays the keyboard mode. This is applicable only
to a multi-mode keyboard. The text displayed is
mode KeyMode defined by the Mn= string in the Input Table.
Classic Edition Only.
Indicates the state of the Num Lock key. Displays
nam NumLock | tM" if Num Lock is on, blank if off
Indicates the state of the Caps Lock key. Displays
caps CapsLock "Caps" if Caps Lock is on, blank if off.
Ause Pause Displays a flashing red "Pause" message when the
P Pause key is used to halt session output
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Table 20: Session status fields : second row

StatusField | Style Description

curobj CurObj Displays the name of the current object (the name
last under the input cursor)

t ThreadCount D1§p}ays thp number of threads currently running
(minimum is 1)

dqlen DQLen Displays the number of events in the APL event
queue

trap Trap Turns red if JTRAP is set

si SI Displays the length of SI. Turns red if non-zero

o 0 Displays the value of JIO. Turns red if IO is
not equal to the value of the default_io parameter
Displays the value of ML. Turns red if (ML is

ml ML not equal to the value of the default_ml
parameter

Toggle Status Fields

In the default Session files distributed with this release, the Statusfields used to dis-
play the value of JI0, the state of the Insert key (Ins/Rep) and the current keyboard
mode (e.g. Apl/Uni) have callback functions attached to MouseDblClick. This means
that you can toggle the state of these fields by double-clicking with the left mouse

button.

If you dislike this behaviour, you may set the Event property of the Statusfields to 0
and re-save the Session file. Alternatively, you may modify BUILDSE.DWS and

rebuild the Session from scratch.
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The Configuration Dialog Box

General Tab

B Dyalog APL/W Configuration

Trace Edit ] Auto Complete ] SALT ] Uszer Commands ] Object Syntax ] Met Framework, ]
General ] Unicode Input ] Keyboard Shortcuts ] “Workspace ] Help / Dhd ] Windows ] Session ] Log ]

Recently used file lizt size: ]

W Display ¥ alue Tips after. |500 [ms]

Colour Scherne: Default -

v Enable Mative Look and Feet v Underline URLs and links

[ Apply Mative Look and Feel to docked captions

Configuration zaved in:
HKEY_CURRENT_USERMNSOFTWAREYDyaloghDyalog APLAW 131 Unicode

QK | Cancel
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Table 21: Configuration dialog: General

Label Parameter Description
. Determines whether or not line
Show line . . . .
lines on functions numbers are shown in edit/trace
numbers — = .
windows
Specifies the number of the most
Recently used .
e file stack size recently used workspaces
file list size - - . . .
displayed in the File menu.
Specifies the delay before APL
. will display the value of a
]]?ilsys)laa%le?lalue ValueTips/Delay variable or the code for a
p function when the user hovers
the mouse over its name.
Specifies the colour scheme used
. to display the value of a variable
Colour Scheme ValueTips/ or the code for a function when
ColourScheme
the user hovers the mouse over
its name.
Enable Native
Look and Feel XPLookAndFeel See below.
. Specifies whether or not Native
fgsliyag(?tl?éf:l Look and Feel is honoured when
XPLookAndFeelDocker | drawing the title bars of docked
to docked . . .
. windows, including docked
captions . .
Session windows.
Underline Specifies whether or not URLs
. URLHighlight and links are highlighted in
URLs and links . N
Session and Edit windows.
Configuration inifile Specifies the full pathname of the
saved in registry folder used by APL
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Native Look and Feel

If you check the Apply Native Look and Feel option box and close the Options
dialog by pressing OK, APL creates a MANIFEST file. This is a file with the same
name as the Dyalog executable program (normally, dyalog.exe) with the addition
ofa .manifest suffix (normally, dyalog.exe.manifest). If you clear the
option box and click OK, the manifest file is deleted.

The presence or absence of this file determines whether or not Native Look and Feel
is used for Session windows.

Underline URLs and links

Ifthis option is selected, valid URLSs are identified when the cursor is in the Session
or in an Edit or Trace window. When the mouse pointer is over a URL, the URL is
underscored and the appropriate items in the Session Popup menu are activated.
These allow you to open the link or copy it to the clipboard.

You may also open a URL using Ctrl+Click (Left Mouse button).

Currently a URL string is defined to be a string starting with any of the following
strings:

http://
https://
WWW.
mailto:
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Unicode Input Tab (Unicode Edition Only)
Unicode Edition can optionally select your APL keyboard each time you start APL.

To choose this option, select one of your installed APL keyboards, enable the
Activate selected keyboard checkbox, then click OK

5B Dyalog APL/W Configuration @
Trace/Edit ] Auto Complete SALT ] Uszer Commands ] Object Syntax ]
General Unicode Input l Keyboard Shortcuts ] Wiorkspace Windows ] Session ] Log ]

Dwalog can automatically load your zelected keyboard when the session window is made wvisible:

W fchivate selected keyboard I Show keyboards for alllanguages
Eevboard:
|Dyalog APL IME [en-GE) |

LConfigure Layout...

Ok | Cancel
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Label Parameter Description
selected InitialKeyboardLayoutInUse P
keyboard on start-up.
keyboard M .
0 = no action
Show 1 = show list of all

keyboards for
all Languages

InitialKeyboardLayoutShowAll

installed keyboards
0 = show only the
Dyalog keyboards

Keyboard

InitialKeyboardLayout

the name of the APL

keyboard to be selected.
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=,

Dyalog APL Input Method Editor Properties

l &bt ]

Input Tranzlate Table:

|E:'xF'rcugram FilezhDyalog'UnicodelME \aplkeyshen-GE. din Browsze. ..

[v Enable Dwverstrikes
[ Owerstrikes do not require the '05" introducer key [expermental]

[v Usze Overstike popup

k. | Cancel

Table 22: Configuration dialog: Unicode Input/Configure Layout

Label Parameter Description
Enable . 1 = enable overstrikes.
Overstrikes ResolveOverstrikes 0 = disable overstrikes

1 = IME identifies overstrike
operation automatically

0 = IME requires the <OS> key to
signal an overstrike operation

Overstrikes do
not require the
<OS> key

Use Overstrike OverstrikesPopu 1 = enable the overstrike popup.
popup PUP 10 = disable the overstrike popup
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Input Tab (Classic Edition Only)

5B Dyalog APL/W Configuration

Auta Complete
General Input

Input table search path:

| SaLT

Output ] ‘wWorkspace ] Wwindoves Session ] Log ] Trace/Edit ]

Drouble click a directory to ligt its Input T able Hles

l

Uszer Commands ] Ohject Spntax ]

Input table file:

Contents of the highlighted directon

uk.din

|

C:AProgram Files\DyaloghDyalog APL 12,1 Claszichaplkeys

Qg | Cancel

Table 23: Configuration dialog: Keyboard

Label Parameter Description

Input table anlkevs A list of directories to be searched for
search path pIKey the specified input table

Input table file |aplk The name of the input table file (DIN)
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Output Tab (Classic Edition Only)

5B Dyalog APL/W Configuration
Auta Complete ] SALT ] Uszer Commands ] Ohject Spntax ]
General ] Irput Dutput l ‘wWorkspace ] Wwindoves Session ] Log ] Trace/Edit ]

Output table search path:
Drouble click a directory bo ligt itz Qutput T able files

IC:“Program FilestDyalogiDyalog APL 12.1 Classichaplrans

Olutput kable file:
Contents of the highlighted directon

win. it j

Qg | Cancel

Table 24: Configuration dialog: Output

Label Parameter Description

Output table apltrans A list of directories to be searched for
search path P the specified output table

Output table

file aplt The name of the output table file (DOT)
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Keyboard Shortcuts Tab

,ED Dyalog APL/W Configuration @
Trace E dit ] Auto Complete ] SALT ] User Commands ] Object Syntax ]
General ] Unicode [nput Keyboard Shortouts l Workspace “Windows ] Session ] Log
Available shartcuts: Shorteut for:
Code | Description | Shorteut | | TL:toggle localisation
as Begin overstike g2q...  [None)
52 Exit zeript and onlp fi..  [None] Contral+Llp
51 Ewit gcript and fig en... [None)
1] Goto matching outine  [None) Coanflicts with:
TO Toggle outline [Mone)
GL Go toLine [Mone)
Do Del comments [Mone)
A0 Add comments [Mone)
U2 unda all changes [Mone] [~ Confirm befare avenarite
TL toggle localization Control+p
Fikd Resume execution (i...  [None)
BP toggle breakpoint [Mone)
BH Rurn o exit fintracer]  [None)
LM Toggle Line numbers Mum -
[ Fix the current functi...  [None)
TC Trace Control+E nter
ED Edit Shift+Enter
P Previous [Mone]
e gz;tlace mg:g% w| 7 Use Ctil- X.CV for clipboard
QK | Cancel |

To alter the keystroke associated with a particular action, simply select the action
required and press the keystroke. For example, to change the keystroke associated
with the action <UA> (undo all changes) from (None) to Ctrl+Shift+u, simply select
the corresponding row in the list and press Ctrl+Shift+u. If Confirm before Overwrite
is checked, you will be prompted to confirm or cancel before each and every change

is written back to the registry.
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Workspace Tab
5B Dyalog APL/W Configuration
Trace/Edit ] Auto Complete SALT ] User Commands ] Object Syntax ]
General ] Urnicode Input ] F.eyboard Shortouts Wiorkspace ] Windows ] Session ] Log ]

‘Wiorkspace search path:

Browze

C:ADocuments and Settings\Pete\My DocumentzhDpalog AFL 13.0 Unicode Files

C:%Program Files\DyalogDyalog APL 12.0 Unicode'ws

C:%Program Files\DyalogDyalog 4PL 13.0 Unicode'\S ampleshdine
C:%Program Files\Dyalog . Dyalog 4PL 13.0 Unicode'\S ampleshactives
C:%Program Files\Dypalog Dyalog 4PL 13.0 Unicode'\Sampleshole
C:%Program Files\Dpalog . Oyalog 4PL 13.0 Unicode\Sampleshtcpip
C:%Program Files\Dypalog . Oyalog 4PL 13.0 Unicode\Samplesh0044PL
C:%Program Files\Dpalog Oyalog 4PL 13.0 Unicode\Sampleshuwinforms
C:%Program Files\DyalogDyalag 4PL 13.0 Unicode'w«fiib

C:%Program Files\Dypalog'Dyalag 4PL 13.0 Unicode'tools/aplkeam

L

b ainauirn work space gize (RB): (64000

Ok | Cancel

Table 25: Configuration dialog: Workspace

Label Parameter Description

A list of directories to be searched for
wspath the specified workspace when the user
executes ) LOAD wsname

Workspace
search path

Maximum . . .
The maximum size of the workspace in
workspace maxws

size(kB) KB. Default is 16384.
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Help/DMX Tab
5B Dyalog APL/W Configuration
Trace/E dit ] Auto Complete ] SALT ] User Commands ] Object Syntax ] _Met Framework. ]

General ] Unicode Input ] Feyboard Shortouts ] “workspace Help / Db ] WWindows ] Session ] Log ]

Db meszages should go to:

va

I Status Window

[ ze Microsaft's documentation center for non-Dyalog topics

URL: |ms-help: #/me.mscc. w80

Ok | Cancel

Table 26: Configuration dialog: Help/DMX

Label Parameter Description

If checked, these boxes cause
DMX messages DMXOUTPUTONERROR APL to d1§play dJoMx .
should go to messages in the corresponding
window(s).

If this option is checked, APL
will look for help at
UseDefaultHelpCollection | Microsoft's documentaion
center for the the current
string under the cursor.

Use Microsoft's
documentation
centre for non-
Dyalog topics

The url for the documentation

URL DefaultHelpCollection
center.
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Windows Tab

5B Dyalog APL/W Configuration

Trace/Edit I Auto Complete SALT | User Commands I Object Syntax
General | Urnicode Input I F.eyboard Shortouts I ‘Workspace Windows | Session | Log
— Edit Window
“width ng Height |3|j
# Pos ID ' Pos ID
= Offzet |3 r Offzet |3

— Trace Window:

* Pos ID— ' Pos ID—
|3 |3

# Offset ' Offset

— QuadSk Windo

width I;-'g— Height |25—

Ok I Cancel
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Table 27: Configuration dialog: Windows (Edit Windows)

Label

Parameter

Description

Width

edit _cols

The maximum number of rows displayed
in a new edit window

Height

edit_rows

The maximum number of columns
displayed in a new edit window

X Pos

edit first x

The initial horizontal position in
characters of the first edit window
relative to the Session window

Y Pos

edit first y

The initial vertical position in characters
of the first edit window relative to the
Session window

X Offset

edit offset x

The initial horizontal position in
characters of the second and subsequent
edit windows relative to the previous
one

Y Offset

edit offset y

The initial vertical position in characters
of the second and subsequent edit
windows relative to the previous one

Table 28: Configuration dialog: Windows (Trace Windows)

Label

Parameter

Description

X Pos

trace first x

The initial horizontal position in
characters of the first trace window
relative to the Session window

Y Pos

trace_first y

The initial vertical position in characters
of the first trace window relative to the
Session window

X Offset

trace offset x

The initial horizontal position in
characters of the second and subsequent
trace windows relative to the previous
one

Y Offset

trace_offset y

The initial vertical position in characters
of the second and subsequent trace
windows relative to the previous one
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Table 29: Configuration dialog: Windows (QuadSM Window)

Label Parameter Description
Width sm cols The width of the [JSM and prefect
- windows

The height of the [JSM and prefect

Height sm_rows .
- windows
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Session Tab

5B Dyalog APL/W Configuration

Trace/Edit I Auto Complete SALT | User Commands | Object Syntax
General | Urnicode Input I F.eyboard Shortouts I ‘Workspace Windows Session Log

— Default settings

O1o: [
OML : o
OBF: o
ORTL: |n—
ORL: [tea07

E45
-
Sesgion file:
C:ADocurents and SettingstPate\My DocurentsiDyalag APL 13.0 Unicods Files\def_uk.dse Browse... |

Ok I Cancel |
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Table 30: Configuration dialog: Session

Label Parameter Description
gIo default_io ;l;l;e default value of JIO in a c lear
OML default ml ;l;l;e default value of ML in a clear
Opp default_pp ;l;l;e default value of PP in a clear
ORTL default_rtl ;l;l;e default value of JRTL in a clear
OrRL default_rl ;l;l;e default value of JRL ina clear
do1v default_div ;l;l;e default value of DIV ina clear
Owx default wx ;l;l;e default value of JWX ina clear

If checked, the value of JPW is dynamic
Auto PW auto_pw and depends on the width of the Session

Window.

Session file

session_file

The name of the Session file in which
the definition of your session (OSE) is
stored.
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Log Tab

5B Dyalog APL/W Configuration

Trace/Edit ] Auto Complete SALT ] User Commands ] Object Syntax ]
General ] Urnicode Input ] F.eyboard Shortouts ] ‘Workspace Windows ] Session Log

|C:\Document$ and Settingz\PeteMy Documentzt\Dpalog APL 13.0 Unic Browse...

v Canfirm on Deletion from Session Log

Segzion log gize[Kb]: a00

Input buffer size[kb): ,-'-107
Histaory buffer zize(kb]: ’47
PFKepbuffersizekby  [10

Ok | Cancel
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Table 31: Configuration dialog: Log

Label

Parameter

Description

Use Session log
file

log_file inuse

Specifies whether or not the Session log
is saved in a session log file

Use Session log
file

log file

The full pathname of the Session log file

Confirm on
Deletion from
Session log

confirm
session_delete

Specifies whether or not you are
prompted to confirm the deletion of a
line from the Session (and Session log).

Session log

size(Kb) log_size The size of the Session log buffer in Kb
The size of the buffer used to store
Input buffer . . . . iy .
. input_size marked lines (lines awaiting execution)
size(Kb) . .
in the Session
History The size of the buffer used to store
size(Kb) history_size previously entered (input) lines in the

Session

PFKey buffer
size(Kb)

ptkey size

The size of the buffer used to store
PFKey definitions (OPFKEY)
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Trace/Edit Tab

5B Dyalog APL/W Configuration

General ] Unicode lhput ] Keyboard Shortcuts ] workspace ] Help & D ] Windows ] Session ] Log ]
Trace/E dit l Auto Complete ] SALT ] Usger Commands ] Object Syntax ] Met Framework, ]

Canfirm edit window close on:

- [ Cloze

[ Al foating edit windows B Bl 5

[ Show status bars M 2

[ Show boal bars v AutoFaormat functions
[ Show bace stack on emar W Autolndent

Iv Double click to gdit

Warh if trace stack bigger thar: 15 Tab stops every |4 characters.

Exit and fix i a suspended class or namespace should fi: | Orly Functions hd
But if not suspended fix: Ewverything i

Ok | Cancel
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Table 32: Configuration dialog: Trace/Edit

Label Parameter Description
Classic Dyalog . Selects pre-Version 9 behaviour
mode ClassicMode for Edit and Trace windows
Allow floatin Allows individual Edit windows
edit win dowsg DockableEditWindows | to be undocked from (and re-
docked in) the main Edit window
Single trace . Specifies whether or not there is a
. SingleTrace . .
window single Trace window
Specifies whether or not status
Show status . bars are displayed along the
bars StatusOnEdit bottom of individual Edit
windows
Specifies whether or not tool bars
Show tool bars [ ToolBarsOnEdit are displayed along the top of

individual Edit windows

Show trace
stack on error

Trace on_error

Specifies whether or not the
Tracer is automatically invoked
when an error or stop occurs in a
defined function

Wamn if trace
stack bigger
than

Trace level wam

Specifies the maximum stack size
for automatic deployment of the
Tracer.

Confirm on edit
window close

confirm_close

Specifies whether or not a
confirmation dialog is displayed if
the user alters the contents of an
edit window, then closes it
without saving

Confirm on edit
window fix

confirm_fix

Specifies whether or not a
confirmation dialog is displayed if
the user alters the contents of an
edit window, then saves it using
Fix or Exit
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Label

Parameter

Description

Confirm on edit
window abort

confirm_abort

Specifies whether or not a
confirmation dialog is displayed if
the user alters the contents of an
edit window, then aborts using

Selects automatic indentation for

Autoformat AutoFormat Control Structures when function
functions ) ..
is opened for editing
Autoindent Selects semi-automatic
. Autolndent indentation for Control Structures
functions . ..
while editing
. Specifies whether or not double-
Double-click t . . L .
E((i);tlb RO DoubleClickEdit clicking over a name invokes the
editor
Specifies whether or not text
Paste text as . . transferred to and from the
Unicode UnicodeToClipboard Windows clipboard is to be
treated as Unicode
Tab stops every | TabStops The number of spaces inserted by

pressing Tab in an edit window

Exit and fix ...

See Fixing Scripts below

If not ...

See Fixing Scripts below
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Fixing Scripts

When using the Editor to edit a script such as a Class or Namespace you can specify
whether, when you Fix the script and Exit the Editor, just the functions in the script
are re-fixed, or whether the whole script is re-executed, thereby re-initialising any
Fields or variables defined within.

These two actions always appear in the Editor File menu, but you can specify which
is associated with the <EP> (Esc) key by selecting the appropriate option in the
drop-downs labelled:

e Exit and save changes (EP) in a suspended class or namespace should fix:
e [f not suspended fix:

In both cases, you may select either Only Functions or Everything.

The label for the corresponding items on the Editor File menu (see "The File Menu
(editing a script)" on page 215) will change according to which behaviour applies.
Note that if you specify a keystroke for <S1> in the Keyboard Shortcuts tab, this will
be associated with the unselected action.
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Auto Complete Tab

5B Dyalog APL/W Configuration

B

&3

Make suggestions after

Suggest up to

Show up to
v FK.eep histany

History Length

W Inchude filenames

General ] Unicode lhput ] Keyboard Shorteuts ] workspace ] Help & D ] Windows ] Session ] Log
Trace Edit Auto Complete ] SALT ] Usger Commands ] Object Syntax ] Met Framework,

i} characters. Delay completion for 500 milizeconds.

an items at a time.

32 columns at a time.

0K Key: | Right

Cancel Key: |ESC

’W entries.
ar: |[N one|
or: |[N one]

Common Key: | Control+Right

l
l

Ok | Cancel

Note: To enter values in the OK Key and Cancel Keyfields, click on the field with the
mouse and then press the desired keystroke.

Table 33: Configuration dialog: Auto Complete

Label Parameter Description
Use Auto Enabled Specifies whether or not Auto
Complete Completion is enabled.
Specifies the number of characters
Make
. . you must enter before Auto
suggestions PrefixSize . .
after Completion begins to make
suggestions
Dela Specifies the delay in milliseconds
Yo KeyboardInputDelay | before Auto Completion begins to
completion for .
make suggestions
Specifies the maximum number of
Suggest up to [ Rows rows (height) in the AutoComplete
pop-up suggestions box.
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Label

Parameter

Description

Show up to

Cols

Specifies the maximum number of
columns (width) in the
AutoComplete pop-up suggestion
box

Keep History

History

Specifies whether or not
AutoComplete maintains a list of
previous AutoCompletions.

History Length

HistorySize

Specifies the number of previous
AutoCompletions that are
maintained

Include
filenames

ShowFiles

Specifies whether or not
AutoCompletion suggests directory
and file names for ) LOAD, )COPY
and ) DROP system commands.

OK Key

CompleteKeyl
CompleteKey?2

Specifies two possible keys that may
be used to select the current option
from the Auto Complete suggestion
box.

Cancel Key

CancelKey1
CancelKey?2

Specifies two possible keys that may
be used to cancel (hide) the Auto
Complete suggestion box.

Common Key

CommonKeyl

Specifies the key that will auto-
complete the common prefix. This is
defined to be the longest string of
leading characters in the currently
selected name that is shared by at
least one other name in the Auto
Complete suggestion box.
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SALT

SALT is the Simple APL Library Toolkit, a simple source code management system
for Classes and script-based Namespaces. SPICE uses SALT to manage development
tools which “plug in” to the Dyalog session

B Dyalog APL/W Configuration
General | Unicode Input I F.eyboard Shortouts | “Work space | Windows I Seszion | Log
Trace/Edit I Auta Complete SALT | Iser Commands I Object Sprtax

Compare command line: IEID|

Editar command line: I

Source falders: I Browse

L

C:\Program Files\DpalogiDyalog APL 13.0 Unicode\SALT Add

Bemove

tove Up

i

fowve Dowrn

QK I Cancel
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Table 34: Configuration dialog: SALT

folders

Label Parameter Description
Enable AddSALT Specifies whether or not SALT is
Salt enabled
Compare The command line for a 3™ party file
command CompareCMD | comparison tool to be used to compare
line two versions of a file. See note.

. . Name of the program to be used to edit
Editor Editor script files (default "Notepad").
Class . . .
source SourceFolder Sets the SALT working directory; a list

of folders to be searched for source code.
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User Commands Tab

5B Dyalog APL/W Configuration
General ] Unicode Input ] K.eyboard Shortcuts Work space ] Windows ] Sessioh ] Log ]
Trace/Edit ] Auto Complete SALT User Commands l Object Syntax ]
Source folders: || Browse

C:AProgram Files\Dpalog\Dyalog APL 13.0 Unicode'SALT \Spice

L

Ok | Cancel |

This page is used to specify and organise a list of folders that contain User-Command
files. When you issue a User Command, these folders will be searched for the source
of the command in the order in which they appear in this list.

Table 35: Configuration dialog: User Commands

Label Parameter Description

Use this field to add folders to the
Source Folders | SALT\CommandFolder | list of folders that will be searched
for User Commands.
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Object Syntax Tab

5B Dyalog APLAY Configuration

General Unicode |nput K.eyboard Shorteuts Work space Windos
Trace /Edi Auto Complete SALT Uszer Commands

[¥]iE #pose properties of GLI Hamespaces

[ Expose properties of Boot

] Expose properties of Session Mamespace

Sessioh Log

Object Syntas

0K

] [ Cancel
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Table 36: Configuration dialog: Object Syntax
Label

Parameter Description

Specifies the value of WX in a clear
workspace. This in turn determines
whether or not the names of
properties, methods and events of
GUI objects are exposed. If set (OWX
is 1), you may query/set properties
and invoke methods directly as if
they were variables and functions
respectively. As a consequence, these
names may not be used for global
variables in GUI objects.

Expose
properties of
GUI
Namespaces

default wx

Specifies whether or not the names
of properties, methods and events of
the Root object are exposed. If set,
you may query/set the properties of
Root and invoke the Root methods
directly as if they were variables and
functions respectively. As a
consequence, these names may not
be used for global variables in your
workspace.

Expose
properties of
Root

PropertyExposeRoot

Specifies whether or not the names
of properties, methods and events of
the Session object are exposed. If set,

Expose
properties of
Session
Namespace

PropertyExposeSE

you may query/set the properties of
OSE and invoke OSE methods
directly as if they were variables and
functions respectively. As a

consequence, these names may not
be used for global variables in the
[SE namespace.

The Object Syntax tab of the Configuration dialog is used to set your default pref-
erences for Object Syntax.

The Object Syntax settings for the current workspace are reflected by the Object
Syntax submenu of the Options menu. Use Options/Object Syntax to change them.
These settings are saved in the workspace.
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.Net FrameworkTab

5B Dyalog APL/W Configuration
General ] Unicode Input ] K.eyboard Shortcuts ] Work space ] Windows Session ] Log ]
Trace Edit ] Auto Complete ] SALT ] Usger Commands ] Object Syntax Met Framework

W Specify MetVersion

|vz.0.50727 |

config file contents:

<configuration:
< gtartup uselegacy2RuntimedctivationPolicy="tue"">
<supportedBuntime version=""v2 0.50727"/»
<fstartup>
<muntimes
<MetF=d_LegacyS ecuntyPolicy enabled="tue"/>
<fruntimes
</configuration:

Ok | Cancel |

This dialog box allows you to specify which version of the .Net Framework you
want to use with Dyalog APL. It is only necessary to do this if you have more than
one version of the .Net Framework installed.

If Specify .Net Version is selected, APL will display the versions of the .Net Frame-
work that are installed in the combo box below.

Choose the version you require and click OK.

Unlike the other configuration dialogs, which typically set values in the Registry,
this dialog creates a configuration file dyalog.exe.config in the same directory
as the Dyalog APL program. Note the following:

e Version 13.1 does not read the contents of an existing
dyalog.exe.config file.

e For .Net Version 2, no configuration file is required; if you select Version 2
having previously selected Version 4, the file will be deleted.

e You will need suitable permissions to write the configuration file, or delete
it — you may wish to start APL by right clicking on the Dyalog shortcut
and selecting Run as administrator.

The dialog box shows the contents of this file as illustrated above.
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Colour Selection Dialog

Dyalog APL/W Colours

Schemes

Sprtax | Yariables | Session/Trace | Status

[nl Colours nc:local:io:0I0:dfrn:f A dummy function Faregraund

[11 a1o«1 ft local sys war

[zl OTRAP«D 'C" 'sErrars’ f global sus var I~

[3l local+«'char const' f lacal + char const

[4] globalel.2 2 345 @ global + num const | Cookoeund

[51] :For o :In JOML ne A kegword + sus fn 1+

[a] O=E.FRINT OCR o A global name

[7] EndFaor A keuword Element

[&] =

[31 Errors: A label Global Mame =
[101] [CA=02/Ale="missing A errors :
[113 Single Background
[12] dfnedl:irslte+{or wilow wi+ws A D-function I Sl s

[13] f.Caption<'Dyalog APL® A Local Property :

[141 Caption+'Dualog APL' f Global Property [¥] Function E ditor

[15] idiome, A oidiom

Function Tracer
Session Input

Orly curent input line

[ ok | [ canesl | [ pew |

Colowr for Backgraund 205 255: 255

The Colour Selection dialog box allows you to select colours for:

e Syntax colouring
e Edit, Trace and Session windows
e Status window

The colour selection dialog box is selected by the [ChooseColor ] system action
which by default is attached to the Options/Colours menu item on the Session menu-
bar and to the Colours menu item in the Session pop-up menu.
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Syntax Colouring

Syntax colouring allows you to visually identify various components in the function
edit and session windows by assigning different colours to them, such as:

Global references (functions and variables)
Local references (functions and variables)
Primitive functions

System functions

Localised System Variables

Comments

Character constants

Numeric constants

Labels

Control Structures

Unmatched parentheses, quotes, and braces

Schemes

Y ou may define a number of different syntax colouring schemes which are suitable
for different purposes and a selection of schemes is provided. Choose the scheme you
wish to use from the Combo box provided. If you change a colour allocation, you
may overwrite an existing Colour Scheme or define a new one by clicking Save A4s
and then entering the name of the Scheme. Y ou may delete a Colour Scheme using
the Delete button.

Changing Colours

To allocate a colour to a syntax element, you must first select the syntax element.
You may select a syntax element from the Combo box provided, or by clicking on an
example in the sample function provided. Having selected a syntax element, choose
a colour using the Foreground or Background selectors as appropriate.

Show Idioms

The Show Idioms checkbox allows you to choose whether or not idioms are to be
identified by syntax colouring.

Single Background

The Single Background checkbox allows you to choose whether to impose a single
background colour, or to allow the use of different background colours for different
syntax elements.
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Function Editor

Check this box if you want to enable syntax colouring in Edit windows.

Function Tracer

Check this box if you want to enable syntax colouring in Trace windows.

Session Input

Check this box if you want to enable syntax colouring in the Session window. Note
that the colour scheme used for the Session may differ from the colour scheme
selected for Edit windows and is specified by the Session Colour Scheme box on the
Session/Trace tab.

Only current input line

This option only applies if Session syntax colouring is enabled. Check this box if
you want syntax colouring to apply only to the current input line. Clear this box, if
you want to apply syntax colouring to all the input lines in the current Session win-
dow. Note that syntax colouring of input lines is not remembered in the Session log,
so input lines from previous sessions do not have syntax colouring.

HotKeys
You may associate different hot key with any or all of your colour schemes.

When you depress a hot key over a function in an Edit window, the function is dis-
played using the scheme associated with the hot key. Releasing the hot key causes it
to be displayed in the normal scheme.

This feature is intended to allow you to quickly check for certain syntax elements.
For example, you may define a special scheme that only highlights global names and
associate a hot key with it. Pressing the hot key will temporarily highlight the glob-
als for you.

To associate a hot key with a colour scheme, click on the Hotkey field, and then
make the desired keystroke. To disassociate a hot key, use <backspace>.
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Print Configuration Dialog Box

The Print Configuration dialog box is displayed by the system operation
[PrintSetup] that is associated with the File/Print Setup menu item. It is also

available from Edit windows and from the Workspace Explorer and Find Objects
tools.

There are four separate tabs namely Setup, Margins, Header/Footer and Printer.

Note that the printing parameters are stored in the Registry in the Printing sub-folder

Setup Tab

-,

B Dyalog APLAY Print Configuration

Setup | Marging | Header/Footer | Printer

Color scheme | Default l Lead wrapped lines with:
(%) Thiz bext:
Line numbers on functions ("3 Thiz many spaces;

[] Line numbers an wariables

APL335 Unicode . 12

(] ] [ Cancel
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Table 37: Print Configuration dialog: Setup

Label Parameter Description
Check this box if you want to print
Color scheme InColour functions \ylth syr'ltax coloupng. Note
that that printing in colour is slower
than printing without colour.
Color scheme SchemeName Se'lec't the colour scheme to be used for
printing.
Check this option button if you wish to
This text WrapWithText prefix wrapped lines (lines that exceed
P the width of the paper) with a particular
text string
This text WrapLeadText Spec1ﬁes the text for prefixing wrapped
lines
This many WrapWithSpaces Check this optlop butt(?n if you wish to
spaces prefix wrapped lines with spaces.
This man Specifies the number of spaces to be
Y WrapLeadSpaces | inserted at the beginning of wrapped
spaces lines.
Line numbers Check this box if you want line
. LineNumsFns numbers to be printed in defined
on functions .
functions.
Check this box if you want line
Line numbers . numbers to be printed in variables. If
. LineNumsVars . . . .
on variables you choose this option, line numbering
starts at JIO.
Click to select the font to be used for
Font Font printing. Note that only fixed-pitch

fonts are supported.
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Margins Tab

B Dyalog APLAY Print Configuration

Setup | Marging | Header/Footer | Printer

Left margir: 0.5 Hnits

Bight margin: 0.5
Top margir: (IR

Bottom margin: 0.5

(#) Inches

() Centimetres

(] l [ Cancel

Table 38: Print Configuration dialog: Margins

Label Parameter Description

Use margins UseMargins Check this box if you want margins to
apply

Left margin MarginLeft Specifies the width of the left margin

Right margin MarginRight Specifies the width of the right margin

Top margin MarginTop Specifies the height of the top margin

Bottom margin | MarginBottom Spem.ﬁes the height of the bottom
margin

Inches MarginInch Specifies that the margin units are inches

Centimetres MarginCM Spegﬁes that the margin units are
centimetres
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Header/Footer Tab

B Dyalog APLAY Print Configuration

Setup || Marging | Header/Footer | Printer

Workspace Twznamet{cr}

Footer
{crt{h1}Printed at {printdate} {printtime}{rj}Page {cu

Prefis funcions with:
{Th1¥{objname}{ri} Author:{author} Last Fixed:{fixdate}

Prefix variables with;
{Th1H{objname}{cr}

Prefiz other objects with
{Th1H{objname}{cr}

(] l[ Cancel
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Table 39: Print Configuration dialog: Header/Footer

objects with

Label Parameter Description
Header DoHeader Spemﬁes whether or not a header is
printed at the top of each page
Header HeaderText The header text
Specifies whether or not a footer is
Footer DoFooter printed at the bottom of each page
Footer FooterText The footer text
Prefix functions DoSenFn Specifies whether or not text is printed
with p before each defined function
Prefix functions The text to be printed before each
with SepFnText defined function. This can include its
name, timestamp and author
Prefix variables Specifies whether or not text is printed
with DoSepVar before each variable.
Prefix variables SepVarText The text to be printed before each
with p variable. This can include its name.
Specifies whether or not text is printed
Prefix other before other objects. These include
obiects with DoSepOther locked functions, external functions, [INA
) functions, derived functions and
namespaces.
Prefix other SepOtherText The text to be printed before other

objects. This can include its name.
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The specification for headers and footers may include a mixture of your own text, and
keywords which are enclosed in braces, e.g. {objname}. Keywords act like variables
and are replaced at print time by corresponding values.

Any of'the following fields may be included in headers, footers and separators.

{WSName} {WS} Workspace name
{NSName} {NS} Namespace name
{ObjName} {OB} Object name

{Author} {AU} Author

{FixDate} {FD} Date function was last fixed
{FixTime} {FT}  Time function was fixed
{PrintDate} {PD} Today's date

{PrintTime} {PT}  Current time

{CurrentPage} {CP}  Current page number
{TotalPages} {TP}  Total number of pages
{RightJustify} {RJ}  Right-justifies subsequent text/fields
{HorizontalLine} {HL} Inserts a horizontal line
{CarriageReturn} {CR} Inserts a new-line

For example, the specification:
Workspace: {wsname} {objname} {rj} Printed {PrintTime} {PrintDate}

would cause the following header, footer or separator to be printed at the appropriate
position in each page of output:

Workspace: U\WS\WDESIGN WIZ change toolbar Printed 14:40:11 02 March
1998
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Printer Tab

5 Dyalog APL/W Print

Frinter l Setup | Margins | Header/Footer

Mame: |HF' Lazerlet 4200L PCL &
Where:  hpd200

Frirt
Al

~

ﬂ Properties. ..

Frint | Cancel

Table 40: Print Configuration dialog: Print

Label Parameter Description

. . The name of the printer to be used for
Name PrinterField printing from Dyalog APL.
Properties Click this to set Printer options.
Where Reports the printer device

Allows you to choose between printing
all of the current object or just the

Print selection. Note that this option is present
only when the dialog box is displayed in
response to selecting Print.

Status Window
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The Status window is used to display system messages and supplementary infor-
mation. These include the operations that take place when you register an OLEServer
or ActiveXControl.

The Status window is also used to display supplementary information about errors.
For example, if in a [JWC statement you misspell the type of an object, you will get a
suitable error message in the Status window, in addition to the DOMAIN ERROR mes-
sage in the Session.

Example

'"F'OWC'FROM' A Should be 'FORM'
DOMAIN ERROR
"F'0OWC'FROM'

A

555 Dyalog APLAW - Status mEx]

File Options

Invalid ohject tupe: FROH

Cloze

The Status window can be explicitly displayed or hidden using the [Status] sys-
tem operation which is associated with the Tools/Status menu item.

There is also an option to have the Status window appear automatically whenever a
new message is written to it. This option is selected using the [AutoStatus] sys-
tem operation which is associated with the Tools/AutoStatus menu item.

Note that when you close the Status window, all the system messages in it are
cleared.
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The Workspace Explorer Tool

The Explorer tool is a modeless dialog box that may be toggled on and off by the sys-
tem action [Exp lorer]. In a default Session, this is attached to a Menultem in the
Tools menu and a Button on the session toolbar.

The Explorer contains two sub-windows. The one on the left displays the namespace
structure of your workspace using a TreeView. The right-hand window is a ListView
that displays the contents of the namespace that is selected in the TreeView.

Y| Exploring C:\Program Files\Dyalog\Dyalog APL 13.... g@
File Edit Cptions Miew Tools
EEBRXQHE of BEEEER &4l al &l
Workspace Tree Contents of B.Whesign.FropFmt
BRI A | Name | Type (]
=I-[] Whesign .@Animatiun Function
& [Fns/ops]| | [)BTNS Variable
%] [Varsz] F)BTNSCONY Function
+-[] Bitmaps .@Eitmap Function
+-[2 BMED FlBrowsebox Function
4 (] Buttons ¥ CHOICES Variable
w7 ColourPick .@Ealendar Function
4] Events .@Eheck Function
S GridTitle .@Eircle Function
4[] GWiz .@Eamha Function
: -@EDmeEX Function
* DILIAHZ ......... . -@EDD[E&F Functiaon
+-[JiPropFmt: ,
............................. ] L -@EHFSDF Functian
- Prop¥al .@DateTimeP... Function
@ Styles .@Edit Function
+- (3 TabWiz v B EditBox Function ™
< Ba 2]
75 object(s), &60,38Mb free, 233536 bytes used {0 bytes se

The Explorer is closely modelled on the Windows Explorer in Windows and the facil-
ities it provides are very similar. For Windows users, the operation of this tool is prob-
ably self-explanatory. However, other users may find the following discussion useful.
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Exploring the Workspace

The TreeView displays the structure of your workspace. Initially it shows the root
and Session namespaces # and [JSE. The icon for # is open indicating that its con-
tents are those that appear in the ListView. You can expand or collapse the TreeView
of the workspace structure by clicking on the mini-buttons (labelled + and -) or by
double-clicking the icons. A single click on a closed namespace icon opens it and
causes its contents to be displayed in the ListView. Another way to open a names-
pace is to double-click its icon in the ListView. Only one namespace can be open at
a time. The icons used in the display are described below.

Class
Namespace (closed)
GUI Namespace (closed)

Namespace (open)

ge olLE

GUI Namespace (open)

Function

Variable

Operator

Indicates an object that has been erased
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Viewing and Arranging Objects

The ListView displays the contents of a namespace in one of four different ways
namely Large Icon view, Small Icon view, List view or Details view. Y ou can switch
between views using the View menu or the tool buttons that are provided. In the first
three views, the system displays the name of'the object together with an icon that
identifies its type. In Details view, the system displays several columns of additional
information. Y ou may resize the column widths by dragging or double-clicking the
lines in the header. To hide a column, drag its width to the far left. The additional col-
umns are:

This is the namespace containing the object. By definition, this
Location |is the same for all of the objects shown in the ListView and is
normally hidden

For a function or operator, this is the function header stripped
of localised names and comment. For a variable, the description
indicates its rank, shape and data type. For a namespace, the
description indicates the nature of the namespace; a plain
namespace is described as namespace, a GUI Form object is
described as Form, and so forth.

Description

Size The size of the object as reported by 0SIZE.

Modified | For functions and operators, this is the timestamp when the
on object was last fixed. For other objects this field is empty.

Modified | For functions and operators, this is the name of the user who
by last fixed the object. For other objects this field is empty.

In any view, you may arrange the objects in ascending order of name, size, timestamp
or class by clicking the appropriate tool button. In Details view, you may sort in
ascending or descending order by clicking on the appropriate column heading. The
first click sorts in ascending order; the second in descending order.
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Moving and Copying Objects

You can move and copy objects from one namespace to another using drag-drop or
from the Edit menu.

To move one or more objects using drag-and-drop editing:

1. Select the objects you want to move in the ListView.

2. Point to one of the selected objects and then press and hold down the left
mouse button. When the drag-and-drop pointer appears, drag the object(s) to
another namespace in the TreeView. To indicate which of the namespaces is
the current target, its name will be highlighted as you drag the selected
object(s) over the TreeView.

3. Release the mouse button to drop the objects into place. The objects will
disappear from the ListView because they have been moved to another
namespace.

To copy one or more objects using drag-and-drop editing, the procedure is the same
except that you must press and hold the Ctrl key before you release the mouse button.

You may also move and copy objects using the Edit menu. To do so, select the
object(s) and then choose Move or Copy from the Edit menu. You will be prompted
for the name of the namespace into which the objects are to be moved or copied.
Enter the namespace and click OK.

Editing and Renaming Objects

You can open up an edit window for a function or variable by double-clicking its
icon, or by selecting it and choosing Edit from the Edit menu or from the popup
menu. You may rename an object by clicking its name (as opposed to its icon) and
then editing this text. You may also select the object and choose Rename from the
Edit menu or from the popup menu. Note that when you rename an object, the orig-
inal name is discarded. Unlike changing a function name in the editor, this is not a
copy operation.
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Using the Explorer as an Editor

If you open the Fns/Ops item, the names of the functions and operators in the names-
pace are displayed below it alphabetically in the left (tree view) pane. When you
select one of these names, the function itself'is opened in the right (list view) pane.

1| Exploring C:\Program Files\Dyalog\Dyalog APL 13.0 Unicode'ws\wdesign g@
Elle Edit Options Yiew Tools

B X Q& e el ol al Bl
Workspace Tree

B 1nscol Al A A X |4 40 | *m °F *p
&) INSROW L% OML

&) KEYPRESS OML<0

&) LAST_BTN T $1f 2=0NC'DESCRIBE'

@LIST_OBJ tDESCRIBE
@LOCP\TE EndIf

£ LOWER

gLy

&) MAKE

&) MAKE_BTN

& MAKE_EXEL

£ MAKE_FMT_FN

£ MAKE_FMT_PROP

&) MAKE_FN

) MAKE_FN_FORM

&) MAKE_FN_GRID [,
<] Lo [#]  [Function Dyadic: 25/06/1996 Pos: 05,1
413 object(s), 60.37Mb free, 1041076 bytes used (D bytes selected)

Y ou may use this feature to quickly cycle through the functions (or variables) in a
namespace, pressing cursor up and cursor down in the left (tree view) pane to move
from one to another.

You may also edit the function directly in the right (list view) pane before moving on
to another.
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The File Menu

Prink...
Prink setup...

Delete
R.enarme
Properties

Close

Fz
alk Enker

The File menu, illustrated above, provides the following actions. All but Print setup

and Close act on the object or objects that are currently selected in the ListView.

Print Prints the object(s).

Prin Displays the Print Configuration dialog box

setup play g g .

Delete Erases the object(s).

Rename Re.nam.es the object. This option only applies when a single
object is selected.

Properties | Displays a property sheet; one for each object that is selected.

Close Closes the Explorer
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The Edit Menu

Edit  Enter
Copy  ChrliC
Move

Select 3 Select Functions
Select Yariables

Select Mone
Select Al Chrl &
Irvert Selection

The Edit menu, illustrated above, provides the following actions. The Edit, Copy and
Move operations act on the object or objects that are currently selected in the List-
View.

Edit Opens an edit window for each of the objects selected.
Copy Prompts for a namespace and copies the object(s) there.
Move Prompts for a namespace and moves the object(s) there.
Select- Selects all of the functions and operators in the ListView.
Functions

Sele‘ct Selects all of the variables in the ListView.

Variables

Select None | Deselects all of the objects in the ListView.

Select All Selects all of the objects in the ListView.

Invert Deselects the selected objects and selects all those that were
Selection not selected.
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The Options Menu

v Toolbar
Toolbar Captions
v Status Bars

v Tvpe Libraries
Expand All
Fefresh MNow FS

v Auko Refresh

The Options menu, illustrated above, provides the following actions.

Toolbar |Displays or hides the Explorer toolbar.
Toolbar Displays or hides the button captions on the Explorer toolbar
Captions play p P '
StatusBar | Displays or hides the Explorer statusbar.
Type . . o
Libraries Enables/disables the exploring of Type Libraries
Expands all namespaces and sub-namespaces in the TreeView,
Expand s 1 . . .
All providing a complete view of the workspace structure, including
or excluding the Session object JSE.
Refresh Redisplays the TreeView and ListView with the current structure
and contents of the workspace. Used if Auto Refresh is not
Now
enabled.
Auto Specifies whether or not the Explorer immediately reflects
Refresh | changes in the active workspace.

If Auto Refresh is checked the Explorer is updated every time APL returns to desk-cal-
culator mode. This means that it is always in step with the active workspace. If you

have a large number of objects displayed in the Explorer, the update may take a few

seconds and you may wish to prevent this by un-checking this menu item Ifyou do
so, the Explorer must be explicitly updated by selecting the Refresh Now action.
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The View Menu
Columns kW Mame
v Location
Large Icons
v Type
amall Icons o
) v Descripkion
List Icons )
w Details v Size
v Modified on
Scope k| v Modified by

arrange Icons  #

Line up Icons
W Aukto Arrange

The View menu, illustrated above, provides the following actions.

Columns | Allows you to select which columns you wish to display.
Large Selects Large Icon view in the ListView.
Icons
Small | elects Small Icon view in the ListView.
Icons
List Selects List view in the ListView.
Icons
Details Selects Details view in the ListView.
Allows you to choose whether the Explorer displays objects in
Scope .
local scope or in global scope.
;&cl(“)rnz;nge Sorts the items in the ListView by name, type, size or date.
Line up Rearranges the icons into a regular grid.
Icons
Auto If checked, the icons are automatically re-arranged when
Arrange |appropriate
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The Tools Menu

Find...
Go ko,

F3
Ctrl G

G0 ko Session Space
et Session space

The Tools menu, illustrated above, provides the following actions.

Find Displays the Find Objects Tool

Go to Prompts for a namespace and then opens that namespace in the
TreeView, displaying its contents in the ListView

Go to . . .

Session Opens the namespace in the TreeView control corresponding to
the current space in the Session.

Space

Set . . .

Session Sets the current space in the Session to be the namespace that is
currently open in the TreeView.

Space
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Browsing Classes

Classes are represented by icons. The picture below shows 3 classes: Bird,

Parrot and DomesticParrot.

-ﬂ Exploring C:\Help13.0ws\PARROTS [#]

M= X

Bile Edit

BERXQE oF

Options  Wiew  Tools

Workspace Tree

alolal fl

Contents of # (Global Scope)

+3¢
+-(271 OSE

FParrot

3 object(s), 61.57Mb free,

i Parrot |

38548 bytes used (20136 bytes selected)

Ifyou open the # node in the left-hand pane, you see the contents of # as a tree.

= Exploring C:\Help13.0Wws\PARROTS [#]

=%

File Edit

BRXQE oF

Options  View Tools

glolaltl

Workspace Tree

Contents of # (Global Scope)

Tl )
<20 Bird
+ [0 DomesticPar Bird
+ B Parrot

+-(gg] OSE

< i | =

3 object(s), 61.57Mb free,

Parrot

Domesti
i Parrot |

38548 bytes used (20136 bytes selected)
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Browsing Class Scripts

Selecting DomesticParrot in the left-hand pane brings up its Class Script in the
right-hand pane.

i Exploring C:\Help13.0\ws\PARROTS [#.DomesticParrot] |[=] <
File Edit Options Yiew Tools

BB X Q& cF alglal ol

Workspace Tree Contents of #.DomesticParrot
-t A A X ~| B & M *F %P
* @Brd iClass DomesticParrot: Parrot
+ EDiDomesticPar ®  iField Public Name
w1 Parrot
+ (271 OSE [0] = 7 egglname species)
[1] thccess Public
[2] tImplements Constructor :Base species
[3] O0F Mame+name
[u] L 7
[0] = 7 eggl
[1] thccess Public
[2] tImplements Constructor :Base 'Generic'
[3] ODF Name+'Paolly’
[u] L 7
[0] = 7 R+ipeak
[1] thccess Public
[2] R+0BASE.Speak, ' Who's a pretty boy,thent’
[3] 7

iEndClass A DomesticParrot

< 1l | 2] [class Pos: 0/21,0
3 objectis), 61.57Mb free, 38548 bytes used (20136 bytes selected)
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... and selecting Parrot in the left-hand pane brings up the Class Script for
Parrot.

] Exploring C:\Help13.0\ws\PARROTS [#.Parrot] =13
File Edit ©Options ‘iew Tools

(BBRXAE o mEEER| a6

Workspace Tree |Contents of #.Parrot
HoA A X ~| 48 8| *m *F *p
:Class Parrot: Bird
[0] =] 7 egg species
[11 tAccess Public Instance
[21 iImplements Constructor :Base 'Parrot: ',species
[3] L 7
[o] =] 7 ReSpeak
[11] thAccess Public
[21] Re'Squark?t’
[3] L 7
[o] =] 7 kill
[1] tImplements Destructor
[21] 'This Farrot is dead’
[31] L 7

tEndClass A Farrot

loting CiiHelp13. ... B unikitled - Paint | el | |
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... and finally, selecting B i rd in the left-hand pane brings up the Class Script for
Bird.

) Exploring C:\Help13.0\ws\PARROTS [ Bird] M=%
Eila Edit Options iew Tools
EBRXQE o EEEE 408
Workspace Tree |Eontents of #.Bird
EE Bl A A X | 48 A *m %F P
L iClass Bird
+0 DomesticPar & :Field Public Species
+ & Parrot
+ (g7 OSE [0] =] ¥ eBgqg spec
[1] thcceszsz Public Instance
[2] :Implements Constructor
[3] Species+szpec
(L] L 7
(o] = 7 R+Speak
[1] tAccess Public
[z] Fe'Tweet, tweett'
[31] L 7
tEndClass A Bird
£ $| [l”class | |F‘05:D,|'15,U
||3 object(s), 61.57Mb free, |38548 bytes used (20136 bytes selacted) v
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If you open a Class node, a tree appears to help you to navigate within the Class
script. In the picture below, the user has opened the [Methods ] node and then
clicked on Speak. The system has responded by scrolling to (if necessary) and high-
lighting the appropriate section of the script.

| | Exploring C:\Help13.0\ws\PARROTS [#.DomesticParrot] =JoJed
File Edit Options Yew Tools

BB XQE o glglalol

Workspace Tree Contents of #.DomesticParrot
- @ # A A X | a8 &
[ Bird . tClass DomesticParrot: Parrot
- [E DamesticParrat & tField Public Hame
+.4% [Constructors]
w80 [Dfns] [o] = 7 eqglname species)
w3 [Fields] [1] thccess Public
5 [Methods] [2] tImplements Constructor :Bak
F)Speak [3] ODF Hame+name
S Dol L] .
+.3% [Nested Classes] -
2
+ SI:I [Mested Hamespaces] [o] =] 7 eggl
<41 [Properties] [1] tAccess Public
% [Sections] [2] tImplements Constructor tBaw
+[E0 Parrot [3] O0F Mame< ' Polly'
+- (g OSE [u] L v
[o] = 7 R+Speak
[1] tAccess Public
[2] R«OBASE.Speak, ' Who's a prew
[3] L 7

iEndClazs A DomezticParrot

<] m | (2]
< M [[2] [class Pos: 15/21,0

3 object(s), 61.57Mb free. 38548 bytes used (20136 bytes selected)
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Browsing Type Libraries

When the View/Type Libraries option is enabled, the Workspace Explorer allows
you to:

e Browse the Type Libraries for all the COM server objects that are installed
on your computer, whether or not they are loaded in your workspace.

e Load Type Libraries for COM objects

e Browse the Type Library associated with an OLEClient object that is
already instantiated in the workspace.

If the Microsoft .Net Framework is installed, you may in addition:

e Load Metadata for specific .Net classes
e Browse the loaded Metadata, viewing information about classes, methods,
properties and so forth.

If the Type Libraries option is enabled, the Workspace Explorer displays a folder
labelled TypeLibs which, when opened, displays two others labelled Loaded
Libraries and Registered Libraries as shown below.

r.ilql Exploring CLEAR WS [#] g@-\

File Edit W%ew Columns Tools

TR XQE | G0 EE (N

Workzpace Tree Contents of #

+-i=y H Name Type
+ OsE

+-fiet Metalata

=% Typelibs

#'l Loaded Libraries
-3 Registered Libraries

<] 2]
0 objectis), 61.7Mb (64700600 bytes) free, 0 bytes used (0 bytes selected) in Lo
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Browsing Registered Libraries

If you open the Registered Libraries folder, the Workspace Explorer will display in
the tree view pane the names of all the Type Libraries associated with the COM
Server objects that are installed on your computer.

If you select one of these Library names, some summary information is displayed in
the list view pane.

For example, the result of selecting the Microsoft Excel 9.0 Object Library is illus-
trated below.

2 Exploring CLEAR WS [#] =Jo&d

File Edit Wiew Columns Tools

FRXQE ¢ HEEE| e

‘Workspace Tree Contents of TypelibsiReqgistered Libraries\Micrasoft Excel 9.0 Ob
g Microsoft DTSPackag_hj Akkribube Yalue
Sfil Microzoft Excel 5.0 CLSID {00020a1 3-0000-0000-C000-00000000004
#9(Microsoft Excel 9.0 Object Library. ['\-'ersion:1.3,Locale:UJF'-Ex

- ; TR O T TS IO T T IS T

3‘%‘ Microsoft FlexBrid HeI;FiIe C:{Prn;ram FiIes'ltMicrnsnFt OFFice'ltOFFice'l,\-'B
gidMicrozoft FlexGrid HelpID Ox0000FFFF
g9 Microsoft Forms 2.0, ]| Version 1.3

< [ 2 <] 2]

0 object(s). 61.7Mb (64700600 bytes) free,

Ifinstead, you select the Registered Libraries folder itself, the list of Registered Type
Libraries is displayed in the list view pane

1] Exploring CLEAR WS [#] E]@

File Edit Wiew Columns Tools

FRXQE | HEEE|| e

‘Workspace Tree Contents of TypelibsiReqistered Libraries
- B “ Mame Loaded | CLSID “
+ OsE || Microsoft Direct’ Transforms Image T... {SE77EE
+.0ét MetaData Microsoft Disk Quata 1.0 {798865
a , Microsoft Excel 5.0 Object Library {000208
= Typelibs . Microsaft Excel 9,0 Object Library | 1000208
g1 Loaded Libraries Microsoft, FlexGrid Contral 6.0 {9CF7ALl
S R egistered Libraries Microsoft FlexGrid Contral 6.0 (SP3) {SE9E7E
[ Microsoft Forms 2.0 Object Library {0D452E
IAS Hel COM C
oy Elper BT | Microsoft Farms 2,0 Object Library {57DELL
g1 IAS RADIUS Protocc || microsoft Forms 2.0 Object Library 16705F0
g% . (Version:1.0,Locs Microsaft Farms 2.0 Object Library {8EEA31
#%1:-) YideoSoft wsFle | Micresoft Forms 2.0 Object Library {aC1152
) @ w e m e ieea ™| Microsoft Forms 2.0 Object Library {91152
< > < >

0 object(s), 61.7Mb (64700600 bytes) free, 0 bytes used (0 bytes selected) in Local Scope
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Loading a Type Library
You can load a library shown in the list view pane by double-clicking its name.

Alternatively, you can load a library shown in the tree view pane by selecting Load
from its context menu.

In either case, a message box will appear asking you to confirm. The operation to
load a Type Library may take a few moments to complete.

Notice that if the selected Library references any other libraries, they too will be
loaded. For example, loading the Microsoft Excel 9.0 Object Library brings in the
Microsoft Office 9.0 Object Library and the Microsoft Visual Basic for Applications
Extensibility 5.3 Library too. It also contains references to a general library called the
OLE Automation Type Library, so this is also loaded.

When you ) SAVE your workspace, all of the Type Libraries that you have loaded
will be saved with it. Note that type library information can take up a considerable
amount of workspace.
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Browsing Loaded Libraries

If you have already loaded any Type Libraries into the workspace, using the Work-
space Explorer or as a result of creating one or more OLEClient objects, you can
select and open the Loaded Libraries folder.

The picture below illustrates the effect of having loaded the Microsoft Excel 9.0
Object Library.

_-'IJ, Exploring CLEAR WS [#] E]@

File Edit Wew Columns Tools

T8 XQE | [ E (25 e 0

‘Workspace Tree Contents of TypelibsiLoaded Libraries
iy B Mame Loaded | CLSID
+ OsE OLE Automation fes {00020430-1
-0t MetaData Unknown Types es {ZFCA3ECE-
4T Lib Microsoft Office 9.0 Object Library es {ZDFED04C
= “‘y':Fl eLi1bs . . . Microsoft Wisual Basic For Applications..,  Yes {O00ZE157-1
—-# JiLloaded Libraries: Microsoft Excel 9.0 Object Library es 40002081 3-

@I Microsoft Excel 9.0 0
2 #IMicrosoft Office 9.0
f8 Microsoft Yisual Basi
£.%% OLE Automation
=% Registered Libraries
a B3 2]
0 object(s). 61.7Mb (64700600 bytes) free,

Notice that any external references to other libraries causes these to be brought in
too.

If you select a loaded Type Library, summary information is displayed in the list
view pane.

Ifyou open a loaded Type Library, four sub-folders appear named Object CoClasses,
Objects, Enums and Event Sets respectively.
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Object CoClasses

A Type Library describes a number of objects. Typically, all of the objects have prop-
erties and methods, but only some of them, perhaps just a few, generate events.
Objects which generate events are represented by CoClasses, each of which has a
pointer to the object itself and a pointer to an event set.

For example, the Microsoft Excel 9.0 Object Library contains seven CoClasses
named Application, Chart, Global etc as shown below.

2 Exploring CLEAR WS [#]

=/od

File Edit Wew Columns Tools
P BXQE = 00E[E| s
‘Workspace Tree Caontents of TvpelibsiLoaded LibrariesiMicrosoft Ex
= B || Mame CLSID
OsE Application {000z245
Tt MetaData Chart {00208
g T Lib Global {000z08
= Typelibs . — ||| oLEbject 000208
=471 Loaded Libraries CQueryTable {59191C
D& Microsoft Excel 9.0 Object Workbook {o00zos
w#Yi0bject Coblasses) Wiorkshest {000208
@1 Objects
& Enums
@49 Event Sets
e AN -
(<] I | [ (=] I [*]

0 object(s). 61.7Mb (64700600 bytes) free,
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Opening the Application folder you can see that the Application CoClass comprises
the Application object coupled with the AppEvents event set as shown below.

] Exploring CLEAR WS [#] =<
File Edit Wew Columns Tools
P mxQE| | 00 EE s
‘Workspace Tree Contents of TvpelibsiLoaded LibrariesiMicrosoft Ex
ElafilLoaded Libraries [A]
&I Microsoft Excel 9.0 Object Marne Application
= ﬂ Object CoClasses CLSID {0002 4500-0000-0000-C000-
a5 Helpstring
=8y ||| HelpFile Z:\Program Files\Microsoft Of
=40 Event Sets = || HelpID 000020001
'l AppEvents
= #'l Interfaces
=& _Application
1 Methods
| Froperties
#59 Chart
w2 Glabal (]
[{] i | [}] [{] i [)]
0 object(s), 61.7Mb (64700600 bytes) free,

The specific methods, properties and events supported by the CoClass object can be
examined by opening the appropriate sub-folder. The same information for these and
other objects is also accessible from the Objects and Event Sets folders as discussed

below.
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Objects

The Objects folder contains several sub-folders each of which represents a named
object defined in the library.

Each object folder contains two sub-folders named Methods and Properties. Selecting
one of these causes the list of Methods or Properties to be displayed in the list view
pane. The picture below shows the Methods exposed by the Microsoft Excel 9.0
Range object.

] Exploring CLEAR WS [#] =JoEed
File Edit Wew Columns Tools
?RXQE |06 EE|H e
‘Workspace Tree Caontents of TypelibsiLoaded Libraries|Micrasoft Excel 9.0 Obij
w89 Points “ Mame Fesult “
4% Publi zhObject Activate YT_YARIAMNT
w351 PublishObiects AddComment Comment
Y a Tabl AdvancedFilker YT_YARIANT
=8 QueryTables Anplyklames YT _YARTANT
= ApplyOutlineStyles VT_YARIAMT
AutoZomplete WT_B3TR
g o AutoFill YT_VARIAMT
P t -
£ Froperties ALtoFilter YT_VARIANT
+-3#1 RecentFile | AutoFi YT_YARIANT
w41 RecentFiles AutoFormat YT _WARIANT
£ 4% Rectangle AutoOutline WT_YARTANT
Y Rect 1 || Borderfround YT_YARIAMT
- # 8 Rectangles (vl mg e YT VARTANT %)
B E3 B2 E3
0 object(s), 61, 7Mb (64700600 bytes) free,
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If you open the Methods or Properties subfolder, you can display more detailed infor-
mation about individual Methods and Properties. For example, the following picture
shows information about the SaveAs method exposed by the Microsoft Excel 9.0
Worksheet object.

4 Exploring CLEAR WS [#] =<

File Edit W¥iew Columns Tools

T XQE | EDEEE |60l

‘Workspace Tree Contents of TvpelibsiLoaded LibrariesiMicrosaft Excel 9.0 Object Library
¥l PivatTables | N
gl PivotTableWizard )l | Marme Saveds Bl
£ PrintOut Help String
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€ Frotect Result YT _0ID
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] Argurnents:
a:l ResetAl1PageBreaks Filoname WT_BSTR [in]
#1 Savehs FileFormat WT_WARIANT  [Optional,[in]
&%l Scenarios Password WT_WARIAMT  [Cptional],[in]
#*1 ScrollBars WriteResPassward WT_VARIANT [Optional],[in]
a ReadCnlyRecommended WT_VARIANT [Optional],[in]
oy Select CreateBackup WT_WARIANT  [Optional],[in]
#1 SetBackgroundPicture AddToMru WT_WARIAMT  [Dptional],[in]
71 ShowAl1Data || TextCodepage WT_MARIAMT  [Cptional],[in] —
F R T ™| TextvisualLayout WT WARIANT [optionall,fin] ¥
< > < >

0 object(s), 61.7Mb (64700600 bytes) free,

This tells you that the Save4s method takes up to 9 parameters of which the first, File-
name, is mandatory and is of data type VT BSTR (a character string). Note that [in]
indicates that the parameter is an input parameter.
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Incidentally, the optional Fileformat parameter is an example of a parameter whose
value must be one of a list of Enumerated Constants. Even without looking at the doc-
umentation, the possible values can be deduced by browsing the Enums folder, with
the results shown below.

2 Exploring CLEAR WS [#]

Workspace Tree

File Edit ‘Yiew Columns Tools

BB X4 & cf

<

A1EditionOptiors
X¥1EditionType
X¥1EnableCancelk
K1EnableSelecti
KIEndStylelap
X1ErrorBarDirec
¥1ErrorBarlnclo
K1ErrorBarType
K1FileAccess

H1Fi11With
XK1FilterAction
K1FindLookIn ™

.X

B B B B B BB BB

0 object{s), 61.49Mb (64474120 bytes) free.

-
M=%
alglol By
Contents of TypelibsiLoaded LibrariesiMicrosaft Exce
Marme |Vmue_6_
#AddIn 1a
xS 5]
#CSYMac 2z
wIZSYMSDIDS 24
TS windows 23
x|DBFZ2 7
*IDBF3 g
*IDBF4 11
«IDIF 9
#lExcelz 16
x|Excel2FarEast 27
#lExcel3 29
wlExceld 33
®lExcels 39
#IExcel7 39
I P zretazas 47 ¥

Y ou can therefore deduce that the following expression, executed in the namespace
associated with the currently active worksheet, will save the sheet in comma-sep-
arated format (CSV) in a file called mysheet.csv:

"MYSHEET.CSV' xLlCSV

SaveAs

or

SaveAs

"MYSHEET.CSV' 6
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Event Sets

The Event Sets folder contains several sub-folders each of which represents a named
set of events generated by the objects defined in the library.

If you open one of these event sets, the names of the events it contains are displayed
in the tree view pane. If you then select one of the events, its details are displayed in
the list view pane as shown below.

4] Exploring CLEAR WS [#] M=}
File Edit View Columns Tools
P EBRXQE = ([EEDEEI[5H5 e
Warkspace Tree Contents of TypelibsiLoaded Libraries! Microsof
o B P
OsE Mame Shestckivate
R Metabata = :E:plgtring O=00010619
=25 TypelLibs 1 =P *
ElgfilLuaded Libraries Result YT _WoID
o @I Microsaft Excel 9.0 Objec
@ : Arguments:
3{:l0b]lect CaoClazzes <h VT DISPATCH
#]Objects
#*1 Enums
= 'l Event Sets
=-%% AppEvents
= gl Events
&1 NewWarkbaook
[( ] I [{ ] Ll [)]
0 object(s). 60.34Mb (63266256 bytes) free,

This example shows that when it fires, the SheetActivate event invokes your call-
back function with a single argument named S whose datatype is VT _DISPATCH
(in practice, a Worksheet object).
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Enums

The Enums folder will typically contain several sub-folders each of which represents

a named set of enumerated constants.

If you select one of these sets, the names and values of the constants it contains are

displayed in the list view pane as shown below.
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File Edit View Columns Tools
EEBEXQHE of HEEE 2ol
Workspace Tree Conkents of TypelibsiLoaded Librariesih
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0 objectis). 61, 49Mb (54474120 bytes) free.
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Browsing .Net Classes

Microsoft supplies a tool for browsing .NET Class libraries called TLDASM. EXE!.

As a convenience, the Dyalog APL Workspace Explorer has been extended to per-
form a similar task as TLDASM so that you can gain access to the information within
the context of the APL environment.

The information that describes .NET classes, which is known as its Metadata, is part
of'the definition of the class and is stored with it. This Metadata corresponds to Type
Information in COM, which is typically stored in a separate Type Library.

To enable the display of Metadata in the Workspace Explorer, you must have the
Type Libraries option of the View menu checked.

I ITLDASM.EXE can be found in the NET SDK and is distributed with Visual Studio
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To gain information about one or more Net Classes, open the Workspace Explorer,

right click the Metadata folder, and choose Load.

] Exploring CLEAR WS [#]

BE<]

Tt MetaDat a
w & Typelibs

File Edit View Columns Tools

P ERXQE i |[HEEE |60l
Workspace Tree Contents of MetaData

=Y

OsE

This brings up the Browse .Net Assembly dialog box as shown below. Navigate to the

NET assembly of your choice, and click Open.

-

Browse .Net Assembly

D

My Recent
Documents

=

Dezktop

=,

(a7
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My Computer

by Metwark,

.
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Marme Size | Type Date [A]
é] Microsoft_Ysavh,dll 7KE aApplication Extension 09/0<4
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é] mscordacks, dll 54 KE  Application Extension  09/04
é] mscordbe, dil 63KE Application Extension  05/04
é] mscordbi.dll 291 KE  Application Extension  09/04
é] mscorie, dll 32KE Application Extension  05/0
é] mscarjic.dll 315KE  Application Extension  09/04] =
é] mscarld.dil 7o KB Application Extension  05/04
e ] 4,304 KE  Application Extension 09704
é] mscorpe, dil 9z KB Application Extension  05/04
é] mscorre. dll 309KE Application Extension 0304
é] mscorsec, dil 62 KB Application Extension  08/04
é] mscorsn,dil SKE Application Extension  05/04
é] mscorsye. dil ZE5KE  Application Extension  05/04/ 4
R
<] 11 | (2]
File narne: |mscnrlib.dll [V] [ Open l
Flesof type: | Net Assembles [*dl] ~| [ Cancal |
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Note that the .NET Classes provided with the .NET Framework are typically located
in C: \WINDOWS\Microsoft.NET\Framework\V2.0.50215. The last named
folder is the Version number.

The most commonly used classes of the .NET Namespace System are stored in this
directory in an Assembly named mscorlib.dl11, along with a number of other fun-
damental NET Namespaces.

The result of opening this Assembly is illustrated in the following screen shot. The
somewhat complex tree structure that is shown in the Workspace Explorer merely
reflects the structure of the Metadata itself.
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Bt System.Diagnostics.SymbolStore
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Opening the System/ Classes sub-folder causes the Explorer to display the list of
classes contained in the .NET Namespace System as shown in the picture below.
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The Constructors folder shows you the list of all of the valid constructors and their
parameter sets with which you may create a new instance of the Class by calling
New. The constructors are those named .ctor; you may ignore the one named .cctor,
(the class constructor) and any labelled as Private.

For example, you can deduce that DateT ime . New may be called with three
numeric (Int32) parameters, or six numeric (Int32) parameters, and so forth. There
are in fact seven different ways that you can create an instance ofa DateTime.

4 Exploring CLEAR WS [#] =oed

Eile Edit YWew Columns Tools
T XxXqQE @ |EEGES (40 =
‘Warkspace Tree Caonkenk:
- Tt System.DateTime 4\
+Jit Base Class
--Jiét Constructors
et (FrivatelWoid .cctor()
Mt (PrivatelV¥oid .ctor(Intel, System.DateTimelind, Boolean)
et (Private)lVoid .ctor(System.Runtime.Serialization.Serializatior
et (PrivatelWoid .ctor(UIntBl)
Bt Yoid .ctor(Int32, Int32, Int32)
Bt Yoid .etor(Int32, Int32, Int32, Int32, Int32, Int32)
et Woid .ctor(Int32, Int32, Int32, Int32, Int32, Int3Z, Int3Z2]
Rt Void .ctor(Int32, Int32, Int32, Int32, Int32, Int32, Int3Z2, 3
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For example, the following statement may be used to create a new instance of
DateTime (09:30 in the morning on 30t April 2001):

mydt<[INEW DateTime (2001 4 30 9 30 0)

mydt
30/04/2001 09:30:00
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The Properties folder provides a list of the properties supported by the Class. It
shows the name of the property followed by its data type. For example, the
DayOfYear property is defined to be of type Int32.
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You can query a property by direct reference:

mydt.DayOfWeek
Monday
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Notice too that the data types of some properties are not simple data types, but

Classes in their own right. For example, the data type of the Now property is itself
System.DateTime. This means that when you reference the Now property, you
get back an object that represents an instance of the System.DateTime object:

mydt.Now
07/11/2001 11:30:48
aTs
2001 11 7 11 30 48 O

The Methods folder lists the methods supported by the Class. The Explorer shows the
data type of the result of the method, followed by the name of the method and the
types of its arguments. For example, the IsLeapYear method takes an Int32
parameter (year) and returns a Boolean result.

mydt.IsLeapYear 2000
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Many of the reported objects are listed as Private, which means they are inaccessible
to users of the class — you are not able to call them or inspect their value. For more
information about classes, see the chapter on Object Oriented Programming in the
Dyalog APL Language Reference Manual.
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%t [nt3z CompareCsustem.DateTime, Sustem.DateTimel)

£ »
1 object(s), 53.9Mb (56515472 bytes) free.
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Find Objects Tool

The Find Objects tool is a modeless dialog box that may be toggled on and off by the
system action [WSSearch]. In a default Session, this is attached to a Menultem in
the Tools menu and a Button on the session toolbar. This tool allows you to search
the active workspace for objects that satisfy various criteria.

The first page allows you to specify the name of the object which you wish to find
and the namespace(s) in the workspace that are to be searched for it.

&7 Find Objects

File Edit  YWiew Columns  Search

X B | BH B E B #4|od = Bl

. Delete  Props Large | Small  List  Detals | |Mame | Size Date  Type

Name/Lacation | Modified | Advanced

Hamed:

W ariables Functionz Operators Mamezpaces
Look in;
Inzhude sub-namespaces Inzhude Sezsion namespace

You type the name of the object you wish to find into the field labelled Named. To
locate all objects beginning with a particular string, enter the string followed by a 'x'
character. For example, if you enter the string FOO*, the system will locate all objects
whose name begins with FOO.

Four check boxes are provided for you to specify the types of objects you wish to

locate. For example, if you clear Variables, Operators and Namespaces, the system
will only search for functions.
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You can restrict the search to a particular namespace by typing its name into the field
labelled Look in. Y ou can also restrict the search by clearing the Include sub-
namespaces and Include Session namespace check boxes. Clearing the former
restricts the search to the root namespace or to the namespace that you have specified
in Look in, and does not search within any sub-namespaces contained therein. Clear-
ing the latter causes the system to ignore [JSE in its search.

The second page, labelled Modified, allows you to search for objects that have been
modified by a particular user or at a certain time

&1 Find Objects

File Edit Wiew Columns Search

X B | BB E B #4 |4 = bl

. Delete  Props Large | Small  List  Details | Mame | Size  Date  Type

Mame/Location | Modified | 4dvanced

Modified Dbjects

Modified by
) Ay date
07/12/2007
and 06011 /2008
O during the previous miarth{z)
() during the previous dayls]

To make the search dependent upon modification, you must check the Modified
Objects check box.

To locate objects modified by a particular user, enter the user name in the field
labelled Modified by. Otherwise leave this blank.

To find objects which have been modified at a certain time or within a specified
period of time, check the appropriate radio button and enter the appropriate dates or
time spans.
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The third page, labelled Advanced, allows you to search for objects that contain a par-
ticular text string.

&7 Find Objects

File Edit  YWiew Columns  Search

X B | BH B E B #4|od = Bl

. Delete  Props Large | Small  List  Detals | |Mame | Size Date  Type

Mame/Location | Modified | Advanced

Containing T ext: [l

Match Casze Match whole Ward
IUze Fiegular Expressions || As Symbol Reference

[ 5ize between

If you wish to search for objects containing a particular character string, type the
string into the field labelled Containing Text.

Match Case specifies whether or not the text search is case sensitive.

Use Regular Expressions specifies whether or not regular expressions are applicable.
For example, if you enter FOO* into the field labelled Containing Text and check
this box, the system will find objects that contain any text string starting with the 3
characters FOO. If this box is not checked, the system will find objects that contain
the 4 characters FOOx.

Match Whole Word specifies whether or not the search is restricted to entire words.

As Symbol Reference specifies whether or not the search is restricted to APL symbols.
If so, matching text in comments and other strings is ignored.

If you wish to restrict the search to find only objects whose size is within a given
range, check the box labelled Size is between and enter values into the fields pro-
vided.
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When you press the Find Now button, the system searches for objects that satisfy all
ofthe criteria that you have specified on all 3 pages of the dialog box and displays
themin a ListView. The example below illustrates the result of searching the work-
space for all functions containing references to the symbol CURSOR.

-,

&1 Find Objects

File Edit Wwiew Columns Search

X & B EH E B & o o &l

Delete Props Large 3Small  List Details || Mame Size  Date  Type
Name/Location | Modiied Advanced l
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Iv Match Caze Iv M atch Whale Ward Mew Search
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[ Size between

Mame Location |
.@BED_EGPYMENUS #.Whesign.EBMED
@EH&HGEP'-ML #.Wheszign '
Firiurpcnr p1rieal # LiNasinm RMERN sl
4 »

6 object(s) Found in Global Scope

You may change the way in which the objects are displayed in the ListView using
the View menu or the tool buttons, in the same manner as for objects displayed in the
Workspace Explorer. You may also edit, delete and rename objects in the same way.
Furthermore, objects can be copied or moved by dragging from the ListView in the
Search tool to the TreeView in the Explorer.

If you wish to specify a completely new set of criteria, press the New Search button.
This will reset all of the various controls on the 3 pages of the dialog box to their
default values.
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Object Properties Dialog Box

The Object Properties dialog box displays detailed information for an APL object. It
is displayed by executing the system action [Ob jProps ]. In a default Session, this
is provided in the Tools menu, the Session popup menu and from the Explorer. An

example (for a function) is shown below.

Properties Tab

The Properties tab displays general information about the object. For a function, this
includes an extract from its header line, when it was last modified, and by whom.

¥] #.CENTRE - Properties

-,

hd amikar
CENTRE
Type Functiaon
Dezcription

Location  #

Size 3920 [892 bytes)
Modified 04 Movember 1938 12:35
By Diyadic

QE, l [ Cancel
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Value Tab

For a variable, the Values tab displays the value of the variable. For a function, it dis-
plays its canonical representation.

-,

¥] #.CENTRE - Properties
Froperties "H"'-3|UE hd amikar
7 TEXT+W CEWTRE TEXT:SPLC5:FORE:BACK @A Centre TE.
[1] TEAT<( [ 14pTEXT) . WI+TEXT A Stretch t
[2] SPCS+«TEXT=" ' A Identify :
[3] FORE++/~\5PLS f Mumber of
[4] BACK++/~%¢5PC5 f ..
[5] TEXT+[[0.5=FORE-BACK] 4TEXT A Rotate ea:
7
£ b
QE, l[ Cancel
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Monitor Tab

The Monitor tab applies only to a function and displays the result of JMONITOR.
The Reset button resets JIMONITOR for the lines on which it is currently set. The Set
All Lines button sets JMONITOR to monitor all the lines in the function. The Clear
All Lines switches JMONITOR off.

[ 1
. [ |
¥ # .CENTRE - Properties
Froperties | Yalue |
Line Mumber Zount ZPU time {ms) | Elapsed time (ms)
0 4006 551 550
1 4006 140 150
2 4006 70 70
3 4006 30 40
4 4006 &0 &0
5 4006 130 130
Reset | | SetéllLines | | ClearllLines |
[ ] l [ Cancel




Chapter 2: The APL Environment 205

COM Properties Tab

The COM Properties tab applies only to a function in an OLEServer or Activ-
eXControl namespace. The tab is used to define arguments and data types for an
exported Method or Property. For further information, see Interface Guide.

-,

Y] #.Loan.CalcPayments - Properties

Properties | Walue | Monitor | COM Properties

Param Name| Type | b odifier | Optional |
Resut  [VT_Ra | WT_sRREY v

Loandmt WT_l4 w Ed ]
Lenkd ax YT 14 A A Fi
Lenkdin YT_l4 w + O
Intrhd & WT_ld e | [
Intrkdin WT_I4 w | [

Help 1D

{(*) Method () Prop Get () Prop Set

Exported

QE, l [ Cancel
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Net Properties Tab

The Net Properties tab applies only to a function in a NetType namespace. The tab is
used to define arguments and data types for an exported Method or Property. For fur-
ther information, see . Net Interface Guide.

- =
Z] #.APLClasses.Primitives. IndexGen - Properties

Pararm Name| Type | t adifier | Optional |
Fesult | Int321] ~| -]
Mumnber [nt32 ﬂ ﬂ [

Help [ad |

* Method (" web Method ¢ PropGet ¢ Prop Set |

[+ Public [ Static [ Yirtual [ Constructar
[ Protected

| QF. | Cancel
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The Editor
Invoking the Editor

The editor may be invoked in several ways. From the session, you can use the system
command ) ED or the system function [JED, specifying the names(s) of the object(s) to
be edited. You can also type the name of the object and then press Shift+Enter (ED),
click the Edit tool on the tool bar, or select Edit from the Action menu. If you invoke
the editor when the cursor is positioned on the empty input line, with a suspended
function in the State Indicator, the editor is invoked on the suspended function and
the cursor is positioned on the line at which it is suspended. This is termed naked
edit. These ways of invoking the editor apply only in the session window

J Editor - [BUILD_SESSION] M=)
[ File Edit Refactor window Wiew _ 8%
B9 A A X ~|dB 40 °m *F *p

[0l {FILE}BUILD_SESSION LANG: OEJ MEEOT0; OML OLD: NEWMOTIFS w|as
[1] A Build the szeszsion object and zave if desired

[z21] :If 0=0NC'NoPrompt' ¢ NoPrompt+0 < :EndIf

[3] :If O0=0ONC'FILE' & FILE<'' ¢ :EndIf

(4]

[5] OWX+0SE.OWs+1 < OML OIO+1 < OPATH+'#.Trans'

[&] OPW=122 A allows room for Status Bar

[7] MOTIF«'M'=3=2t+", 'OWG ' APLVersion'

(el Y12¢122230YFI{ (T L+ 'L ' ) fw} 22t

[9] LAMG+upCase,LANG A translation assumes uppercase

[10] UNICODE<20=0DR' ' _
[11] "Unknown language 'OSIGNAL(Trans.CODESe™cLANG) 411 |~
<] B
Function Last saved by: Pete: 14 August 2009 09:51 Paos: 0f207,1

In addition, there is a general point-and-edit facility which works in edit and trace
windows too. Simply position the input cursor over a name and double-click the left
mouse button. Alternatively, you can press Shift+Enter or select Edit from the File
menu. The name can appear in the Session, in an Edit window, or in a Trace window;
the effect is the same. Note that, in the Session, typing a name and pressing
Shift+Enter is actually a special case of point-and-edit. Note also that a naked edit
can be invoked by double-clicking the left mouse button in the empty input line.

The type of a new object defaults to function/operator unless the object is shadowed,
in which case it defaults to a variable (vector of character vectors). You can however
specify the type of a new object explicitly using ) ED or JED . For example, typing
")ED eLIST -MAT"ina CLEAR WS would create Edit windows for a vector of
character vectors named LIST and a character matrix called MAT. See ) ED or [JED for
details.
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Ifthe name is not already being edited, it is assigned a new edit window. If you edit a
name which is already being edited, the system focuses on the existing edit window
rather than opening a new one. Edit windows are displayed using the colour com-
bination associated with the type of the object being edited.

Window Management (Standard)

Unless Classic Dyalog mode is selected (Options/Configure/Trace/Edit), the Editor
is a Multiple Document Interface (MDI) window that may be a stand-alone window,
or be docked in the Session window. Each of the objects being edited is displayed in
a separate sub-window. Individual edit windows are managed using standard MDI
facilities.

5 Editor REX)

File Edit Refactor ‘window ‘iew

$P BUILD_SESSION B [=

A A X v|db g m eF cp
[0] {FILE}BUILD_SESSION LANG;OBJ:MSG:DIO:DML:OLD:NEH:MOTIF:Ebkg
[1] A Build the session object and zave if desired

[2] * — - o

(3] | §BUILD_MB_FILE =1
[s1 F
(s |B A& X | MEY YR
[&] [0] ME BUILD_ME_FILE LANG

[7] [1] acs Me

[3] [2]
[9] [2] "file'0WC Menu' [LANG TranslateString ' &File’)
rasn [h]

[il— "file.clear'OWC'Menultem' (LANG TranslateStringm
Functiory "file.clear 'OWs'Event’' 'Select’ '[wsclear]’
"file.clear'OWS'Hint '(LANG TranslateString'Clew

I ] LZJ

johnd: 107042006 Fos: 0/67,1

The initial size of an edit window is specified by the edit_rows and edit_cols param-
eters. The first edit window is positioned at 0 0. Subsequent ones are staggered
according to the values of the edit_offset y and edit_offset x parameters.

By default, the Session has the Editor docked along the right edge of the Session win-
dow. When you edit a function, the Editor window automatically springs into view
as illustrated overleaf.
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B C:\Program Files\Dyalog\Dyalog APL 12.1 Unicodews\BUILDSE - Dyalog APLAY

Fle Edt Yew Windows Session Log Action Options Tools Threads Help

s DS Y ot BBV @l @ el QG B e BB 0 v sesson 5 |BPBSUncede  |v][ 1612

[B][=1]

Language Bar P =11 ﬁ
FEFFEFEELT] [IFEF FFEEFEFE FEFF FEETER [EEREE B
Unicode Edition
Fri Aug 14 09:59:28 2009
clear ws
Jload BUILDSE
C:“Program Files“\DyaloghDyalog APL 12.1 Unicodehws\BUILDSE saved Tue Jul 28 12:11:18 2009
This workspace is used to reset the session according to seme
international Farmats 1ike german, french or english.
For example, to redsfine the italian look try
BUILD_SESSION '"IT'
You can alzo reset the SALT wtility programs here by doing
EUILD_DVALOGSPACE
In any caze, to make sure the changes are effective, you should
save your session via the menu item SessionfSave or Sawe as...
Dyalog 2008
Wersion 2.31
Jfns
BUILD_DVALOGSPACE BUILD_MB_ACTION BUILD_MEB_EDIT BUILD_MB_FILE BUILD_MB_HELP BUILD_MB_LOG
BUILD_MB_OPTIONS BUILD_MB_SESSION BUILD_MB_THREADS BUILD_MB_TOOLS BUILD_MB_WIEW
BUILD_MB_VIEW_COOL BUILD_MB_WINDOWS BUILD_POPUF BUILD_SE BUILD_SESSION BUILD_TE
BUILD_TC BootLib Bootlocation BootSALT BuildSessionMenu DllVersion GetUTFEFile
I0_TOGGLE KEY_TOGGLE POSITION_SESSION TB_POPUP TOGELE  UCMD WSloaded lowCase
pbase  wediff
=}
=
Debugger w
Ready. .. Ins  NUM
CurQbj: &:l aoQ: 0 OTEAP  OSI:0  QOI0:1  0OML:0

ﬂ! C:\Program Files\Dyalog\Dyalog APL 12.1 Unicodews\BUILDSE - Dyalog APLAW

Fle Edt Refactor Window View

Language Bar Zle x|

FEMFFEERLT] ML FFEFFEER

=]
ol
i

JP BUILD_SESSION

[B][=1%]
s D EHY et B@ESEVERESE O @HE B E o o :Sessmnb“‘ iEES)

E]r;;:uasm 09:59:28 2009 (AAX| v]o8 & m oF *p
Jload BUILDSE [o] {FILEJBUTLD_SESSION LANG:O0BI;MSE:010:0ML;OLD: NEW: MOTIF; BOC
C:VProgram Files\DyalegiDyalog AFL 12.1 Unice [1] # Build the session object and save if desired
[21 $If 0=ONG'NoPrompt' ¢ MoPrompt<d ¢ :EndIf
This workspace is used to reset the session a [3] tIf 0=ONC'FILE' © FILE< ' ¢ :Endlf
international formats like german, french or [4]
[s] OWs<0SE. OWi+1 © DML OI0<1 ¢ OPATH+'#.Trans'
For example, to redsfine the italian look try [s] OPW
BUILD_SESSION 'IT' [71 woT | 55 BUILD_MB_FILE
[&] iz o %
You can alsa reset the SALT utility programs [3] Lanfi? A A X ‘ t]ag 48 m *F *p
BUILD_DYALOGSPACE [10] unrgtel ME BUILD_ME_FILE LANG 3
[11] unflf1] ocs Me
In any case, to make sure the changes are eff [121 r2]
save your session via the menu item Session/S [13] A Exgll3] | #i1e'OWC Menu' (LANG TranslateString &File’)
[1u] f ang|l4]
Dyalag 2008 151 opdl(5] "file.clear OWC'Menultem' (LANG TranslateStrin
Version 2.31 [161 opr{l6] "file.clesr OWS Event’ 'Select’ ‘[wsclsar]’
Yins [171 or1)|l7] "file.clear OWS'Hint ' (LANG TranslateString Gl
BUILD_DYALOGSPACE BUILD_ME_ACTION BUILD nrul[8]
SUILD MB_OPTIONS BUILD MB_SESSION [91 "file.load OWC'Merulten' (LANG TranslatsString
BUILD ME VIEW COOL BUILD ME WINDOWS Function [10] "file.load ONS'Event’ 'Select’ '[wsload]’
BUILD T&  Bootlib Bootlocation  BootS [111 "file.load OWS 'Hint (LANG TranslateString Loa
10_TOGGLE KEY_TOGELE POSITION_SESS r1z]
iplaze wsdiff [131 "File.copy OWC Menultem' (LANG TranslateString
[1s] "file.copy OWS'Event’ 'Select' '[wscopy]’ U
riea [DIEPAR WIS WS s CLAME Tramal ok S et e s
<l = | @ | & < M ]
— = Function Last saved by johnd: 10 Aprl 2006 1137 Pos: 3/67,1 v
Debugger Hlojx| w I | (&)
Ready. .. Ins  HUM

CurObj: ME (Undefined)

&il Opa:0  OTRAP  O$I:0 | OIO0:1  QOML:0




Chapter 2: The APL Environment

210

You can resize the Editor pane to view more or less of the Session itself, by dragging

its title bar.

Using the buttons in the title bar, you can instantly maximise the Editor pane to
allow you to concentrate on editing, or minimise it to reveal the entire Session. In

either case, the restore button quickly restores the 2-pane layout.

The picture below shows the effect of maximising the Editor. The BUILD_SESSION

edit window is itself maximised within the Editor too.

5 C:\Program Files\Dyalog\Dyalog APL 12.1 Unicode'ws\BUILDSE - Dyalog APLAW - [BUILD_SESSION] ===
Jpb Fle Edt Refactor window Visw _& x
ws D E Y iohe BB SV o b2 @b itoo @ G OB O Ede (B« o Sesson (2 |APLIBEUncode v [ 162
ﬂmnﬂx v|d6 4 *m *F %P
| [0l {FILE}BUILD_SESSION LANG QBT MSG:OI0; OML; OLD; MEW; MOTIF; COOL;MB; SBL; SB2;TE; SBi SBH; toolssidyalogikini okiOPATH » /A
[l A Build the session object and save if desired
[21 t1¢ 0=[NC 'MoPrompt’ © NoPrompt<0 o :EndIf
[31 :If O=0OMC'FILE' ¢ FILE+'' ¢ :EndIf
5]
[51 OWX+0SE.OWX+1 o OML O10+1 ¢ OPATH+'#.Trans’
3 OPW+122 A allows room for Status Bar
[71 MOTIF+'M'=32t+", "O4E'APLVersion'
(81 V121222300 FI{0 1+en 'L ' ) b} 2ot
[91 LANG+upCase, LANG A translation assumes uppercase
[1o] UNICODE<80=00R" '
[t11 ‘Unkonwn language '0SIGNAL(Trans.CODES=XcLANG) 411
[i12]
[13]  n Expunge MenuBar(s), StatusBar(s), ToolBar(s) and TigField(s)
[l A and expunge OSE.WSDoc and OSE.NumEd
[15] OBJ+0WN'0OSE"
[18] OBJ+((0B] OWG"c Type')e MenuBar' 'StatusBar' 'TonlBar' 'TipField' 'Menu' 'CoolBar')/0BJ
[t?l 0BJ,+'OSE.WSDoc' '0OSE.NumEd’
[18] OEX 0BT
[13] ‘OSE'OWS'Event’ 0 0O
[20]
[211 :If 0=2p0BJ+0SE.ONL 2 3 4 9
[22] 0BJe~a' 'ULOBT
[23] TEXT+(='Do you went to delete all the following Session objects 7'),087
[2u1 'MSE'OAWC 'MsgBox' 'BUILD_SESSION'TEXT('Style' 'Query')('Event' 'A11° 1)
[25] $1F HoPrompt
[28] 10r1f "MsgBtnl'=250DQ MSG
[27] [«'Remaving ', (7242, /0B1,"<", '),"
[28] OSE.DEX10B] b
‘6 [29] ' . Done’ ha
£ <) B
W Function Last sawed by: Danb: 19 May 2009 11:42 Pas: 0/207,1
: Ready... Ins KM
: CurObj: ME (Undefined) &:1 goa:0  OTRAP  D0OSI:0  QOI0:1 OML: o

Note that when the Editor has the focus, the Editor menubar is displayed in place of
the Session menubar.
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Window Management (Classic Dyalog mode)

If Classic Dyalog mode is selected (Options/Configure/Trace/Edit) each Edit win-
dow is a top-level window created as a child of the Session window. This means that

Edit windows always appear on top of the Session.

The first edit window is created at the position specified by the edit_first y and
edit_first_x parameters. The initial size of an edit window is specified by the edit_

rows and edit_cols parameters.

S5 BUILD_SESSION M=%

File Edit Refactor Wiew

A A X v| ik &) *m *F

[0] I{FILE}BUILD_SESSIGN LANG:OBI:M5G:010: " A

[1] i Build the session object and sawve if w!

[2] :If 0=0ONC'NoPrompt' < NoPrompt<d < -Emw

[2] :If O=OMC'FILE' ¢ FILE+'' & :EndIf

[L]

[5] OWr+O%E.OWx+1 < OML OI0«1 < OFATH+'f. »

[6] OPW+122 m allows room for Status Bar  [¥)

Function Danb: 19052009 | Pos: 0/207,1

& X

ol F_EBBUILD_TC Mi==

o7 File Edit Refactor Wiew

(11 |B1 A A X v i 4 m*

(2] |ITo] BUILD_TC LANG:X:IL:TBE:S A

(3] Ji01] IL«(='O%E.chtop. '), "i1n' "i1h' 'i1i ml

(L1 frz21 TB+'Oze.chtop.bandtbl.th’

(31 (I[2] TE OWC 'Toclcontral "('Divider' 01J0'Sh »

(6] [J[u] tWith TE

AN (=0 OWS ' Imagelist ' IL

Furictilf [ £ ] :If ~#.MOTIF A pop-up menu probl »
[7] OWSE 'Event ' 'MouseDown’ '0OSE »
[2] tEndIf —
rni >
Funckion johnd: 08/01/2008 Pos: 0f182,1
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Subsequent ones are staggered according to the values of the edit_offset_y and edit_
offset_x parameters.

Moving around an edit window

You can move around in the edit window using the scrollbar, the cursor keys, and the
PgUp and PgDn keys. In addition, Ctrl+Home (UL) moves the cursor to the begin-
ning of the top-line in the object and Ctrl+End moves the cursor to the end of the last
line in the object. Home (LL) and End (RL) move the cursor to the beginning and end
respectively of the line containing the cursor.

Closing an edit window

Closing an edit window from its System Menu has the same effect as choosing Exit
from the File Menu; namely that it fixes the object in the workspace and then closes
the edit window.

Minimising an edit window

Minimising an edit window causes it to be displayed as a Dyalog APL Edit icon,
with the name of the object underneath. The edit window can be restored in the nor-
mal way, or by an attempt to re-edit the same name.
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Editor ToolBar

1A A X

~[06 8 *m*F %P

Toggle line numbers

A

Comment selected text

i |

Uncomment selected text

X

Save changes and return

Search Box

(H
Search for Next Match

)

Search for Previous Match

“m

Refactor text as method

*F
Refactor text as field

*p
Refactor text as property

Toggles Line numbers on/off.

Adds a comment to the beginning of
the current line or all selected lines.

Removes a comment (if present) from
the current line or all selected lines.

Saves changes and closes the current
edit window.

Enter search text and click one of the
following two buttons.

Locates the next occurrence of the
search text

Locates the previous occurrence of
the search.

Inserts a Method template for the
selected name.

Inserts a Field template for the
selected name.

Inserts a Property template for the
selected name.
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The File Menu

Fix

Print...
Print Sekup. ..

Properties

Exit {and Fix) Esc

Exit and discard changes Shift+Esc

The File menu illustrated above is displayed when editing a simple object and pro-
vides the following options.

Fixes the object in the workspace, but leaves the edit
window open. Edit history is also preserved. If the data

Fix has changed and the confirm_fix parameter is set, you
will be prompted to confirm.
Fix Script (Disabled unless editing a script)
. Opens an Edit window on the name under the mouse
Edit . .
pointer. (Disabled when not).
Print Prints the current contents of the edit window.
Print Setup Displays the Print Configuration dialog box.
; . T for th
Properties Displays the Object Properties dialog box for the

current object.

Fixes the object in the workspace and closes the edit
window. If the data has changed and the confirm_exit
parameter is set, you will be prompted to confirm.

Exit (and Fix)

Exit (and fix

script)

(Disabled unless editing a script)

Exit and discard
changes

Closes the edit window, but does not fix the object in
the workspace. If the data has changed and the
confirm_abort parameter is set, you will be prompted
to confirm.
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The File Menu (editing a script)

Fix whole script
Fiz orly Funckions

Prink. ..
Prink Setup...

Properties

Exit and fix whole script Esc
Exit and fix only functions
Exit and discard changes  Shift+Esc

The File menu illustrated above is displayed when editing a script and provides the
following different options from those shown on the preceding page.

Fix whole script Fixes the entire script

Fix only functions | Fixes only the functions in the script.

Exit and fix whole

. Fixes the entire script, and exits the Editor.
script

Exit and fix only | Fixes only the functions in the script and exits the
functions Editor.

Editing Scripts

Suppose that you have a Class that manages a list of items in a shared Field, so some-
where in the script would appear a line such as:-

:Field shared public List {gets} {zilde}

You run your application for a bit, and L i s t, which was initially empty, gets
updated as new instances of the Class are created. You then edit the Class to add a
new function, or fix a bug. In this instance, when you exit the editor you may not
want L ist to be reset back to the empty vector although you do want the new ver-
sion of the function(s) in the Class to be fixed.

Nevertheless whenever you edit the Class when it is not suspended, you probably
always want the entire script to be re-fixed, and L i st re-initialised.

The options in the File menu shown above provide for these alternatives.

In addition, the Configuration dialog (See "Fixing Scripts" on page 144) allows you
to define the behaviour of the keystrokes <EP> and <S1> for both the suspended
case and the non-suspended case. This association will be displayed against the
appropriate action according to the state of the script you are editing.




Chapter 2: The APL Environment 216

The Edit Menu

The Edit menu provides a means to execute those commands that are concerned with
editing text. The Edit menu and the actions it provides are described below.

Reformat kKevpad-Slash
Zuk Shift+Delete
Copy Ckel+Insert
Paste Shift+Insert

Paste Unicode
Paste Mon-Unicode

Clear Delete

open Line Ckrl+Shift+Insert
Delete Line Crrl+Delete

Gota Line

Eind. ..

Replace. ..

Comment Selected Lines  ChrlHAlL+,
Incomment Selected Lines  Chrl+alt+,

Toggle Local Marme Chel+Up
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Reformats the function body in the edit window, indenting

Reformat .
control structures as appropriate.

Undoes the last change made to the object. Repeated use
Undo of this command sequentially undoes each change made
since the edit window was opened.

Re-applies the previous undone change. Repeated use of

Redo this command sequentially restores every undone change.
Copies the selected text to the clipboard and removes it
Cut .
from the object.
Copy Copies the selected text to the clipboard.
Paste Copies the text in the clipboard into the object at the

current location of the input cursor.

Same as Paste, but gets the Unicode text from the

Paste Unicode clipboard and converts to [JAV

Paste Non- Same as Paste, but gets the ANSI text from the clipboard
Unicode and converts to [JAV.
Deletes the selection or the character under the cursor. Has
Clear .
no effect on the clipboard
Open Line Inserts a blank line immediately below the current one.
Delete Line Deletes the current line.
Goto Line Brompts for a line number, then positions the cursor on that
line.
Find Displays the Find dialog box.
Replace Displays the Replace dialog box.
Comment Adds a comment symbol to the beginning of all selected

selected lines lines.

UnComment Removes a comment symbol from the beginning of all
selected lines selected lines.

Toggle Local | Adds or removes the name under the cursor to/from the
name function header line.

The Find and Replace items are used to display the Find dialog box and the
Find/Replace dialog box respectively. These boxes are used to perform search and
replace operations and are described later in this Chapter.
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Once displayed, each of the two dialog boxes remains on the screen until it is either
closed or replaced by the other. This is convenient if the same operations are to be per-
formed over and over again, and/or in several windows. Find and Find/Replace oper-
ations are effective in the window that previously had the focus.

The Refactor Menu

Add ket as Field
Add text as Properky
&dd text as Method

The Refactor menu illustrated above applies only when editing a Class and provides
the following options. In each case, the user must highlight a name in the Edit win-
dow, and then select one of these options to insert the appropriate template for that
name into the body of'the Class.

Add text as Field Inserts a Field template for the selected name.

Add text as Property | Inserts a Property template for the selected name.

Add text as Method |Inserts a Method template for the selected text name.

The View Menu

Trace
v Stop
Manitor

Line Mumbers Mum -
v Function Line MNurmbers

v Tree Yiew

v Dutlining
Expand All Qutlines
Collapse All Cutlines
Expand all Dutlines below here
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The View menu, illustrated above, provides the following actions.

Displays a column to the left of the function that displays

Trace OTRACE settings
Sto Displays a column to the left of the function that displays
P (STOP settings

. Displays a column to the left of the function that displays
Monitor 1 qyONTTOR settings
Line . .
Numbers Toggles the display of line numbers on/off.
Function Toggles the display of line numbers on individual functions
Line on/off. This option is only enabled when editing a Class,
Numbers Namespace script or Interface.

Tree View | Toggles the display of the treeview in the left-hand pane.

Outlining Tums outlining on and off.

Expand All .

Outlines Expands all outlines.

Collapse All .

Outlines Collapses all outlines

Expand all

Outlines Expands all outlines below the level of the current line.
below here

Function Line Numbers

The Function Line Numbers option in the Editor menu provides an additional level
of line-numbering. If selected, line numbers are displayed independently on each
individual function (or operator) in the Class. This option is only enabled when you
are editing a Class, Namespace script or Interface, and is disabled for all other types
of object.

Note that function line-numbering and general line-numbering are independent
options and it is possible to have the entire Class numbered (from [0] to the number
oflines in the Class) in addition to having line-numbering on each individual func-
tion.
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The Window Menu

The Window menu provides a means to control the display of the various edit win-
dows. The Window menu and the actions it provides are described below.

Close all windows
Cascade

Tile

arrange Icons

Editor ]
Cebugger

Close Closes all the edit windows. If Confirm on Edit Window Closed
All is checked, you will be prompted to confirm for any objects that
Windows | you have changed.

Cascade | Arranges the edit windows in overlapping fashion.

Tile Arranges the edit windows in a tiling fashion.
Arrange o o

Arranges any minimised edit windows.
Icons

Allows you to Select the edit window corresponding to the

Editor named object.
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Using the Editor

Creating a New Function

Type the name of your function and invoke the editor. To do this you may press
Shift+Enter, or select Edit from the Action menu, or double-click the left button on
your mouse, or click the Edit tool in the tool bar. A new window will appear on the
screen with the name you have chosen displayed in the top border. The name is also
inserted in the function header and the cursor positioned to the right. The new win-
dow is automatically given the input focus.

Line-Numbers on/off

Try changing the line numbers setting by clicking on the Line Numbers option in the
Options menu. Note that line-numbering on/off is effective for all edit windows.

Adding Lines

If the keyboard is in /nsert mode, pressing Enter at the end of a line opens you a new
blank line under the current one and positions the cursor there ready for input. You
can also open a new blank line by pressing Ctrl+Shift+Insert (OP).

Ifthe cursor is at the end of the last line in the function, pressing Enter adds another
line even if the keyboard is in Replace mode.

Indenting Text

Dyalog APL allows you to insert leading spaces in lines of a function and (unless the
AutoFormat parameter is set) preserves these spaces between editing sessions.
Embedded spaces are however discarded. You can enter spaces using the space bar or
the Tab key. Pressing Tab inserts spaces up to the next tab stop corresponding to the
value of the TabStops parameter. If the AutoIndent parameter is set, new lines are
automatically indented the same amount as the preceding line.

Reformatting

The RD command (which by default is mapped to Keypad-Slash) reformats a func-
tion according to your AutoFormat and TabStops settings.

Deleting Lines

To delete a block of lines, select them by dragging the mouse or using the keyboard
and then press Delete or select Clear from the Edit menu. A quick way to delete the
current line without selecting it first is to press Ctrl+Delete (DK) or select Delete
Line from the Edit menu.
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Copying Lines

Select the lines you wish to copy by dragging the mouse or using the keyboard. Then
press Ctrl+Insert or select Copy from the Edit menu. This action copies the selection
to the clipboard. Now position the input cursor where you wish to make the copy
and press Shift+Insert, or select Paste from the Edit menu. You can also use this
method to duplicate a ragged block of text.

To copy text using drag-and-drop editing:

1. Select the text you want to move.

2. Hold down the Ctrl key, point to the selected text and then press and hold
down the left mouse button. When the drag-and-drop pointer appears, drag
the cursor to a new location.

3. Release the mouse button to drop the text into place.

Moving Lines

Select the lines you wish to copy by dragging the mouse or using the keyboard. Then
press Shift+Delete or select Cut from the Edit menu. This action copies the selection
to the clipboard and removes it. Now position the input cursor at the new location
and press Shift+Insert, or select Paste from the Edit menu. You can also use this
method to move a ragged block of text.

To move text using drag-and-drop editing:

1. Select the text you want to move.

2. Point to the selected text and then press and hold down the left mouse but-
ton. When the drag-and-drop pointer appears, drag the cursor to a new loca-
tion.

3. Release the mouse button to drop the text into place.

Joining and Splitting Lines

To join a line to the previous one: select Insert mode; position the cursor on the first
character in the line; press Bksp.

To split a line: select Insert mode; position the cursor at the place you want it split;
press Retumn.

Toggling Localisation

The TL command (which by default is mapped to Ctrl+Up) toggles the localisation
of'the name under the cursor. If the name is currently global, pressing Ctrl+Up causes
the name to be added to the list of locals in the function header. If the name is already
localised, pressing Ctrl+Alt+] removes it from the header.
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Outlining

When you are editing a function, outlining identifies the blocks of code within con-
trol structures, and allows you to collapse and expand these blocks so that you can
focus your attention on particular parts of the code

The picture below shows the result of opening the function JSE.cbtop.TB_
POPUP.

Jed OSE.cbtop.TB_POPUP

5 Editor - [oSE.cbtop.TB_POPUP] M=
F File Edit Refactor window Yiew - & x
A A X v b 8% *m *F *P

[o] I{FLAG}TE_F’OPUP MEG:TC

[1] fi Popup menu on Session ToolContral

[2] E :If O=0ONC'FLAG'

[31 H :If (2=52MSG) A Right mouse button 7

(L] 'popup.captions 'OWS'Checked'ShowCaptions

[5] "popup.list 'OWS 'Checked' ('Flatlist '=Stylel

(6] "popup.multilineg 'OWS'Checked 'Multiline

[71] OpQ ' popup’

sl L tEnd

(9] tElze

[10] TC+'bandtbl.tb' 'bandtb2.tb' ‘bandtb3.tb' 'bandtbl.tb'
(111 & :Select FLAG

[1z1 iCase 1

[13] ShowCaptions+~ShowCaptions

[14] TG OWE"='ShowCaptions ' Showbaptions

[15] :Casze 2

[16] Style«(1+'Flatlist'=Stylel2'Flatlist' 'FlatButtons'
[171] TC OWs"='Style'Style

[18] :Case 3

[13] MultiLine+~MultiLine

[20] TC OWS"c'Multiline'Multiline

[21]

fzz] | tEnd

[23] | :End

Funickion Last saved by: Dyyadic: 20 Ockober 1998 17:15 Pos: 0f24,1

Notice that the various control structure blocks are delineated by a treeview diagram.
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e When you hover the mouse pointer over one of the boxes that mark the start
of a block , the line marking the extent of that block becomes highlighted,
as shown above.

e Ifyou click on a [=] box, the corresponding section collapses, so that only
the first line of the block is displayed, as shown below.

e Ifyou click on a I*l box, the corresponding section is expanded.

5 Editor - [oSE.cbtop.TB_POPUP] M=
F File Edit Refactor window Yiew - & x
A A X v b 8% *m *F *P

[o] I{FLAG}TE_F’OPUP MEG:TC

[1] fi Popup menu on Session ToolContral

[2] [ :1f 0=0ONC'FLAG'

[3]1 H© PIf (2=52MSG) A Right mouse button 9

(391 tElse

[10] TC+'bandtbl.tb' 'bandtb2.tb' ‘bandtb3.tb' 'bandtbl.tb'
(111 & iSelect FLAG

[1z1 iCase 1

[13] ShowCaptions+~ShowCaptions

[14] TG OWE"='ShowCaptions ' Showbaptions

[15] :Casze 2

[16] Style«(1+'Flatlist'=Stylel2'Flatlist' 'FlatButtons'
[171] TC OWs"='Style'Style

[18] iCaze 3

[19] Multilines~MultiLine

[20] TC OWS"c'Multiline'Multiline

[211

fzz] | tEnd

[23] | :End

Function Last saved by: Dyadic: 29 Ockober 1993 17:15 Pos: 0f24,1
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Sections

Functions and scripted objects (classes, namespaces etc.) can be subdivided into Sec-
tions with : Section and : EndSection statements. Both statements may be fol-
lowed by an optional and arbitrary name or description. The purpose is to split the
function up into sections that you can open and close in the Editor, thereby aiding
readability and code management. Sections have no effect on the execution of the
code, but must follow the nesting rules of other control structures.

The following picture illustrates the use of sections in a function called
DumpWindow. The function is divided into 5 sections named Comments, Init,
NAs, MakeBitmapand CopyToClipBoard.

The first picture shows the function with all sections closed.

/B Editor - [DumpWindow] =) 0JEd
S5 Bl Ede Refactor Window  View _| a3 x
-] A A X |48 A 'm *F *p

[o] Dumplindow ref:OI0;0OML

[1] tSection Comments I

[B] tSectian Init

[10] tSection MAs

[25] tSection MakeBitmap

[37] [+ :Section CopyTollipBoard

< B
Maodified Funckion Pete; 170122010 Pos; 1/44,258
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The next picture shows the effect of opening the Comments section. Notice how this
is delineated by the statements:

:Section Comments

:EndSection Comments

5 Editor - [DumpWindow] =Jo&d
[ Ele Edt Refactor Window  View -8 x
-1 A A X v|db &b *m °F *P

[o] Dumpkindow ref;0I0;0OML

[1] :Section Comments

[2] fi eg DumpWindow f f note unquoted name

[31 A Mote only the wvisible part of the window is dumped

(L] fi you may need to set 'OnTop' to ensure total window visibility
[51 tEndSection Comments

[6] :Section Init

[1lo] [{ :Section NAs

[251] [ :Section MakeBitmap

[37]: iM:Section CopyTaClipBoard

< | I B
Madified Function Last saved by: Pete: 17 December 2010 14:52 Pas: 0f44,0

And with the Init section opened too:

5 Editor - [DumpWindow] =JoEd
S Fle Edt Refactor Window iew R
1A A X v |4k 8% *m*F *p

[0l DumpWindow ref:OI0:0OML

[11] [ :3ection Comments

[21 A eg DumpWindow f A note unquoted name

[31 A Mote only the visible part of the window is dumped

[L4] A oyou may need to set 'OnTop' to ensure total window wvisibility
[5] L :EndSectian Comments

(6] E :Section Init

[71 OML OI0<n

[g8] OSHADOWT (= ref ") ~=" "~="I0OREF 32051

[9] | :EndSection|

[1o] [l :Section MAs

[251] [ :Section MakeBitmap

[371] [H:Section CopyToClipBoard

:<: 1l :>:
Modified Function Last saved by: Pete: 17 December 2010 14:52 Pos: 944,12
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Finally, with all the sections opened:

L Ty
£ Editor - [DumpWindow] =JoEd
S Ele Edit Refactor Window Yiew -8 x
A A X v a8 & 'm*F *P
[o] Dumpkindow ref;0I0:0OML A
(1] [ :3ection Gomments
[21 A eg DumpWindow f A note unquoted name
[31 A Mote only the visible part of the window is dumped
[u] fi you may need to set 'OnTop' to ensure total window visibilimw
[5] L :EndSectian Comments
(6] E :Section Init
[7] OML OI0«0
[8l OSHADOWT (= ref ") ~=" "~=7I0OREFS=0S1
[9] | :EndSection
[10] [H :Section NAs
[11] OWA'UL user32|GetWindowDD UL »
[12] OMA' UL user3?|GetWindowRect Ue ={UL U4 UL U} [
[13] OMA'UL user32|ReleaszeDC UL UL »
[14] OMA'UL user32|OpenClipboard Uy -
[15] OMA'UL user32|EmptyClipboard -
[16] OMA'UL user32|SetClipboardData UL Uy -
[17] OMA'UL user32|CloseClipboard -
[181] OMA'UL  gdi32|CreateCompatibleDC UL -
[191] OMA'UL  gdi32|CreateCompatibleBitmap Uk UL UL >
[z20] ONA'Us  gdi22]Selectobject Uk Uk -
[211 ONA'UL  gdi32|DeleteDC Uy -
[221] OMA' UL gdi32|Delete0bject Ul >
[23] OWA'UL  gdiz2|BitBLt UboUb Uh U U Ub U U e
[24] | :EndSection MAs
[25] [ :Section MakeBitmap
[26] hund+ref . 0OWG 'Handle'

[27] hdc+GetWindowDlC hwnd

[28] sze+-—/82 ZplaGetWindowRect hwnd(Lpl)

[29] mdc+CreateCompatibleDl hdc

[30] hbm+CreateCompatibleBitmap hdc,sze

[31] old+SelectObject mdc hbm

[32] ink+«BitBlt mdc O O,zze,hdc O O 13369676 m SRCCPY

[33] jnk+SelectObject mde old

[3L] jnk+Releasedl hdc 0

[35] jnk+DeleteDl mdc

[36] L :EndSection MakeBitmap

[371 iSection GopyToblipBoard

raal ink<0nenflinhnard 0 hdl
< b
Madified Function Last saved by: Pete: 17 December 2010 14:52 Paos: 9/44,12
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Editing Classes

The picture below shows the result of opening the ComponentF i L e class. Notice
how each function is delineated separately and that each function is individually
line-numbered.

)ed ComponentFile

5 Editor - [ComponentFile]

A A X

ﬁﬁile Edit Refactor Window View

=0k

v|dB 8 m *F *p

= ED #.ComponentFil I:E]ass ComponentFile -~
+-#Y [Constructor & tField Private Instance tie "
coa’y [DEns] & tField Private instance temp+Q A Tewk
] .
+§£[F]E]d81 [o] = 7 Open filename
* 3{:' [Methods] [1] i Open MNamed File
* 3{:' [Nested Clas||[3) :Implements Constructor
=80 [Nested Mame |[3] tAccess Publie Instance
w30 [Properties]| |[4]
#-8%9 [Sections] [5] [= :Trap 0
[&] tiecfilename OFSTIE 0
[71] tElse
[&] OFUNTIE filename OFCREATE O naw|
[9] tiecfilename OFSTIE 0 i3
[10] tEndTrap
[11] v
[0] = ¥ OpenTemp:OUSING: z
[1] A Default: Open temporary file
[2] :Implements Constructar
[3] tAccess Public Instance
[L]
[5] OUSING<"'
[&] z+System. I0.Path.GetTempFileName
[7] z OMERASE =z ONTIE 0 m Erase the t®
[2] tieez OFCREATE 0
[9] temp+l
[10] v
[0] v Close
[1] tImplements Destructor
[2] $If ties[FNUMS
[3] :If temp ¢ Name OFERASE tie
[L] :Else ¢ OFUNTIE tie
[5] tEndIf
[&] tEndIf
[7] v |
<] 2] <] 2]
Class Pos: 0/111,0
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The outlining feature really comes into its own when editing classes because you can
collapse and expand whole functions. The picture below shows the effect of col-
lapsing all but the Append method.

5 Editor - [ComponentFile] E]@

JB File Edt Refactor Window View -3 x
B A A X | v|ob 4 m % %P
= [E1 4. ComponentFile kClass ComponentFile
w-3% [Constructors] Los iField Private Instance tie
wi’l [Dfns] & tField Private instance temp+0 »
w4 [Fields] ,
[#] 0 Fil
s [Methods] [ 7 Open filename
Cl
[+-81 [NESth Classes] 7 OPEHTEMP;DUSING}Z
w8 [Nested Mamespaces
wal [Praperties] 7 Closze
w39 [Sections]
i --- Instance Methods ---
(o] 7 r+Append data
[1] tAccess Public Instance
[z2] r+data OFAPPEND tie
(3] 7
7 Rename name
7 Replacelcomp datal
i --- Instance Properties ---
tProperty Mame
:Property Count
:Property Access
tProperty Mumbered Default Com »
A --- Shared Members
7 Delete fileitie
tEndClazs A Class ComponentFile
(<] Im | [ <] I | (2]
Class Pos: 0/111,0
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When you edit a class, a separate treeview is optionally displayed in the left pane to
make it easy to navigate within the class. When you click on a name in the treeview,
the editor automatically scrolls the appropriate section into view (if necessary) and
positions the edit cursor at its start. The picture below illustrates the result of opening
the [Methods ] section and then clicking on Rename.

_ﬁEditnr—[CumpnnentFile] E]
JB File Edt Refactor Window View -8 %
A A X ~ 0k 4 *m *F *p
= [ED #.ComponentFile (a1 L temp+l i~
4% [Canstructors] [10] v
+ Sfil [DFHS]
5468 [Fields] [o] 7 Close
@ [11 tImplements Destructor
=80 [Methods] [2] S1F t1iecOFNUMS
£ Append (3] t1F temp © Name OFERAS m
ElCtlose 4] tElse @ OFUNTIE tie
EDelete [5] tEndlf
a Rename (6] tEndIf
| Replace [7] 7
+-%°1 [Mested Classes]
7% [Hested Mamespaces A== Instance Methods ---
] .
& Sf:l [F‘rop?rtles] [o] = 7 r+Append data
=4 [Sections] [11] tAccess Public Instance
[z21 r+data OFAPPEND tie
[3] L 7
(o] = 7 Rename name
[1] tAccess Public Instance
[21 name [OFREMAME tie
[31 L 7
o] = 7 Replacelcomp datal
[1] tAccess Public Instance
[2] data OFREPLACE tie,comp
[21 L 7
A --- Instance Properties --®
tProperty Mame
tAccess Public Instance
o] 7 r+get
[1] PIf tieeOFNUMS < r<0FN ®
[2] tElse ¢ r+'" & 1EndIf
[31] 7 3l |
o tFndPranertw ..v.
A | £ >
Class Pos: 45/111,0
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Sections within Scripts

Scripts can also be subdivided into Sections using : Sectionand :EndSection
statements. As with single functions, the purpose is only to split the script up into sec-
tions that you can open and close in the Editor. Sections have no effect on the
execution of the code.

The following picture illustrates a Class named actuarial which, for editing pur-
poses, has been sub-divided into five separate Sections named Main,
MenuHandlers,Validation,Utilities and OldCode. In this picture, all
the Sections are closed.

5 Editor - [actuarial] g@
[P Ele Edit Refactor Window Wiew IR
A A X |48 & [ *m *F %p
S [ED #. actuarial iClass actuarial: Page
w35 [Constructors] tUsing System
w41 [Dfns] :Using System.Web.Ul,system.web.dl 1
ol [Fields] .USTng System.Web.UI.HtmlControls
% [Methods] tlUging System.Web.UI.WebControls
* 3‘:‘ tUsing System.Data,system.data.dll
+.41 [Nested Classes] iAcce=s Public
+-#% [Nested MNamespaces]
%% [Properties] tSection Main
-3 [Sections] :Section MenuHandlers
TMain tZection Walidation
B MenuHandlers :Sect?on Utilities
? OldCode tSection OldCode
D tEndClass
T Utilities
F validation
< B
Class Pos: 0f1504,0
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The next picture shows the effect of opening just the Main section.

_ﬁ Editor - [actuarial] g@
— & ®

ﬁ File Edit Refactor ‘Window Wiew

Bl A A X ~| o8 &0 [ m *F %P
- Ed#.actuarial iClags actuarial: Page
9
4% [Constructars] tlUzing System
.35 [Dfnz] ilzing System.Web.Ul,system.web.dll
oa [Fields] tlUsing System.Web.Ul.HtmlControls

tlUsing System.Web. Ul .WebControls
tlsing System.Data,system.data.dll
tAccess Public

1 [Methods]

w31 [Mested Classzes]
#4%1 [Nested Namespaces]
%% [Properties]

4% [Sections]

F

tSection Main
7 Page_Load: INT; AGE:; DUR: TERM: TAB_DURM

(+H1]

§ Main v CALC_FSLTAB_RESULTS(obj evl:X:ULT:w
T MenuHand lers vEE:;C_?L_R;SLIILTS(obj ev] X CHANGE
0ldCod iEndSection Main
% Ut'l?t? tZection MenuHandlers
1.1 “?S tSection Yalidation
f validation B :Section Utilities
tSection OldCode
tEndClass
< 2]
Modified Class Pos: 445/1500,7

Notice that this section is delimited by the two statements:

:Section Main

:EndSection Main
In this picture the 3 functions within the Ma i n section are temporarily closed.
Similarly, the section called Val idation is delimited by:

:Section Validation

:EndSection Validation
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5 Editor - [actuarial]

BE X

@ File Edit Refactor Window iew

Bl A A X

~| 46 4% | m *F P

o]

S [EN#. actuarial

+.3%1 [Constructors]

+ Sfil [DfnS]
w3 [Fields]
.45 [Methaods]

@

+-41 [Nested Classes]
+-%% [Nested Namespaces]
359 [Froperties]
-3 [Sections]

T Main

B MenuHandlers

B 0ldCode
B Utilities
i

Yalidation

Modified Class

[o]
[1]
[2]
[3]
[4]
[5]
[6]
[7]
[a]
[9]
[10]

[o]
[1]
[2]
[2]
[4]
[5]

r-1

—EHMH

I
Lir

iClass actuarial:
tlsing System
tUsing System.Web.Ul,system.web.dll
ilzing System.Web.Ul.HtmlControls

tUzing System.Web.UIl.WebControls

tUzing System.Data,system.data.dll
tAccess Public

tiection Main
tSection MenuHandlers
tZection Walidation

Page

7 YALIDATE_AGE(source args) A Yal »
thAccess Public

tSignature YALIDATE_AGE Object

tTrap O

-

AGE+Convert.Tolnt32 args.¥a »

tElze

args. Is¥alid«0
tReturn

tEndTrap

args. Is¥alide«(10SABE) ~B0zAGE

v

7 YALIDATE_DUR(=zcurce args)l:DT A

tAccess Public

tSignature YALIDATE_DUR Object

tIf 2=GET_RUN_OPTION

DT+1
:Else

2% P

R

1l TA TRY AL

Fos: 0/1500,0

[

-
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Find and Replace Dialogs

The Find and Find/Replace dialog boxes are used to locate and modify text in an
Edit window.

-

Find f Replace
Search For: | j Find Hexst
Feplace With: | j Beplace
|+ tatch Case | Match ‘Whole ' ord feuia=gt)

[ Usze Regular Expressions

a1l

Direction
v Autokove Liose
© Up f" Down
Enter the text string that you want to find. Note that the
text from the last 10 searches is available from the drop-
Search For down list. If appropriate, the search text is copied from the

Find Objects tool. This makes it easy to first search for
functions containing a particular string, and then to locate
the string in the functions.

Enter the text string that you want to use as a replacement.
Replace With | Note that the text from the last 10 replacements is
available from the drop-down list.

Match Case Check this box if you want the search to be case-sensitive.

Match Whole | Check this box if you want the search to only match

Word whole words.
Use Regular Check this box if you want to use various wild card
Expressions symbols.

If checked, the Find or Find/Replace dialog box will
AutoMove automatically position itself so as not to obscure a matched

search string in the edit window.

Direction Select Up or Down to control the direction of search.
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Docking the Find/Replace Dialogs

You may dock the Find or Find/Replace dialog boxes in the Session window. If you
do so, they are displayed in a slightly abbreviated form, for economy of space. The
picture below illustrates the effect of docking the Find/Replace dialog box along the
top edge of the Session.

,ﬁ!C:\Dncuments and Settings\Pete\My Documents\Dyalog Apl 12.0 Unicode Files\buildsev1? - Dyalog APL/W - [BUILD_SESSION 3
& L yalog Ap yalog
File Edit View MWindows 3Zession Log Action Options Tools Threads Help
ws [) = 8 E 2] | Obect B B B ¥ b B2 @b | Tood O 33 M Edit By (& v Session [= [APL38EUnicads || 16—
LanguageBar =le1x| ﬁ 1 A A X - | a8 40
Fl ‘+‘7|x‘% G ‘ <[-T=[=] [+[4]= Fil | {NoPrompt }BUTLD_SESSTION LANG:OBI:MSG:TEXT:FILE:OI0;OML:OMA
= 0[&% ‘\, ‘ ‘“l R A M A Build the session object and save if desired 1
Find / Replace —lolx| OWX<DSE.OWE<1 < OML OI0<l ¢ OFATH+'#.Trans'

MOTIF«'M' =32t«", "OWG 'APLYersion’

Search For ‘classic\ j Find Next V121222o0VFI{ (T 1+wy ' Tt} 2ot

ClassicEditione~lUnicodeEdition«B0=0DR" "

Heglacewnh:‘ j Beplace LANB«upCase, LANG R translation sssumes uppercase
‘Unkonwn language OSIGNAL(Trans. CODESe¥cLANG) 411

international farmats like german, french or english. |m
7 Expunge MenuBar(s), StatusBar(s), ToalBar(s) and TipFiew
For example, to redefine the italian look try A and expunge OSE.WSDoc and OSE.NumEd
BUILD_SESSION 'IT' QBT+0WN'OSE"
QBJ+( (0B OWE"='Type')e'MenuBar' 'StatusBar' 'ToolBar' '»
You can also reset the SALT utility programs here by do 0BT, +'DSE.WSDoc' 'DSE.NumEd’ -
BUILD_DYALOGSPACE é MF£4+0RT
v| | £ e
< EY W Functian Last saved by: Pete: 07 January 2008 14:45 Fos: 6,6
Debugger 8lalx|
Ready. .. Ins [HUM
CurObj: ClassicEdition (Undefined) &:l apa:0  OTRAF  OsI:0 0OI0:1 [OML:Q
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Using Find and Replace

Find and Replace work on the concept of a current search string and a current
replace string which are entered using the Find and Find/Replace Dialog boxes.
These boxes also contain buttons for performing search/replace operations.

Suppose that you want to search through a function for references to the string
"Adam". It is probably best to work from the start of the function, so first position the
cursor there (by pressing Ctrl+Home). Then select Find from the Edit menu. The Find
Dialog box will appear on your screen with the input cursor positioned in the edit
box awaiting your input. Type "Adam" and click the Find Next button (or press
Return), and the cursor will locate the first occurrence. Clicking Find Next again will
locate the second occurrence. You can change the direction of the search by selecting
Up instead of Down. You could search another function for "Adam" by opening a
new Edit window for it and clicking Find Next. Y ou do not have to redefine the
search string.

Now let us suppose that you wish to replace all occurrences of "Adam" with
"Amanda". First select Replace from the Edit menu. This will cause the Find Dialog
box to be replaced by the Find/Replace Dialog box. Enter the string "Amanda" into
the box labelled Replace With, then click Replace All. All occurrences of "Adam" in
the current Edit window are changed to "Amanda". To repeat the same global change
in another function, simply open an edit window and click Replace All again. If
instead you only want to change particular instances of "Adam" to "Amanda" you
may use Find Next to locate the ones you want, and then Replace to make each
individual alteration.

Saving and Quitting

To save the function and terminate the edit, press Esc (EP) or select Exit from the File
menu. The new version of the function replaces the previous one (if any) and the edit
window is destroyed.

Alternatively, you can select Fix from the File menu. This fixes the new version of
the function in the workspace, but leaves the edit window open. Note that the history
is also retained, so you can subsequently undo some changes and fix the function
again.

To abandon the edit, press Shift+Esc (QT) or select Abort from the File menu. This
destroys the edit window but does not fix the function. The previous version (if any)
is unchanged.
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The Tracer

The Tracer is a visual debugging aid that allows you to step through an application
line by line. During a Trace you can track the path taken through your code, display
variables in edit windows and watch them change, skip forwards and backwards in a
function. You can cutback the stack to a calling function and use the Session and
Editor to experiment with and correct your code. The Tracer may be invoked in sev-
eral ways as discussed below.

Tracing an expression

Firstly, you may explicitly trace a function (strictly an expression) by typing an
expression then pressing Ctrl+Enter (TC) or by selecting Trace from the Action menu.
This lets you step through the execution of an expression from the beginning.

In the same way as when you execute a statement by pressing Enter, the expression is
(ifnecessary) copied down to the input line and then executed. However, if the
expression includes a reference to an unlocked defined function or operator,
execution halts at its first line and a Trace window containing the suspended func-
tion or operator is displayed on the screen. The cursor is positioned to the left of the
first line which is highlighted.

Naked Trace

The second way to invoke the Tracer is when you have a suspended function in the
State Indicator and you press Ctrl+Enter (TC) on the empty input line. This is termed
naked trace. The same thing can be achieved by selecting Trace from the Action
menu on the Session Window or by clicking the Trace button in the Trace Tools.
However, in ALL cases it is essential that the input cursor is on the empty Input line
in the Session.

The effect of naked trace is to open the Tracer and to position the cursor on the cur-
rently suspended line. It is exactly as if you had Traced to that point from the Input
Line expression whose execution caused the suspension.

Automatic Trace

The third way to invoke the Tracer is to have the system do it automatically for you
whenever an error occurs. This is achieved by setting the Show trace stack on error
option in the Trace/Edit tab of the Configuration dialog (Trace_on_error param-
eter). When an error occurs, the system will automatically deploy the Tracer. Note
that this means that when an error occurs, the Trace window will then receive the
input focus and not the Session window.
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Tracer Options

From Version 10.1 onwards, the Tracer is designed to be docked in the Session win-
dow.

In previous versions of Dyalog APL, the Tracer was implemented as a stack of sep-
arate windows (one per function on the calling stack) or as a single, but still separate,
window.

You can disable the standard behaviour by selecting Classic Dyalog mode from the
Trace/Edit tab of the Configuration dialog box.

Ifyou do so, you may then choose to have the Tracer operate in multiple windows or
in a single window.

These alternatives are discussed later in this Chapter.
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The Trace Window

The Tracer is implemented as a single dockable window that displays the function
that is currently being executed. There are two subsidiary information windows
which are also fully dockable. The first of these (SIStack) displays the current func-
tion calling stack; the second (Threads) displays a list of running threads.

In the default Session files, the Tracer is docked along the bottom edge of the Session
window. When you invoke the Tracer, it springs up as illustrated below. In this exam-
ple, the function being traced is [JSE . UCMD, which is invoked by typing a user-com-
mand, in this case Jdisplay.

5 CLEAR WS (cSE)- Dyalog APL/W =Jo&d
Tools  Wiew

fws [0 @ OF Gl 3] Gobject BB Es VOB b B2 @ 12 (700l @ G [ W CEdi BB 0 o4 Session
Language Bar P =1 .1 ﬂ
l|||||||E||\|||||f|l|||||¢||||||¢|||||||T\+|||U|4|T|||||\|||f’|\|"|*|-iJ

Dyalog APL/W Yersion 12.1.0
Serial Mo @ 0000LZ
Unicode Edition
Mon Aug 17 10:28:20 2009
clear ws

Idisplay v13

b

Debugger ~=lnlx]|
ST UM D S || o ﬁ UCMD[1]1#A User Command Processor.
o
[0] ar+{THISHICHMD Input i
[1] F User Command Frocessor.
[2] A Spice is used, see documentation for d »
[21
[4] +[Input~.=" "1/0 m do nothing?
[5] —
[&] "SALT needs to be enabled 'OSIGNAL 11p%9 » | 2
[7] ar+0SE. SALTUti1s.Spice Input E
x
= =
sl EAE =
Function johnd: 11/08)... Pos: 1/8,0 5] L
C o Ready... Ins  HUM
C Cur0bi: &:1 Op@:o  OTRAP  0Os5I:1 QOIO:1 [OML:0

In the default layout, the Sistack window is displayed alongside the main Tracer win-
dow, although this can be hidden or made to appear as a separate floating window, as
required.
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Trace Tools

The Tracer may be controlled from the keyboard, or by using the Trace Tools which
are arranged along the title bar of the Debugger window. Note that the button names
are solely for reference purposes in the description that follows.

Button Name

—
S

+

“

44

||

X

Exec

Trace

Back

Fwd

Restart

Restart all

Continue

Edit

Exit

Intr

Reset

Key s
D

Code Keystroke escription

ER Enter Executes the current line

TC Ctrl+Enter Traces execution of the current
line

BK  Ctrl+Shift+Bksp Skips back one line

FD  Ctrl+Shift+Enter Skips forward one line

RM -~[ILC Restarts execution of the current
thread, closing all its trace
windows

Restarts execution for all threads,
closing all trace windows

BH Continues execution of the current
thread, leaving Trace windows
displayed

ED Shift+Enter Invokes the Editor

EP Esc Closes the Trace window, exits

the current function

Ctrl+Pause Interrupts execution

CS Clears all break-points (resets
(STOP on every function)
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Using the Trace Tools, you can single-step through the function or operator by click-
ing the Exec and/or Trace buttons. If you click Exec the current line of the function or
operator is executed and the system halts at the next line. If you click Trace, the cur-
rent line is executed but any defined functions or operators referenced on that line are
themselves traced. After execution of the line the system again halts at the next one.
Using the keyboard, the same effect can be achieved by pressing Enter or Ctrl+Enter.

The illustration below shows the state of execution having clicked Exec 6 times to
reach JSE.UCMD[7].

S5 CLEAR WS (oSE)- Dyalog APLAW B[=[x]
Tools  Wiew

cws P E & iobjet B E S VE b ®FL ool @ 3 R M Edt By B« cx Session
Language Bar Zlelx| ﬁ
l|||||||E||\|||||f|l|||||¢||||||#|||||||\||||1|4>|‘*?|||||\|||/|\|||-'-1E

Dyalog APLAW Yersion 12.1.0
Serial Mo @ 0000LZ

Unicode Editiaon

Mon Aug 17 10:28:20 2009

clear ws
Jdisplay 113
e

Debugger =lalx|
SITHUDPDPEXNE ﬁ UCMD[71+ar<OSE. SALTUL i 1s.Spice Inp

o
[o] ar+{THISIUCMD Input 1
[1] f User Command Processor.
[2] A Spice is used, see documentation for d
[3]
[ul +(Input~.=' '1/0 A do nothing?
[5] —
[6] 'SALT needs to be enabled 'OSIGNAL 11p%9 » | <
[7] [ar+OSE.SALTUtils.Spice Input =

=
- | & =
idal BN £
Function johmd: 11/08)... Pos: 7j8,0 L] <] 3| W
¢ Ready... Ins  MUM
© Curobj: g1 Oba:o | OTRAP  OSI:1  OIO:1  OML:0

Execution Reached JSE .UCMD[ 7]

The next illustration shows the result of clicking Trace at this point. This caused the
system to trace into JSE .SaltUtils.Spice, the function called from
OSE.uCMD[7].

Notice how each function call on the stack is represented by an item in the Sistack
window.
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55 CLEAR WS (oSE.SALTUtils)- Dyalog APLAW (=[]
Tools  Wiew
fws [0 @ OF bl 3] Gobject BB Es VOB b B2 @ 12 (700 @ B [ W CEdi By B 0 o4 Session
Language Bar P =1 .1 ﬂ

l||||||IEII\|||||f|l|||||¢||||||¢|||||||+\+||IDI‘#I#’IIIII\III?I\I*‘I*I-
Dyalog APL/W Yersion 12.1.0
Serial Mo @ 0000LZ
Unicode Edition
Mon Aug 17 10:28:20 2009
clear ws
ldisplay 1.3

o]
Debugger ~=lnlx]|
SFHUMW D P DPEXXIN K X|| spice[1]+n Handle KeyPress in SPIC
1281 A - ﬂ UCMD[ 7] ar+0SE.SALTUti1s.3pice Inp
[29] Lv =
[o] 7 {R}<Spice msgicmdiargslistiiscifin ®
[1] F Handle KeyPress in SPICE command w
[21 A The function can also be used dire » —
[3] R+T1 =
[4] tIf ~Quiet<isChar cmdemsg now E
[5] +04%"ER'=32msg A Ente » |
el crmde' T e lh( 19mealMWE Tavt ' A oarabh el O .
< > = £
Function johnd: 11f08)... Paos: 40/360,0 28] ( | W
C o Ready. .. Ins  HUM
Curlbj: &:1 Opg:o  OTRAP | OsI:2 0OI0:=1  [OML:3

Execution Reached JSE . SALTUtils.Spice [1]
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The illustration below shows the state of execution having traced deeper into the sys-
tem.

S CLEAR WS (5SE.SALT)- Dyalog APLAY =JoJ&d

File Edit Wew “Windows Session Log Action ©Options Tools Threads Help

tws ) @ O bl 3] Gobject BB Es VOB b 2 @ 1 (Too @ G [ W ed By B o o Session

Language Bar e x| ﬁ

[ [x[elle[Blelt]?) [(U]r] [Felel<Rlel=le] [P (e[ [l [ a
ldisplay 1.3 ”~
1si b |

OSE.SALT.Load[1]1+
OSE.SALTUti1s.BootSpicel[17]
OSE.SALTUti1s. Spicel18]
OSE.UCMD[7]

]
Debugger =lalx|

3%’« » D ’ D =z XN ﬂ (=l Load[1]+:Access Shared Public
[16] LPEF*‘ﬂ.DNEH(LUad cmd) ,hasargs/cargs - BootSpicel[17] OSE.SALT.Load SALTHP

l=lz|x

[17] 7 b | Spicel[18] :If 0=0NC'OSE.cbbot.band
= UCMD[ 7] ar+0SE.SALTUti1s.3pice Inp
[0] 7 {reF}+{protect}Load clazs:filezaTA »

[1] fAccess shared Public

[2] A This function returns either a ref » —

[3] fi or a message for anything else (fa® =

[4] tIf isHelp class E

[5] ref<'Load [pathlclassname’ '' 'Load » |

a1 ref. ' 'Madifiere:’ |t = s
> = =]

Mamespace Pos: 118/672,0 =] ( ) w

¢ Ready... Ins NUM

C Cur0bi: &:1 Op@:o  OTRAP | OSI:4  Q0OIO:=1 [OML:2

Execution reached four levels deep

At this stage, the State Indicator is as follows:

)SI
OSE.SALT.Load[1]x*
OSE.SALTUtils.BootSpice[17]
OSE.SALTUtils.Spice[18]
OSe.ucMp[ 7]
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Controlling Execution

The point of execution may be moved by clicking the Back and Fwd buttons in the
Trace Tools window or, using the keyboard, by pressing Ctrl+Shift+Bksp and
Ctrl+Shift+Enter. Notice however that these buttons do not themselves change the
State Indicator or the display in the SIStack window. This happens only when you
restart execution from the new point.

You can cut back the stack by clicking the <EP> button in the Trace Tools window.
This causes execution to be suspended at the start of the line which was previously
traced. The same effect can be achieved using the keyboard by pressing Esc. It can
also be done by selecting Exit from the File menu on the Trace Window or by select-
ing Close from its system menu.

The <RM> button removes the Trace window and resumes execution. The same is
achieved by the expression »~[JL C. The <BH> button also continues execution, but
leaves the Trace window displayed and allows you to watch its progress.

Using the Session and the Editor

Whilst using the Tracer you can skip to the Session or to any Edit window and back
again. While it is docked, you may resize the Tracer pane by dragging its title bar,
and you may use the buttons provided to maximise, minimise and restore the Tracer
pane within the Session window.

Unless you move it sideways, the cursor is positioned to the left of the suspended
line in the top Trace window. If you press Shift+Enter (ED) with the cursor in this
position, the trace window becomes an edit window allowing you to edit the func-
tion or operator on top of the stack. You can achieve the same thing by selecting Edit
from the File menu, but the input cursor MUST again be in the left-most (empty) col-
umn, or the system will attempt to open an edit window for the name under the cursor
(point-and-edit).

When you finish editing, the window reverts to a trace window with the new def-
inition of the function or operator displayed.

You may also open a new edit window from within the Tracer using point-and-edit.

You can copy text from a trace window to the session for editing and execution or for
experimentation.

It is possible to skip from the Tracer to the Session and then re-invoke the Tracer on a
different expression.
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Setting Break-Points

Break-points are defined by JSTOP and may be toggled on and offin an Edit or
Trace window by clicking in the appropriate column. The example below illustrates
a function with a JSTOP break-point set on line [5].

~ -1
S Editor - [BUILD_SESSION] =Jo/&3
S Bl Edit Refactor Vindow View _ 8 =
A A X ~|db AL *m *F *p

[0] [ {FILEFBUTLD_SESSION LANG3O0BI;MSG3OI0:0ML:OLD: NEWIMOTIF »[a)
[1] A Build the session object and save if desired L]
[2] :If 0=0HC'HoPrompt' ¢ NoPrompt+0 ¢ :EndIf

[3] :If 0=0ONC'FILE' 4 FILE+'' % :EndIf

[L]

[5] L] OWg+0%E.OWs+1 < OML OI0<1 < OPATH+'#.Trans'

[&8] OPW+122 A allows room for Status Bar

[7] MOTIF+'M'=32t+" . '"OWG"'APLYersian’

[2] W12e12<2o0VFI{ (T 1+w ', "1 tw} 2ot

[3] LANG+upCase, LANG A translation assumes uppercase

[10] UMICODE<80=0ODR" '

[111] "Unkonwn Tanguage 'OSIGHAL(Trans.CODESe™cLANGY+LL w|
<] 2]
Maodified Funckion Last saved by: Danb: 19 May 2009 11:42 Pos: 0f207,0

[STOP break-points set or cleared in an Edit window are not established until the
function is fixed. JSTOP break-points set or cleared in a Trace window are estab-
lished immediately.

Clearing All Break-Points
jadl

You can clear all break-points by pressing the above button in the Trace Tools win-
dow. This in fact resets JSTOP for all functions in the workspace.
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The Classic mode Tracer

If you select Classic Dyalog mode from the Trace/Edit tab in the Configuration
dialog box, the Tracer behaves in the same way as in Dyalog APL Version 8.2. How-
ever, the Tracer is not dockable in the Session.

If you select the Classic mode Tracer, you may choose between multiple trace win-
dows or a single trace window using the Single Trace Window option.

Multiple Trace Windows

The following behaviour is obtained by deselecting the Single Trace Window
option.

Each function on the SI stack is represented by a separate trace window.
The top window contains the function that is currently executing, other win-
dows display functions further up the stack, in the order in which they were
called.

When you press Ctrl+Enter or click the Trace button on a line that calls
another function, a new trace window appears on top of the stack and dis-
plays the newly called function.

When a function exits, its trace window disappears and the focus moves to
the previous trace window. When the last function in a traced suspension
exits, the last trace window disappears.

If you click the Quit this function button in the Trace Tools window, or
press Escape, or close the trace window by clicking on its [X] button or typ-
ing Alt-F4, the top trace window disappears and the focus moves to the pre-
vious trace window

If you close any of the trace windows further down the stack, the stack will
be cut back to the corresponding point, i.e. to the line of code that called
the function whose trace window you closed.

The <RM> button removes all the trace windows and resumes execution.
The same is achieved by the expression »[JLC. The <CS> button also con-
tinues execution, but leaves the trace windows displayed and allows you to
watch their progress.

If you minimise any of the trace windows, the entire stack is minimised to a
single icon, from which it may be restored.
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Single Trace Window

The following behaviour is obtained by selecting the Single Trace Window option.

The trace window contains a combo box whose drop-down displays the con-
tents of the SI stack. This box is not provided if there are multiple trace win-
dows.

The trace window is re-used when tracing into, or returning from, a called
function. This means that there is never more than one trace window
present.

When the last function in a traced suspension exits, the trace window dis-
appears.

If you click the Quit this function button in the Trace Tools window, or
press Escape, the current function is removed from the stack and the trace
window reused to display the calling function if there is one.

Closing the trace window by clicking on its [X] button or typing Alt-F4
removes the window and clears the current suspension. It is equivalent to
typing naked branch (=) in the session window.

If you move or resize the trace window, APL remembers its position, so that
it reappears in the same position when next used.
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The Threads Tool

The Threads Tool is used to monitor and debug multi-threaded applications. To dis-
play the Threads Tool, select Show Threads Tool from the Session Threads menu, or
Threads from the Session pop-up menu.

ﬁThreads E]@
Tid Location State Flags | Treq | 21002
0: Run =RUNCE3] OTGET... Session Mormal ﬂ g
1: GUI SHOHCZ2] ODR'F* oo Paused
2: Lift 1 GOTOC10]1 ODL .2 ODL Paused :

J: Lift 2 GOTOC10]1 ODL .2 ODL Paused c
5: Man & PER=OMLC?] OTG... OTGET... Paused 52 =
6: Lady & PERSOWL?] OTG... OTGET... Paused 12 =
7: Man 7 PERSOMC4] Lif... OTGET... Paused 2 B
B: Lady & PERZOWLC4]1 Lif... OTGET... Paused 2 E
¢ 2l &

The above picture illustrates a situation using the LIFT.DWS workspace after execut-
ing the function RUN. The Pause on Error option was enabled and a Stop was set on
RUN[63]. When RUN suspended at this point, all other threads (1-8) were auto-
matically Paused. Note that all other threads happen to be Paused in the middle of
calls to system functions

The columns of the Threads Tool display the following information.

Column Description

Tid The Thread ID (OTID) and name (OTNAME) if set
Location The currently executing line of function code
State Indicates what the thread is doing. (see below)
Flags Normal or Paused.

Treq The Thread Requirements (OTREQ)
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Thread States
State Description
Pending Not yet running
Initializing Not yet running

Defined function

Between lines of a defined function

Dynamic function

Between lines of a dynamic function

Indicates that the thread is suspended and is able to

Suspended accept input from the Session window.
. Indicates that Session window is connected to this
Session
thread.
Indicates that the thread has no SI stack and the
(no stack) Session is connected to another thread. This state can
only occur for Thread 0.
Exiting About to be terminated
:Hold Waiting fora :Hold token
:EndHold Waiting for a : Hold token
doL Executing DL
0oQ Executing [IDQ
ONA Waiting for a DLL (0NA) call to return.
OTGET Executing OTGET, waiting for a token
OTGET

(Ready to continue)

Executing TGET, having got a token

OTSYNC

Waiting for another thread to terminate

Awaiting request

Indicates a thread that is associated with a NET system

thread, but is currently unused

Called Net

Waiting for a call to .NET to return.

Paused/Normal

In addition to the thread state as described above, a thread may be Paused or Normal
as shown in the Flags column. A Paused thread is one that has temporarily been
removed from the list of threads that are being scheduled by the thread scheduler. A
Paused thread is effectively frozen.
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Threads Tool Pop-Up Menu

Switch bo
Interrupk

Refresh Mow
v ko Refresh

v Pause Threads an Errar

v Paused
Pause &l
Resume Al
Restart All
Selecting this item causes APL to attempt to suspend
Switch to (if necessary) and switch to the selected thread,

connecting it to the Session and Debugger windows.

Refresh Now

Refreshes the Threads Tool display to show the current
position and state of each thread.

Auto Refresh

Selecting this item causes the Threads Tool to be
updated continuously, so that it shows the latest
position and state of each thread.

Pause Threads on

If this item is checked, APL automatically Pauses all
other threads when a thread suspends due to an error or

Error .
an 1nterrupt.
This item toggles a thread between being Paused and
Paused Normal. It Pauses a Normal thread and resumes a
Paused thread.
Pause All This item causes all threads to be Paused.
Resume All This item resumes all threads.
Restart All This item resumes all Paused threads, restarts all

suspended threads, and closes the Debugger.
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Debugging Threads

The Debugger provides a tabbed interface that allows you to easily switch between
suspended threads for debugging purposes. To keep things simple for non-threaded
applications, Tabs are only displayed if there is a thread suspended that is other than
Thread 0. The following picture shows the Debugger open on a multi-threaded appli-
cation (LIFT.DWS) when only Thread 0 is suspended. This has been achieved by set-
ting a stop on RUN[63]

B C:\Program Files\Dyalog\Dyalog APL 12.1 Unicodetwshlift - Dyalog APL/W =]
File Edt View Windows Session Log Action Options Tools Threads Help

ws 08 E Y obet BB Es T b B2 @ k5 Tool @ G B Cedi By (B o cx session (B [APLIBS Unicode [ w|[ 1672

Language Bar Bl =T a
LR (L FE=RFEER [ RRR] [[o[ol<]-] [l [FEL] ol Pl [ & =
Serial No @ 0000K2 -
Unicode Edition

Mon Aug 17 11120128 2008

clear ws

C:\Program Files‘DyalogiDyalog AFL 12.1 Unicodetwshlift saved Wed Mar 11 11:17:02 2009

Lift simulation designed to |1lustrate multi-threading

and thread synchronisation, using the Token Poal.
To run it:

RUN 20 m Simulate 20 arrivals

RUN 5
RUNL63]
~
Debugger =T
TSHTUM DY PEXIN H v |08 @0 [RUNLE3T+OTBET 2|+ ﬁ RUN[631+OTGET 2pJobDone A Wy
OTGET GUIReady al| Ol
F.LIFTL F.LIFT2 LIFT&"cFLOORS CAPACITY m Start Lift threads
tFor I :ln 2 A Start <H= people threads
PERSONEFLOORS =
ObL 0.2x710  Simulate random(ish) arrival E
:EndFor
OTPUT AllDone A Tell Lifts "that’s it" =
[[OTGET 2pIobDone R Wait until Lifts have finished delivering men Z
OTKILL OTHUMS  Zap any threads =1
vl 5 .
2 5
<] > 2 2
Function Last saved by: Dyalog: 09 July 2004 08136 Pos: 63/65,0 [Nvs > w

Ready... Ins  NUM

CurObj: RUN (Function) &8 Opa:o  OTRAP  0OS1:1  0OI0:1  OML:0
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In the next picture, the user has chosen to display the Threads Tool and then dock it
between the Session and Debugger windows. Note that only one thread, thread 0

(Run) is suspended. All the other threads are Paused (because Pause on Error is ena-
bled).

JB C:\Program Files\Dyalog\Dyalog APL 12.1 Unicodewsilift - Dyalog APL/W =]
Fle Edt Vew MWindows Session Log Action Options Tock Theads Help
wi D EORE Y obiex BB Y V bh b2 @ = Tool @G R G Ede ¥ Ca  Session [ |APL3ES Unicode | w|[ 1B
Language Bar i =11 ﬁ
[LLELeERrT) O] =R (=[] [e[2[]=]-] [[Te[#fel] [FELL] o[n[fule]ee] [o] = | @
RUN 5 -~
RUN[E3]
v
Threads Zlalx|
Tid Locatian State Flags | Treq
0: Run +RUNL63] OTGET ZpJobbane A Wai... Session Harmal
1: BUI sHoW[22] ODQ'F' ona Paused
2: Lift 1 GOTO[10] ODL 0.2 onL Paused
3: Lift 2 GOTO[10] ODL 0.2 onL Paused
S: Man 5 PERSON[7] OTGET Lift REACHED MYFLO... OTGET (Ready to continue) Faused b1
6: Lady 6 PERSON[7] OTGET Lift REACHED MYFLO... OTGET (Ready to continue) Faused b2
7t Man 7 PERSON[L] Lift<OTGET Goinglp ... OTGET (Ready to continue) Paused 2
8: Lady 8 PERSON[4] Lift<OTGET Goinglp ... OTGET (Ready to continue) Paused 2
Debugger _-lol x|
SHFUP D P PEZEXN H v| b @ |[runTe31+0TRET 2[v] E RUN[631+OTGET 2pTobDone i Wa
[561 7 [ OTBET BUIReady Al
1571 F.LIFTL F.LIFT2 LIFT&"cFLOORS CAPACITY m Start Lift threads
[58] tFor I :ln N A Start <N= people threads -
[59] PERSON&FLOORS 5
[60] ObL 0.2x710 A Simulate random(ish) arrival =
[611 :EndFar s
[62] OTPUT AllDane A Tell Lifts "that’s it" b=
[63] OTGET ZplobDone R Wait until Lifts have finished delivering men E
[66] L1 OTKILL OTNUMS f Zap any threads v|| % _
- 2 5
< > g 2
Function Last saved by: Dyalog: 09 July 2004 05:36 Pos: 63/65,0 T ¢ 3| w
Ready... Ins  NUM
CurGbj: RUN (Function) 2:8 O0Q:0  OTRAP  OSI:l  OI0:1  OML:0
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The user then uses the context menu to Switch To Thread 6 (whose name is Lady 6)
which was Paused on PERSON[ 7] in the middle of a[JTGET. The act of switching
to this thread caused it to be suspended at the beginning of its current line
PERSON[7] and the Debugger now displays two Tabs to represent the two sus-

pended threads. Note that both the thread id and the thread name are displayed on the
Tabs.

JB C:\Program Files\Dyalog\Dyalog APL 12.1 Unicodewsilift - Dyalog APL/W =]
Ble Edi View Windows Sesson Leg Action Options Tools Theeads Hel
wi D EORE Y obiex BB Y V bh b2 @ = Tool @G R G Ede ¥ Ca  Session [ |APL3ES Unicode | w|[ 1B

Language Bar i =11 ?

= |
[IERefERlT) DU (=Rl (IO [v]ef]o[=[] [[efe[tlele] [TFELL] [loef] [llefalle] [o] &) 2
=

MYFLOOR
"
M
Threads Zlalx|
Tid Location State Flags | Treq
0 Run  +RUN[63] OTGET 2elobbene A Wai... Suspended Paused
1: BUI SHOW[22] O0Q'F oog Paused
2: Lift 1 GOTO[10] ODL 0.2 ooL Paused
3: Lift 2 GOTO[10] ODL 0.2 ooL Paused
S5: Man 5 FERSON[7] OTBET Lift REACHED MYFLO... OTGET (Ready to continuel Paused b1
6: Lady 6 +PERSON[7] OTBET Lift REACHED MYFLO... Sessian Normal
7t Man 7 FERSON[W] Lift<OTGET Goingllp .. DOTGET (Ready to continue) Paused 2
8: Lady B FERSON[4] Lift<OTGET Goingllp ... OTGET (Ready to continue) Paussd 2
Debugger =lol=l
0: Run| 6 Lady 6 ﬂ PERSONL7]+OTGET Lift REACHED MYFL
n
STUMW PP PEXNRAE ~| 0% 8 | PERSONI71+OTEE |~ | 1
5] ARRIVE W Arrive at 11Ft shaft ~l| =
[u] Li ftOTGET Goinglp A Wait for 1ift door to be open/fres z
[s] Lift BETIN MYFLOOR<?FLOORS A Get inta the Lift, tell the 1ift where 17 » ||| §
[6] MYFLOOR OTPUT Lift.ID+ManIn A Clear the Lift door For next person pri
[71 OTGET Lift REAGHED MYFLOOR A Wait for ITft to reach my Floor =
[81 Lift GETOUT MYFLOOR A De-Lift =
[l OTRUT Lift.I1D+ManOut A Tell Lift I’m out, thread ends v | F
< 2 |8 g
= 2
Function Last saved by: Dyalog: 02 Jly 2004 13:28 Pos: 7/10,0 T e 5 i
Ready... Ins  NUM
CurObj: MYFLOOR (Variable) 2:8  Opaso OTRAP  Os1:2  OI0:l [OML:o

Note also that the Session window is connected to the thread indicated by the
selected Tab. In this case, typing MYF LOOR into the Session window displays the
value of the local variable MYFLOOR in Thread 6 (Lady 6).
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You can use the Tabs to switch between the suspended threads, so clicking the Tab
labelled 0 : Run causes the display to change to the picture shown below. The Ses-
sion is now connected to Thread 0 (Run), so the value of [JLC is 63.

JB C:\Program Files\Dyalog\Dyalog APL 12.1 Unicodewsilift - Dyalog APL/W =]
File Edit View ‘Windows Session Log Action Options Tools Threads Help

wi D EORE Y obiex BB Y V bh b2 @ = Tool @G R G Ede ¥ Ca  Session [ |APL3ES Unicode | w|[ 1B

Language Bar i =11 ﬁ
[LLELeERrT) O] =R (=[] [e[2[]=]-] [[Tel#lel] PEELL] ool [olnflelele] [o] &) @
[\ -~
63
M
Threads Zlalx|
Tid Location State Flags | Treg
0: Run +RUNL63] OTGET ZpJobbane A Wai... Session Narmal
1: BUI SHOW[22] O0Q'F' oo Paused
2: Lift 1 GOTO[10] ODL 0.2 onL Paused
3: Lift 2 GOTO[10] ODL 0.2 onL Paused
S: Man 5 PERSON[7] OTGET Lift REACHED MYFLO... OTGET (Ready to continue) Faused b1
6: Lady 6 +PERSON[7] OTGET Lift REACHED MYFLO... Suspended Normal
7t Man 7 PERSON[L] Lift<OTGET Goinglp ... OTGET (Ready to continue) Paused 2
8: Lady & PERSON[4] Lift<OTRET GaingUp ... OTGET (Ready to continue) Paused 2
Debugger =lol=l
0: Run|g: Lady 6 ﬂ RUN(631+OTGET 2pTobDone A Wy
o
STUMW PP PEXNRAE ~| 0% 8 [RunLes]-OTGeT |~ | 1
[56] OTGET GUIReady ~
1571 F.LIFT! F.LIFTZ LIFT&"=FLOORS CAPACITY m Start Lift threads =
[58] iFor 1 iln N A Start <N> people threads &z
[59] PERSON&FLOORS P
[60] 0oL 0.2x710 A Simulate random(ish) arrival =
[61] tEndFor || =
[62] OTPUT AllDane A Tell Lifts "that’s it" v | =
<] 2 || 8 g
2 2
Function Last saved by: Dyalog: 09 July 2004 08:36 Pos: 63/65,0 o ¢ 5 i
Ready. .. Ins  NUM

CurObj: MYFLOOR (Variablel &8 gpg:o  OTRAP  [OST1:1  Q0OI0:1  [OML:0
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The Event Viewer

The Event Viewer can be used to monitor events on Dyalog APL GUI objects. To dis-
play the Event Viewer, select Event Viewer from the Session Tools menu.

You can choose:

e which types of events you want to monitor
e which objects you want to monitor

S Event Viewer
Spy  Columns  Select  Options
Object | EwventMamns | Parameters | Action | EventlD |
#F GotFocus 0 55
#F Mousellp 45.05205206 251 0 0 53
#F MouseDblChck 4505208206 251 0 0 B0
#F Mousellp 45.05205206 251 0 0 E1
®F Configure 11.58854198 2832012, #FOO 62
#F Configure 11.58854198 2.832012...  #FOO 64
#F Configure 11.58854198 2832012, #FOO EE
#F Configure 11.58854198 2832012, #FOO =t
®F Configure 11.58854198 2832012, #FOO 70
#F Configure 11.58854198 2.832012...  #FOO 72
#F Configure 11.58854198 2832012, #FOO 74
#F Configure 11.58854198 2832012, #FOO 7&
®F Configure 11.58854198 2832012, #FOO 78
#F Configure 11.58854198 2.832012...  #FOO an
#F LostFocus 0 a2

In the example illustrated above, the user has chosen to monitor events on a Form
# . F. Furthermore, the user has chosen to monitor GotFocus, LostFocus, MouseUp,
MouseDblIClick and Configure events. Notice that there is a callback #. FOO
attached to the Configure event.
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The Spy Menu

Close
Clear

= 4
As Queued
anapshiok

Skop Logging

The Spy menu, illustrated above, provides the following options and actions.

Close: Closes the Event Viewer

Clears all of the event information that is currently

Clear: displayed in the Event Viewer.

In this mode all the events are displayed in the Event
All: Viewer as they occur, whether or not there is an action
associated with them.

In this mode only events that have associated actions
are displayed in the event viewer. Note that KeyPress

A :
s Queued events are always queued and therefore always appear,
even if there is no associated action.
In this mode the Event Viewer displays a snapshot of
SnapShot: the internal event queue. Only those events that are

currently in the internal APL event queue waiting to be
processed are displayed.

Stop Logging: When checked, this item switches event logging off.
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The Columns Menu

W

Object
Ewventiarme
EventMurnber
Parameters
Ackion
ThreadID
MQed
EventID

The Columns menu allows you to choose which information is displayed for the
events you are monitoring.

Object

If checked, this item displays the name of the object on
which the event occurred.

Event Name

If checked, this item displays the name of the event
that occurred.

Event Number

If checked, this item displays the event number of the
event that occurred.

If checked, this item displays the parameters for the

Parameters event that occurred. These are the items that would be
passed in the argument to a callback function.
If checked, this item displays the action associated
Action with the event, for example the name of a callback
function, or an expression to be executed.
If checked, this item displays the thread id of the
Thread ID thread in which the event occurred
If checked, this item displays 0 or 1 according to
Nqed whether or not the event occurred naturally or was
generated programmatically by [NQ.
Event ID If checked, this item displays the event id of the event

that occurred. This id is used internally.
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The Select Menu

Select Matching Events
Select All Events On This Objeck
Select All Events OF This Type

The Select menu allows you to highlight certain events in the Event Viewer. For
example, if you are monitoring TCP/IP events on a number of TCPSockets, you can
highlight just the events for a particular socket.

Highlights all the events that have the same Object and
Event Name (or Event Number) as the currently
selected event.

Select Matching
Events

Select All Events | Highlights all the events that have the same Object as
On This Object the currently selected event.

Highlights all the events that have the same Event
Name (or Event Number) as the currently selected
event

Select All Events
Of This Type

These items are also available from the pop-up menu that appears when you press the
right mouse button over an event displayed in the Event Viewer window.

The Options Menu

v Always on Top
v Use aFL Fonkt

Settings...

The Options menu allows you to choose which information is displayed for the
events you are monitoring.

If checked, this item causes the Event Viewer window
Always on Top to be displayed above all other windows (including
other application windows).

If checked, this item causes the information displayed
in the Event Viewer window to be displayed using the
Use APL font APL font (the same font as is used in the Session
window). If not, the system uses the appropriate
Windows font.

Settings... Displays the Event Viewer Options Dialog Box.
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Options Dialog Box

The Event Viewer Options dialog box allows you to select the objects and events
that you wish to monitor.

-

Event Viewer Options
Optionz l
Events to wiew: Objects to view:
Name [ D[~ FindTot G Select From List..
Mouzellown 1
Mouzellp 2 Mame:
W ouzebd ove 3
i ouzeClick, 4 Type:
touseDbIClick 3
touzeE nker g .
Mouzel eave 7 ThreadiD:
F ouzetheel g
DiragQiver 10 Handle:
DragDrop 1Al
DragStart 12 p
Craglistbove 15 M Pt Elh
DraglistCopy 16 ) .
K.eyD own a0 I Child Objects
Keylp 21
KeyPress 22 | Same Thread
K.eyE rror 23 ™)
Inwert Select Al Do A
B event(z) zelected ;
)4 | Canhicel |

Events to view

The list box shows all the events that are support by the Dyalog APL GUI and allows
you to select which events are to be monitored. Only those events that are selected
will be reported. You can sort the events by name or by event number by clicking the
appropriate column header.
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Objects to view

All Objects

If checked, this item enables event reporting on all
Dyalog APL GUI objects.

Objects of Type

If checked, this item activates the adjoining Select
button and disables all other Object selection
mechanisms. Clicking the Select button brings up a
dialog box that allows you to choose which types of
Dyalog APL GUI objects you want to monitor.

Find Tool

This tool allows you to choose a single specific
Dyalog APL GUI object that you want to monitor. To
use it, drag the Find Tool and move it over your
Dyalog APL GUI objects. As you drag it, the
individual objects are highlighted and their details
displayed in the Name, Type, Thread ID and Handle

fields. Drop the Find Tool on the object of your choice.

Select

Clicking this button brings up a dialog box that
displays the entire Dyalog APL GUI structure as a tree
view. You can choose a single object by selecting it.
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The Session Object

Purpose: The Session object [JSE is a special system object that represents
the session window and acts as a parent for the session menus,
tool bar(s) and status bar.

Children Form, MenuBar, Menu, MsgBox, Font, FileBox, Printer, Bitmap,
Icon, Cursor, Clipboard, Locator, Timer, Metafile, ToolBar,
StatusBar, TipField, TabBar, ImageList, PropertySheet, OLEClient,
TCPSocket, CoolBar, ToolControl, BrowseBox

Properties  Type, Caption, Posn, Size, File, Coord, State, Event, FontObyj,
YRange, XRange, Data, TextSize, Handle, HintObj, TipObyj,
CurObj, CurPos, CurSpace, Log, Input, Popup, RadiusMode,
MethodList, ChildList, EventList, PropList

Methods ChooseFont, FileRead, FileWrite
Events Close, Create, FontOK, FontCancel, WorkspaceLoaded

Description

There is one (and only one) object of type Session and it is called JSE. You may use
OWG, OWS and [OWN to perform operations on [JSE, but you cannot expunge it with
OE X nor can you recreate it using OWC. You may however expunge all its children.
This will result in a bare session with no menu bar, tool bar or status bar.

[SE is loaded from a session file when APL starts. The name of the session file is
specified by the session_file parameter. If no session file is defined, JSE will have no
children and the session will be devoid of menu bar, tool bar and status bar com-
ponents.

You may use all of the standard GUI system functions to build or configure the com-
ponents of the Session to your own requirements. You may also control the Session
by changing certain of its properties.

Note that the Session reports a Create event when APL is first started, and a Work-
spaceLoaded event when a workspace is loaded or on a clear ws.
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Read-Only Properties
The following properties of [JSE are read-only and may not be set using [JWS:
Type A character vector containing 'Session'
. A character vector containing the current caption in the title
Caption . .
bar of the Session window.
TextSize Reports the bounding rectangle for a text string. For a full
description, see TextSize in Object Reference.
A character vector containing the name of the current object.
CurObj This is the name under or immediately to the left of the input

cursor.

A 2-clement integer vector containing the position of the input
cursor (row and column number) in the session log. This is JI0
CurPos dependent. If IO is 1, and the cursor is positioned on the
character at the beginning of the first (top) line in the log,
CurPos is (1 1). IFQIO0 is 0, its value would be (0 0).

A character vector which identifies the namespace from which
the current expression was executed. If the system is not

CurSpace executing code, CurSpace is the current space and is equivalent
to the result of ' '[ONS ' '.
Handle The window handle of the Session window.

A vector of character vectors containing the most recent set of
Log lines (input statements and results) that are recorded in the
session log. The first element contains the top line in the log.

A vector of character vectors containing the most recent set of
Input input statements (lines that you have executed) contained in
the input history buffer.

A vector of character vectors containing the types of object that

ChildList .
can be created as a child of [JSE.
MethodList A vector of ch.aracter yectors containing the names of the
methods associated with [JSE.
. A vector of character vectors containing the names of the
EventList
events generated by [JSE
. A vector of character vectors containing the names of the
PropList

properties associated with [JSE.
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Read/Write Properties

The following properties of JSE may be changed using OWS:

Coord

Specifies the co-ordinate system for the session window.

Data

May be used to associate arbitrary data with the session object
OsSE.

Event

You may use this property to attach an expression or callback
function to the Create event or to user-defined events. A callback
attached to the Create event can be used to initialise the Session
when APL starts.

File

The full pathname of the session file that is associated with the
current session. This is the file name used when you save or load
the session by invoking the FileRead or FileWrite method.

FontObj

Specifies the APL font. In general, the FontObj property may
specify a font in terms of its face name, size, and so forth or it may
specify the name of a Font object. For applications, the latter
method is recommended as it will result in better management of
font resources. However, in the case of the Session object, it is
recommended that the former method be used.

HintObj

Specifies the name of the object in which hints are displayed.
Unless you specify HintObj individually for session components,
this object will be used to display the hints associated with all of
the menu items, buttons, and so forth in the session. The object
named by this property is also used to display the message
“Ready...” when APL is waiting for input.

Popup

A character vector that specifies the name of a popup menu to be
displayed when you click the right mouse button in a Session
window.

Posn

A 2-element numeric vector containing the position of the top-left
corner of the session window relative to the top-left comer of the
screen. This is reported and set in units specified by the Coord

property.

Size

A 2-element numeric vector containing the height and width of
the session window expressed in units specified by the Coord

property.
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An integer that specifies the window state (O=normal,
I=minimised, 2=maximised). You may wish to use this property to
State minimise and later restore the session under program control. If
you save your session with State set to 2, your APL session will
start off maximised.

Specifies the name of the object in which tips are displayed.
Unless you specify TipObj individually for session components,
this object will be used to display the tips associated with all of
the menu items, buttons, and so forth in the session.

TipObj

XRange | See Object Reference

YRange | See Object Reference

Configuring the Session

As supplied, your default session will have a menu bar, a tool bar and a status bar.
There are many ways in which you may configure this set-up, including the fol-
lowing:

You may select a different APL font or character size.

Y ou may alter the appearance of the menus by changing the Caption properties of the
various Menu and Menultem objects. For example, you may prefer the menus to
appear in your own language.

You may alter the structure of the menus. For example, you may wish to create a
Search menu directly on the menu bar rather than having Find and Replace as part of
the Edit menu.

You may add new Menu and Menultem objects to the menu bar, or new Button
objects to the tool bar, that execute APL functions or expressions for you. You can
store the code inside the [JSE namespace so that it is remains available when you
switch from one workspace to another.

You may add other objects to the tool bar to allow you to provide input for your func-
tions or to display output. For example, you may display a Combo object that offers
you a selection of names applicable to a particular task.

Y ou may add additional toolbars.

You may remove objects too; for example, you can remove fields from the StatusBar
or even delete it entirely. Indeed, you may dispense with the menu bar and/or tool bar
as well.
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This section illustrates how you can configure your session using worked examples.
The examples are by no means exhaustive, but are designed to demonstrate the prin-
ciples. Please note that the structure and names of the objects used in these examples
may not be identical to your default session as supplied. Before you attempt to
change your session, please check the structure and the object names using JWN and
[OWG. The supplied session was created using the function BUILD SESSION in the
workspace BUILDSE. If you wish to make substantial changes to your session, you
may find it most convenient to edit the functions in this workspace, re-run BUILD _
SESSION, and then save it.

Please note that these examples assume that Expose Session Properties is enabled.

Changing the Font

The APL session font is defined by the Font property of JSE. To change the font per-
manently, you should select a different Font and/or size of Font using the combo and
spinner boxes on the Session toolbar, and save your Session.

Classic Edition is distributed with bitmap fonts suitable for use on your screen, and
TrueType fonts for your printer. You can use the TrueType font on the screen, but it
is less attractive than the bitmap fonts at low resolutions. The bitmap fonts come in
two sizes (16 x 8 and 22 x 11) and two weights (normal and bold). You may select
other sizes, so long as the height is a multiple of 16 or 22. The scaling is performed
automatically by Windows.

Changing Menu Appearance

The name of the Session MenuBar is ISE . mb'. To simplify the specification of
object names, we will first change space to the MenuBar itself:

)CS [OSE.mb
0OSE.mb

The names of the Menu objects owned by the MenuBar are given by the expression:

‘Menu' [OWN "'
file edit view windows session Llog action options
tools help

The current caption on the file menu is:

file.Caption
&File

To change the Caption to Workspace:
file.Caption«'Workspace'
To change the colour of the New option in the File menu to red:

file.clear.FCol«255 0 O
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Reorganising the Menu Structure

This example shows how you may alter the structure of the session menus by adding
a Search menu to the menu bar to provide access to the Find and Find/Replace
dialog boxes and removing these options from the Edit menu.

To simplify the process, we will first change space into the MenuBar object itself:

)CS [SE.mb
(SE.mb

Then we can begin by adding the Search menu. You can specify where the new
menu is to be added using its Posn property. In this case, Search will be added at posi-
tion 3 (after Edit).

'search'[JWC 'Menu' '&Search' 3

Next we will remove the Find and Replace Menultem objects from the Edit menu.
Their names can be obtained from [JWN:

‘MenuItem'0WN'edit'
edit.prev edit.next wedit.clear edit.copy edit.paste
edit.find edit.replace

It is worth noting that these Menultems perform their actions because their Event
property is set to execute the system operations [Find] and [Replace] respec-
tively when they are selected.

edit.find.Event
Select [Find]

edit.replace.Event
Select [Replace]

The following statement removes them from the Edit menu:
OEX"'edit.find' 'edit.replace'’
and the following statements add them to the Search menu:

'search.find' OWC 'Menultem' '&Find'
('Event' 'Select' '[Find]')
‘search.replace' [OWC 'Menultem' '&Replace’
('Event' 'Select' '[Replacel]')

Adding your own Menultem

This example shows how you can add a menu item that executes an APL expression.
In this case we will do something very simple; namely add a Time option to the
Tools menu which will execute [JTS. Notice that the statement also defines a Hint.
This will be displayed when you select the option, prior to releasing the mouse but-
ton to action it.



Chapter 2: The APL Environment 267

Once again, we will start by changing space into the Tools menu itself

)CS [SE.mb.tools
OSE.mb.tools

Then we will define a new Menultem to perform the action we require:

"ts'OWC'Menultem' '&Time'
('Event' 'Select' '#[TS'")
('Hint' 'Display Timestamp')

The ¢ symbol is very important and distinguishes an expression to be executed imme-
diately, as in this case, from a callback function. The resulting Tools menu now
appears as follows:

Explarer, ..
Search...
Skatus...

v AuboStatus
Event Viewer

Tirne:
A customised Tools menu

Selecting Time produces the following output in the session:

2007 12 10 17 10 2 O

Adding your own Tool Button

This example shows how you can add a button to the session tool bar that executes
an APL function.

The example function we will use is called XREF. This function analyses another
function, listing the sub-functions that it calls. Instead of returning a result, this exam-
ple displays the sub-functions in a Form.



Chapter 2: The APL Environment 268

vV XREF FN;REFS
[1] :If 0<pFN
[2] :AndIf 3=[NC FN

[3] REFS<[REFS FN

[4] REFS<«(3=[IJNC REFS)#REFS

[5] REFS«(4REFS)~""

[6] REFS<«<REFS~cFN

[7] :If O<pREFS

[8] "F'OWC'Form' ('Functions called by ',FN)
[9] F.FontObj<«[JSE.FontObj

[10] 'F.L'OWC'List'REFS(0 0)(100 100)

[11] :EndIf

[12] tEndIf

To make this function available from a Session tool button, we need to do a number
of things.

Firstly, we must install the function in [JSE so that it is always there, regardless of the
current active workspace. This is easily achieved using the Explorer or [ONS.

'OSE' ONS 'XREF'

Secondly, we need to find another way to specify its argument FN. One possibility
would be to display a dialog box, asking the user to specify the name of the function
to be analysed. A neater solution is to use the CurObj property of JSE which reports
the name under the cursor. Using CurObj, the user can simply place the cursor over
the name of the function to be analysed, and then click the XREF tool button.

To get FN from CurQObj, all we need to do is to change the header and lines 1-2 to:

[0] XREF;FN;REFS
[1] :If 0<pFN<JSE.CurObj
[2] :AndIf 3=[NC FN<[SE.CurSpace,'.',FN

Notice that the function name reported by CurObj is prefixed by its pathname which
comes from the CurSpace property. This reports the user’s current namespace.

Next we will add a new button to the tool bar in the 7ools CoolBand. Ideally we
would use a suitable bitmap, but to simplify the example, we will use a standard text
button:

)CS [SE.cbtop.bandtb3.tb
OSE.cbtop.bandtb3.tb

'xref' [OWC 'Button' 'XREF'
'xref' [WS 'Event' 'Select' '¢[JSE.XREF'

Tool ©, G b M XREF|

Adding a tool button
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User Commands

Dyalog APL includes a mechanism to define User Commands.

User commands are developer tools, written in APL, which can be executed without
having to explicitly copy code into your workspace and/or save it in every work-
space in which you want to use it.

A User Command is a name prefixed by a closing square bracket, which may be nila-
dic or take an argument. A User Command executes APL code that is typically stored
somewhere outside the current active workspace.

By default, the existing SPICE command processor is hooked up to the user com-
mand mechanism, and a number of new SPICE commands have been added. For exam-

ple:
ldisplay 'hello' (5'world")
g
hello| ‘w
o
r
L
d
W
Le

The implementation of User Commands is very simple: Ifa line of input begins with
a closing square bracket (]), and there exists a function by the name [JSE . UCMD,
then the interpreter will call that function, passing the input line (without the
bracket) as the right argument.

To add a user command, drop a new Spice command file in the folder SALT\Spice.
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Chapter 3:

APL Files

Introduction

Most languages store programs and data separately. APL is unusual in that it allows
you to store programs and data together in a workspace.

This can be inefficient if your dataset gets very large; when your workspace is
loaded, you are loading ALL of your data, whether you need it or not.

It also makes it difficult for other users to access your data, particularly if you want
them to be able to update it.

In these circumstances, you must extract your data from your workspace, and write it
to a file on disk, thus separating your data from your program. There are many dif-
ferent kinds of file format. This section is concerned with the APL Component File
system which preserves the idea that your data consists of APL objects; hence you
can only access this type of file from within APL

The Component File system has a set of system functions through which you access
the file. Although this means that you have to learn a whole new set of functions in
order to use files, you will find that they provide you with a very powerful mech-
anism to control access to your data.
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Component Files

Overview

A component file is a data file maintained by Dyalog APL. It contains a series of
APL arrays known as components which are accessed by reference to their relative
position or component number within the file. Component files are just like other
data files and there are no special restrictions imposed on names or sizes.

A set of system functions is supplied to perform a range of file operations. These pro-
vide facilities to create or delete files, and to read and write components. Facilities
are also provided for multi-user access, including the capability to determine who
may do what, and file locking for concurrent updates.

Tying and Untying Files

To access an existing component file it must be tied, i.e. opened for use. The tie may
be exclusive (single-user access) or shared (multi-user access). A file is untied, i.e.
closed, using JFUNTIE or on terminating Dyalog APL. File ties survive ) LOAD,
OLOAD and ) CLEAR operations.

Tie Numbers

A file is tied by associating a file name with a tie number. Tie numbers are integers
in the range 1 - 2147483647 and, you can supply one explicitly, or have the inter-
preter allocate the next available one by specifying 0. The system functions which tie
files return the tie number as a ‘shy’ result.

Creating and Removing Files

A component file is created using [JF CREATE which automatically ties the file for
exclusive use. A newly created file is empty, i.e. contains 0 components. A file is
removed with [JF ERASE, although it must be exclusively tied to do so.

Adding and Removing Components

Components are added to a file using JF APPEND and removed using [JFDROP. Com-
ponent numbers are allocated consecutively starting at 1. Thus a new component
added by OF APPEND is given a component number which is one greater that that of
the last component in the file. Components may be removed from the beginning or
end of'the file, but not from the middle. Component numbers are therefore con-
tiguous.
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Reading and Writing Components

Components are read using [JFREAD and overwritten using JFREPLACE. There are
no restrictions on the size or type of array which may replace an existing component.
Components are accessed by component number, and may be read or overwritten at
random.

Component Information

In addition to the data held in a component, the user ID that wrote it and the time at
which it was written is also recorded. This control information is useful in providing
an audit trail and in facilitating partial backups of components that have changed.

Multi-User Access

OF STIE ties a file for shared (i.e. multi-user) access. This kind of access would be
appropriate for a multi-user UNIX system, a network of single user PCs, or multiple
APL tasks under Microsoft Windows.

OF HOLD provides the means for the user to temporarily prevent other co-operating
users from accessing one or more files. This is necessary to allow a single logical
update involving more than one component, and perhaps more than one file, to be
completed without interference from another user. JF HOLD is applicable to External
Variables as well as Component Files

File Access Control

There are two levels of file access control. As a regular data file, the operating system
read/write controls for owner and other users apply. In addition, Dyalog APL man-
ages its own access controls using the access matrix. This is an integer matrix with 3
columns and any number of rows. Column 1 contains user numbers, column 2 an
encoding of permitted file operations, and column 3 passnumbers. Each row specifies
which file operations may be performed by which user(s) with which passnumber.

User Number

This is a number which is defined by the aplnid parameter. If you intend to use Dya-
log APL’s access matrix to control file access in a multi-user environment, it is desir-
able to allocate to each user, a distinct user number. However, if you intend to rely
on under-lying operating system controls, allocating a user number of 0 to everyone
is more appropriate. A user number of 0 (which is the installation default), causes
APL to circumvent the access matrix mechanism described below.
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Permission Code

This is an integer representation of a Boolean mask. Each bit in the mask indicates
whether or not a particular file operation is permitted as follows:

Bit No.

15|14(13)12(11)10(9|8|7|6|5|%|3]|2]|1

File Access
(R I 1 £ N N N Operation Code

‘ L—— OFREAD 1
OFTIE 2
OFERASE 4
OF APPEND 8
OFREPLACE 16
OFDROP 32
OFRENAME 128
OFRDCI 512
OFRESIZE 1024
OFHOLD 2048
OFRDAC 4096
OFSTAC 8192
OFHIST 16384

For example, if bits 1, 4 and 6 are set and all other relevant bits are zero only
OFREAD,[JFAPPEND and [JFDROP are permitted. A convenient way to set up the
mask is to sum the access codes associated with each operation.

For example, the value 41 (1+8+32) authorises JFREAD, [JF APPEND and [JF DROP.
A value of "1 (all bits set) permits all operations. Thus by subtracting the access
codes of operations to be forbidden, it is possible to permit all but certain types of
access. For example, a value of 133 (T1- 4+128) permits all operations except
OF ERASE and OFRENAME. Note that the value of unused bits is ignored. Any non-
zero permission code allows JF STIE and FSIZE.OFCREATE,OFUNTIE,OFLIB,
OFNAMES and [OF NUMS are not subject to access control. Passnumbers may also be
used to establish different levels of access for the same user.

When the user attempts to tie a file using OF TIE orJF STIE a row of the access
matrix is selected to control this and subsequent operations.

Ifthe user is the owner, and the owner's user ID does not appear in the access matrix,
the value (AI[1] ~1 0)isconceptually appended to the access matrix. This
ensures that the owner has full access rights unless they are explicitly restricted.
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The chosen row is the first row in which the value in column 1 of'the access matrix
matches the user ID and the value in column 3 matches the supplied passnumber
which is taken to be zero if omitted.

If there is no match ofuser ID and passnumber in the access matrix (including implic-
itly added rows) then no access is granted and the tie fails with a FILE ACCESS
ERROR.

Once the applicable row of the access matrix is selected, it is used to verify all sub-
sequent file operations. The passnumber used to tie the file MUST be used for every
subsequent operation. Secondly, the appropriate bit in the permission code cor-
responding to the file operation in question must be set. If either of these conditions
is broken, the operation will fail with FILE ACCESS ERROR.

If the access matrix is changed while a user has the file tied, the change takes imme-
diate effect. When the user next attempts to access the file, the applicable row in the
access matrix will be reselected subject to the supplied passnumber being the same as
that used to tie the file. If access with that password is rescinded the operation will
fail with FILE ACCESS ERROR.

When a file is created using [JF CREATE, the access matrix is empty. At this stage, the
owner has full access with passnumber 0, but no access with a non-zero passnumber.
Other users have no access permissions. Thus only the owner may initialise the
access matrix.

User 0

If a user has an aplnid of 0, the access matrix and supplied passnumbers are ignored.
This user is granted full and unrestricted access rights to all component files, subject
only to underlying operating system restrictions.

General File Operations

OFLIB gives alist of component files in a given directory. JF NAMES and [JF NUMS
give a list of the names and tie numbers of tied files. These general operations which
apply to more than one file are not subject to access controls.
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Component File System Functions

See Language Reference for full details of the syntax of these system functions.

General

OFAVAIL Report file system availability
File Operations

OFCREATE Create a file

OFTIE Tie an existing file (exclusive)
OFSTIE Tie an existing file (shared)
OFUNTIE Untie file(s)

gdrcory Copy a file

OFERASE Erase a file

OFRENAME Rename a file

File information

OFHIST Report file events

OF NUMS Report tie numbers of tied files
OFNAMES Report names of tied files
OFLIB Report names of component files
OFPROPS Report file properties

OFsIze Report size of file

Writing to the file

OFAPPEND Append a component to the file
OFREPLACE Replace an existing component

Reading from a file

OFREAD Read a component

OFRDCI Read component information
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Manipulating a file

0OFDROP Drop a block of components
OFRESIZE Change file size (forces a compaction)
OF CHK Check and repair a file

Access manipulation

OFSTAC Set file access matrix

OFRDAC Read file access matrix

Control multi-user access

OFHOLD Hold file(s) - see later section for details

Using the Component File System

Let us suppose that you have written an APL system that builds a personnel database,
containing the name, age and place of birth of each employee. Let us assume that you
have created a variable DATA, which is a nested vector with each element containing
a person's name, age and place of birth:

DISPLAY 21DATA

Then the following APL expressions can be used to access the database:

Example 1:

Show record 2

DISPLAY 2-5DATA

Example 2:

How many people in the database?

pDATA
123
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Example 3:
Update Pauline's age

(2 2oDATA)<«16
Example 4:

Add a new record to the database
DATA ,« c<'Maurice' 18 'London'
Now let's build a component file to hold our personnel database.

Create a new file, giving the file name, and the number you wish to use to identify it
(the file tie number):

‘COMPFILE' [JFCREATE 1

Ifthe file already exists, or you have already used this tie number, then APL will
respond with the appropriate error message.

Now write the data to the file. We could write a function that loops to do this, but it
is neater to take advantage of the fact that our data is a nested vector, and use each

o).
DATA [OFAPPEND™ 1

Now we'll try our previous examples using this file.

Example 1:
Show record 2

DISPLAY [FREAD 1 2

Example 2:
How many people in our database?

OFSIze 1 A First component, next
1 125 10324 4294967295 A component, file size,
A maximum file size

“1+2>o[JFSIZE 1 A Number of data items

The fourth element of JF SIZE indicates the file size limit. Dyalog APL does not
impose a file size limit, although your operating system may do so, but the concept is
retained in order to make this version of Component Files compatible with others.
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Example 3:
Update Pauline's age
REC « [OFREAD 1 2 A Read second component
REC[2] « 18 A Change age
REC OFREPLACE 1 2 A And replace component
Example 4:

Add a new record

('Janet' 25 'Basingstoke') [FAPPEND 1

Example 5:
Rename our file

'"PERSONNEL ' [OFRENAME 1

Example 6:

Tie an existing file; give file name and have the interpreter allocate the next avail-
able tie number.

"SALARIES' [FTIE O
2

Example 7:
Give everyone access to the PERSONNEL file
(1 3p0 71 0)OFSTAC 1

Example 8:
Set different permissions on SALARIES.

AM « 1 3p1 71 0 A Owner ID 1 has full access
AM;« 102 1 O A User ID 102 has READ only
AMs« 210 2073 0 A User ID 210 has

A READ+APPEND+REPLACE+HOLD

AM [OFSTAC 2 A Store access matrix

Example 9:
Report on file names and associated numbers

OFNAMES ,OF NUMS
PERSONNEL 1
SALARIES 2
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Example 10:
Untie all files
OFUNTIE OFNUMS

Programming Techniques

Controlling Multi-User Access

Obviously, Dyalog APL contains mechanisms that prevent data getting mixed up if
two users update a file at the same time. However, it is the programmer's respon-
sibility to control the logic of multi-user updates.

For example, suppose two people are updating our database at the same time. The

first checks to see if there is an entry for ' Geof f ', sees that there isn't so adds a new
record. Meanwhile, the second user is checking for the same thing, and so also adds a
record for ' Geof f . Each user would be running code similar to that shown below:

V UPDATE ;DATA;NAMES
[1] A Using the component file
[2] "PERSONNEL' [OFSTIE 1
[3] NAMES<«>o[JFREAD ™ 1, 171+2>5[FSIZE 1
[4] >ENDx1(c'Geoff')eNAMES
[5] ('Geoff' 41 'Hounslow')JFAPPEND 1
[6] END:[JFUNTIE 1

\'

The system function [JF HOLD provides the means for the user to temporarily prevent
other co-operating users from accessing one or more files. This is necessary to allow a
single logical update, perhaps involving more than one record or more than one file,
to be completed without interference from another user.
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The code above is replaced by that below:

vV UPDATE ;DATA;NAMES

] A Using the component file

] 'PERSONNEL' [JFSTIE 1

] [OFHOLD 1

] NAMES<«oo[JFREAD ™ 1, 171+2>5[JFSIZE 1
] ->ENDxi1(c'Geoff')eNAMES

] ('Geoff' 41 'Hounslow')[FAPPEND 1
] END:JFUNTIE 1 ¢ [JFHOLD 10

\4

[ L L T e T T |
NOOUIF WN =

Successive JFHOLDs on a file executed by different users are queued by Dyalog
APL; once the first JF HOLD is released, the next on the queue holds the file.

OF HOLDs are released by return to immediate execution, by JFHOLD @, or by eras-
ing the external variable.

It is easy to misunderstand the effect of JFHOLD. It is NOT a file locking mechanism
that prevents other users from accessing the file. It only works if the tasks that wish to
access the file co-operate by queuing for access by issuing [JF HOLDs. It would be
very inefficient to issue a JFHOLD on a file then allow the user to interactively edit
the data with the hold in operation. What happens if he goes to lunch? Any other
user who wants to access the file and cooperates by issuing a [JF HOLD would have to
wait in the queue for 3 hours until the first user returns, finishes his update and his
OF HOLD is released. It is usually more efficient (as well as more friendly) to issue

OF HOLDs around a small piece of critical code.

Suppose we had a control file associated with our personnel data base. This control
file could be an external variable, or a component file. In both cases, the concept is
the same; only the commands needed to access the file are different. In this example,
we will use a component file:

"CONTROL '(JFCREATE 1 A Create control file

(1 3p0 "1 0) OFSTAC 1 QA Allow everyone access

o [OFAPPEND 1 A Set component 1 to empty
OFUNTIE 1 A And untie it
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Now we'll allow our man that likes long lunch breaks to edit the file, but will control
the hold in a more efficient way:

vV EDIT;CMP;CV
[1] A Share-tie the control file

[2] "CONTROL"' [FSTIE 1
[3] A Share-tie the data file
[4] '"PERSONNEL' [FSTIE 2

[5] A Find out which component the user wants to edit
[6] ASK :CMP<ASKAWHICHARECORD

[7] A Hold the control file

[8] OFHOLD 1

[9] A Read the control vector

[10] CV<[JFREAD 1 1

[11] a Make control vector as big as the data file
[12] CV«(~1+2>o[JFSIZE 2)tCV

[13] A Look at flag for this component

[14] ~>(FREE,INUSE)[1+CMPoCV]

[15] A In use - tell user and release hold

[16] 1INUSE:'Record in use' ¢ [JFHOLD & ¢ -ASK

[17] A Ok to use - flag in-use and release hold
[18] FREE:CV[CMP]«1 o CV [OFREPLACE 1 1o [JFHOLD &
[19] na Let user edit the record

[20] EDITARECORD RECORD

[21] @a When he's finished, clear the control vector
[22] [OFHOLD 1

[23] CV<[JFREAD 1 1 oCV[CMP]«0 ¢ CV [JFREPLACE 1 1
[26] [FHOLD &

[27] A And repeat

[28] -+ASK

v

Component 1 of our CONTROL file acts as a control vector. Its length is set equal to
the number of components in the PERSONNEL file, and an element is set to 1 ifa
user wishes to access the corresponding data component. Only the control file is ever
subject to a JFHOLD, and then only for a split-second, with no user inter-action
being performed whilst the hold is active.

When the first user runs the function, the relevant entry in the control vector will be
set to 1. If a second user accesses the database at the same time, he will have to wait
briefly whilst the control vector is updated. If he wants the same component as the
first user, he will be told that it is in use, and will be given the opportunity to edit
something else

This simple mechanism allows us to lock the components of our file, rather the than
entire file. You can set up more informative control vectors than the one above; for
example, you could easily put the user name into the control vector and this would
enable you to tell the next user who is editing the component he is interested in.
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File Design

Our personnel database could be termed a record oriented system. All the infor-
mation relating to one person is easily obtained, and information relating to a new
person is easily added, but if we wish to find the oldest person, we have to read ALL
the records in the file.

It is sometimes more useful to have separate components, perhaps stored on separate
files, that hold indexes of the data fields that you may wish to search on. For exam-
ple, suppose we know that we always want to access our personnel database by
name. Then it would make sense to hold an index component of names:

A Extract name field from each data record
"PERSONNEL' [OFSTIE 1
NAMES<«>o[JFREAD "1, "1 ~1+2>[JFSIZE 2

A Create index file, and append NAMES
"INDEX' [FCREATE 2
NAMES [FAPPEND 2

Then if we want to find Pauline's data record:

NAMES<[JFREAD 2,1 A Read index of names
CMP<NAMESi1c'Pauline’ A Search for Pauline
DATA<[JFREAD 1,CMP A Read relevant record

There are many different ways to structure data files; you must design a structure that
is the most efficient for your application.

Internal Structure

If you are going to make a lot ofuse of APL files in your systems, it is useful for you
to have a rough idea of how Dyalog APL organises and manages the disk area used
by such files.

The interal structure of external variables and component files is the same, and the
examples given below apply to both.

Consider a component file with 3 components:

'"TEMP' [JFCREATE 1
'One' 'Two' 'Three' [OFAPPEND™1

Dyalog APL will write these components onto contiguous areas of disk:

| One | Two | Three |
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Replace the second component with something the same size:
'Six' [OFREPLACE 1 2

This will fit into the area currently used by component 2.

If your system uses fixed length records, then the size of your components never
change, and the internal structure of the file remains static.

However, suppose we start replacing larger data objects:
'Bigger One' [FREPLACE 1 1

This will not fit into the area currently assigned to component 1, so it is appended to
the end of'the file. Dyalog APL maintains internal tables which contain the location
of each component; hence, even though the components may not be physically
stored in order, they can always be accessed in order.

121 13l I1]

The area that was occupied by component 1 now becomes free.
Now we'll replace component 3 with something bigger:
‘BigThree' [FREPLACE 1 3

Component 3 is appended to the end of'the file, and the area that was used before
becomes free:

Dyalog APL keeps tables of the size and location of the free areas, as well as the
actual location of your data. Now we'll replace component 2 with something bigger:

'BigTwo' [OFREPLACE 1 2
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Free areas are used whenever possible, and contiguous holes are amalgamated.

You can see that if you are continually updating your file with larger data objects,
then the file structure can become fragmented. At any one time, the disk area occu-
pied by your file will be greater than the area necessary to hold your data. However,
free areas are constantly being reused, so that the amount of unused space in the file
will seldom exceed 30%.

Whenever you issue a monadic JFRESIZE command on a component file, Dyalog
APL COMPACTS the file; that is, it restructures it by reordering the components and
by amalgamating the free areas at the end of the file. It then truncates the file and
releases the disk space back to the operating system (note that some versions of
UNIX do not allow the space to be released). For a large file with many components,
this process may take a significant time.

Error Conditions
FILE SYSTEM NOT AVAILABLE

In a PC network, or in a single-processor Unix environment, if the FSCB file is miss-
ing or inaccessible (restricted access permissions) the report FILE SYSTEM NOT
AVAILABLE (Error code 28) will be given. The same error will occur under NFS if
the aplfsch "daemon" is not running.

FILE SYSTEM TIES USED UP

The FSCB file has a limited capacity and when that capacity is reached the report
FILE SYSTEM TIES USED UP (Error code 30) will be given.

FILE TIED

A FILE TIED errorisreported if you attempt to tie a file which another user has
exclusively tied. However, it is possible to get spurious FILE TIED errorsin anet-
work for the following reason.

Ifan APL session has component files tied or has External Variables associated, and
terminates abnormally, the FSCB will continue to record the file ties, even though
the session is no longer running. To prevent another user (or even the same appli-
cation restarted) from getting spurious FILE TIED errors, APL checks whether the
process flagged as having a file tied is actually running. If not, the entry is cleared
and the new tie honoured.
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In a networked environment, it is not possible for a process running on one node to
check the status of a process running on another. If a node with component files tied
crashes, its file ties will remain (incorrectly) recorded in the FSCB until either that
node itself attempts to re-tie the files or until the FSCB is re-initialised.

Limitations
File Tie Quota

The File Tie Quota is the maximum number of files that a user may tie concurrently.
Dyalog APL itself allows a maximum of 256 under Unix and Windows, although in
either case your installation may impose a lower limit. When an attempt is made to
exceed this limit, the report FILE TIE QUOTA (Error code 31)is given. On a UNIX
system, there is a system-wide and a per-user limit on the number of open file descrip-
tors. On many systems, the per-user limit is 20, and the system-wide limit about 100.
Both limits are usually parameters specified when Unix is installed. Under Windows,
the maximum number of open files permitted is specified by the "FILES=" state-
ment in CONFIG.SYS.

File Name Quota

Dyalog APL records the names of each user's tied files in a buffer of 40960 bytes.
When this buffer is full, the report FILE NAME QUOTA USED UP (Error code 32)
will be given. This is only likely to occur if long pathnames are used to identify files.

The Effect of Buffering

Disk drives are fairly slow devices, so most operating systems take advantage ofa
facility called buffering. This is shown in simple terms below:

| Operating System | . . .
| instruction to |-->|] BUFFER |--->] File on |
| |
| |

write large data | --------- . | disk |
object to a file |  mmmm—————-

When you issue a write to a disk area, the data is not necessarily sent straight to the
disk. Sometimes it is written to an internal buffer (or cache), which is usually held in
(fast) main memory. When the buffer is full, the contents are passed to the disk. This
means that at any one time, you could have data in the buffer, as well as on the disk.
If you machine goes down whilst in this state, you could have a partially updated file
on the disk. In these circumstances, the operating system generally recovers your file
automatically.
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If'this facility is exploited, it offers very fast file updating. For systems that are /O
bound, this is a very important consideration. However, the disadvantage is that
whilst it may appear that a write operation has completed successfully, part of the
data may still be residing in the buffer, waiting to be flushed out to the disk. It is
usually possible to force the buffer to empty; see your operating system manuals for
details (UNIX automatically invokes the sync () command every few seconds to
flush its internal buffers).

Dyalog APL exploits this facility, employing buffers internal to APL as well as mak-
ing use of the system buffers. Of course, these techniques cannot be used when the
file is shared with other users; obviously, the updates must be written immediately to
the disk. However, if the file is exclusively tied, then several layers of buffers are
employed to ensure that file access is as fast as possible.

Y ou can ensure that the contents of all internal buffers are flushed to disk by issuing
OFUNTIE @ atany time.

Integrity and Security

The structure of component files, the asynchronous nature of the buffering performed
by APL, by the Operating System, and by the external device sub-system, introduces
the potential danger that a component file might become damaged. To prevent this
happening, the component file system includes optional journaling and check-sum
features. These are optional because the additional security these features provide
comes at the cost of reduced performance. You can choose the level of security that is
appropriate for your application.

When journaling is enabled (see OF PROPS), files are updated using a journal which
effectively prevents system or network failures from causing file damage.

Additional security is provided by the check sum facility which enables component
files to be repaired using the system function [JF CHK.

Level 1 journaling protects a component file from damage caused by an abnormal ter-
mination of the APL process. This could occur if the process is deliberately or acci-
dentally terminated by the user or by the Operating System, or by an error in Dyalog
APL.

Level 2 journaling provides protection not just against the possibility that the APL
process terminates abnormally, but that the Operating System itself fails. However, a
damaged component file must be explicitly repaired using the system function

OF CHK which will repair any damaged components by rolling them back to their pre-
vious states.
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Level 3 provides the same level of protection as Level 2, but following the abnormal
termination of either APL or the Operating System, the rollback of an incomplete
update will be automatic and no explicit repair will be needed.

Higher levels of Journaling inevitably reduce the performance of component file
updates.

For further information, see JFPROPS and [JF CHK.

Operating System Commands

APL files are treated as normal data files by the operating system, and may be manip-
ulated by any of the standard operating system commands.

Do not use operating system commands to copy, erase or move component files that
are tied and in use by an APL session.
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Chapter 4:

Error Trapping

Error Trapping Concepts

The purpose of this section is to show some of the ways in which the ideas of error
trapping can be used to great effect to change the flow of control in a system.

Most APLs have error trapping facilities in one form or another, but this section dis-
cusses the facilities available to a Dyalog APL programmer.

First, we must have an idea of what is meant by error trapping. We are all used to
entering some duff APL code, and seeing a (sometimes) rather obscure, esoteric error
message echoed back:

10+0
DOMAIN ERROR
10+0

A

Now, these sorts of error messages are fine for us clever APL programmers, but mean-
ingless to most of our users. We need to find a way to bypass the default action of
APL, so that we can take an action of our own.

Every error message reported by Dyalog APL has a corresponding error number (for a
list of error codes and message, see JTRAP, Language Reference). Many of these error
numbers plus messages are common across all versions of APL. We can see that the
code for DOMAIN ERROR is 11, whilst LENGTH ERROR has code 5.

Dyalog APL provides two distinct but related mechanisms for the trapping and con-
trol of errors. The first is based on the control structure :Trap ... :EndTrap,
and the second, on the system variable DJTRAP. The control structure is easier to
administer and so is recommended for normal use, while the system variable provides
slightly finer control and may be necessary for specialist applications.
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Last Error number and Diagnostic Message

Dyalog APL keeps a note of the last error that occurred, and provides this infor-
mation through system functions: [JEN, JEM and [JDM.
10+0
DOMAIN ERROR
10+0

A

Error Number for last occurring error:

OEN
11

Error Message associated with code 11:

OeM 11
DOMAIN ERROR

(DM (Diagnostic Message) is a 3 element nested vector containing error message,
expression and caret:

(oM
DOMAIN ERROR 1040 A

Use function DISPLAY to show structure:
DISPLAY [IDM

DOMAIN ERROR 10+0 A

€

Mix (1) of this vector produces a matrix that displays the same as the error message
produced by APL:

+0JOM
DOMAIN ERROR
10+0

A
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Error Trapping Control Structure

You can embed a number of lines of code in a : Trap control structure within a
defined function.

[1]

[2] :Trap O

[3]

[4]

[5] :EndTrap
[6] v

Now, whenever any error occurs in one of the enclosed lines, or in a function called
from one of'the lines, processing stops immediately and control is transferred to the
line following the : EndTrap. The 0 argument to : Trap, in this case represents any
error. To trap only specific errors, you could use a vector of error numbers:

[2] :Trap 11 2 3

Notice that in this case, no extra lines are executed after an error. Control is passed to
line [ 6] either when an error has occurred, or if all the lines have been executed
without error. If you want to execute some code only after an error, you could re-code
the example like this:

[2] :Trap 0

[5] ‘Else

[8] :End%éép

Now, if an error occurs in lines [ 3-4], (or in a function called from those lines), con-
trol will be passed immediately to the line following the : E | se statement. On the

other hand, ifall the lines between : Trap and : E L se complete successfully, con-
trol will pass out of the control structure to (in this case) line [9].
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The final refinement is that specific error cases can be accommodated using
:Case[List] constructs in the same manner as the : Se lect control structure.

[1]
[2]
[3]
(4]
(5]
(el
(7]
(8]
[91]
[10]

:Trap 17+121 A Component file errors.
tieename [ftie 0 A Try to tie file
IOKI

:Case 22

'Can''t find ',name
:Caselist 25+113

'Resource Problem'
tElse

‘Unexpected Problem'
:EndTrap

Note that : Trap can be used in conjunction with JSIGNAL described below.

Traps can be nested. In the following example, code in the inner trap structure
attempts to tie a component file, and if unsuccessful, tries to create one. In either case,
the tie number is then passed to function ProcessF i Le. Ifan error other than 22
(FILE NAME ERROR)occurs in the inner trap structure, or an error occurs in func-
tion ProcessF i Ll e (or any ofits called function), control passes to line imme-
diately to line [9].

(1]
[2]
[3]
4]
(5]
(6]
(7]
(8l
[9]
[10]

:Trap O
:Trap 22
tie<name [ftie 0
:Else
tie<name [fcreate 0
:EndTrap
ProcessFile tie
:Else

"Unexpected Error'
:EndTrap
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Trap System Variable: JTRAP

The second way of trapping errors is to use the system variable: JTRAP.

OTRAP, can be assigned a nested vector of trap specifications. Each trap spec-
ification is itself a nested vector, of length 3, with each element defined as:

list of error

The error numbers we are interested in.
numbers

Either 'E' (Execute) or 'C' (Cut Back). There are

action code
others, but they are seldom used.

APL expression, usually a branch statement or a call to

action to be taken an APL function.

So a single trap specification may be set up as:
OTRAP«5 'E' 'ACTION1'
and a multiple trap specification as:

OTRAP«<(5 'E' 'ACTION1')((1 2 3) 'C' 'ACTION2')

The action code E tells APL that you want your action to be taken in the function in
which the error occurred, whereas the code C indicates that you want your action to
be taken in the function where the J-TRAP was localised. If necessary, APL must first
travel back up the execution stack (cut-back) until it reaches that function.

Example Traps

These action codes are best illustrated by example.

Dividing by Zero
Let's try setting aJTRAP on DOMAIN ERROR:

MSG<+'''Please give a non-zero right arg'''
OTRAP«11 'E' MSG

When we enter:
10+0
APL executes the expression, and notes that it causes an error number 11. Before issu-

ing the standard error, it scans its JTRAP table, to see if you were interested enough
in that error to set a trap; you were, so APL executes the action specified by you:

10+0
Please give non-zero right arg
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Let's reset our JTRAP:
OTRAP<0p[TRAP A No traps now set
and write a defined function to take the place of the primitive function +:

V R«A DIV B
[1] R<A=+B
[2] v

Then run it:

10 DIV O
DOMAIN ERROR
DIV[1] R«A=B
A

Let's edit our function, and include a localised JTRAP:

V R«A DIV B;[TRAP
[1] A Set the trap
[2] OTRAP«11 'E' '-ERR1'
[3] A Do the work; if it results in error 11,
[4] A execute the trap

[5] R<A+B
[6] A ALL OK if we got to here, so exit
(7] =0

[8] a Will get here only if error 11 occurred
[9] ERRL1:'Please give a non-zero right arg'
\4

Running the function with good and bad arguments has the desired effect:

10 DIV 2

10 DIV O
Please give a non-zero right arg

OTRAP is a variable like any other, and since it is localised in DIV, it is only effec-
tive in DIV and any other functions that may be called by DIV. So...
10+0
DOMAIN ERROR
10+0

A

still gives an error, since there is no trap set in the global environment.
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Other Errors

What happens to our function if we run it with other duff arguments:

12 3DIVH5S

LENGTH ERROR
DIV [4] R<«A+B
A

Here is an error that we have taken no account of.

Change DIV to take this new error into account:

(7]
(8l
(9]

v
A

A
A

A

A

R«A DIV B;[TRAP

Set the trap

OTRAP«<(11 'E' '-»ERR1')(5 'E' '=ERR2')
Do the work; if it results in error 11,
execute the trap

R«A + B

ALl OK if we got to here, so exit

-0

Will get here only if error 11 occurred

ERR1:'Please give a non-zero right arg'e-0
[10] A Will get here only if error 5 occurred
[11] ERR2:'Arguments must be same length'

v

JRESET
12 3DIVH4H5

Arguments must be the same Llength

But here's yet another problem that we didn't think of:

(2 3p16) DIV (2 3 4pi24)

RANK ERROR
DIV [4] R<«A=B
A
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Global Traps

Often when we are writing a system, we can't think of everything that may go wrong
ahead oftime; so we need a way of catching "everything else that I may not have
thought of". The error number used for "everything else" is zero:

JRESET
Set a global trap:

OTRAP « 0 'E' ' ''Invalid arguments'' '
And run the function:

(2 3p16) DIV (2 3 4pi2k)
Invalid arguments

In this case, when APL executed line 4 of our function DIV, it encountered an error
number 4 (RANK ERROR). It searched the local trap table, found nothing relating to
error 4, so searched further up the stack to see if the error was mentioned anywhere
else. It found an entry with an associated Execute code, so executed the appropriate
action AT THE POINT THAT THE ERROR OCCURRED. Let's see what's in the
stack:

)SI
DIV[4]*

+0DOM
RANK ERROR
DIV[4] R<«A+B
A

So although our action has been taken, execution has stopped where it normally
would aftera RANK ERROR.

Dangers

We must be careful when we set global traps; let's call the non-existent function
BUG whenever we get an unexpected error:

JRESET
OTRAP <« 0 'E' 'BUG'
(2 3p16) DIV (2 3 4pi2h)

Nothing happens, since APL traps a RANK ERROR on line 4 of DIV, so executes the
trap statement, which causes a VALUE ERROR, which activates the trap action,
which causes a VALUE ERROR, which .... etc. etc. If we had also chosen to trap on
1000 (ALL INTERRUPTS), then we'd be in trouble!
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Let's define a function BUG:
vV BUG

[1] A Called whenever there is an unexpected error
[2] "sxxx UNEXPECTED ERROR OCCURRED IN: ',o1i[]SI
[3] "xxx PLEASE CALL YOUR SYSTEM ADMINISTRATOR'
[4] "xxx WORKSPACE SAVED AS BUG.',>1![1SI

[5] A Tidy up ... reset OLX, untie files ... etc
[6] [OSAVE 'BUG.',o14[]SI

[7] "sxxx LOGGING YOU OFF THE SYSTEM'

[8] doFF

v

Now, whenever we run our system and an unexpected error occurs, our BUG function
will be called.

10 DIV O
Please give non-zero right arg

(2 3p16) DIV (2 3 4pi12)

x%x% UNEXPECTED ERROR OCCURRED IN: DIV

xxx PLEASE CALL YOUR SYSTEM ADMINISTRATOR'
x%xx WORKSPACE SAVED AS BUG.DIV

xxx LOGGING YOU OFF THE SYSTEM'

The system administrator can then load BUG.DIV, look at the SI stack, discover the
problem, and fix it.

Looking out for Specific Problems

In many cases, you can of course achieve the same effect of a trap by using APL code
to detect the problem before it happens. Consider the function TIEAFILE, which
checks to see if a file already exists before it tries to access it:

V R«TIEAFILE FILE;FILES
[1] @A Tie file FILE with next available tie number
[2] =~
[3] A AlLL files in my directory
(4] FILES<OFLIB 'mydir'
[5] n Remove trailing blanks
[6] FILES«dbr VFILES
[7] a Required file in list?
[8] >ERRx1~(cFILE)eFILES
[9] @A Tie file with next number
[10] FILE OFTIE R<«1+[/0,00FNUMS
[11] A ... and exit
[12] -0
[13] A Error message
[14] ERR:R«'File does not exist'
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This function executes the same code whether the file name is right or wrong, and it
could take a while to get all the file names in your directory. It would be neater, and
more efficient to take action ONLY when the file name is wrong:

V R«TIEAFILE FILE;[TRAP

[1] A Tie file FILE with next available tie number
[2] n
[3] A Set trap

[4] OTRAP<«22 'E' '-ERR'

[5] A Tie file with next number
[6] FILE OFTIE R<«1+[/0,[JFNUMS
[7] A ... and exit if OK

[8] =0

[9] A Error message

[10] ERR:R«'File does not exist'

Cut-Back versus Execute

Let us consider the effect of using Cut-Back instead of Execute. Consider the system
illustrated below, in which the function REPORT gives the user the option of 4
reports to be generated:

REPORT
I
I I I I
REP1 REP2 REP3 REPY
I
I I I
DIV

where REPORT looks something like this:
vV  REPORT;OPTIONS;OPTION;[TRAP

[1] @ Driver functions for report sub-system. If an
[2] A unexpected error occurs, take action in the
[3] A function where the error occurred

[4] =~

[5] na Set global trap

[6] [OTRAP<0 'E' 'BUG'

[7] ~n Available options

[8] OPTIONS<«'REP1' 'REP2' 'REP3' 'REPY4'
[9] @A Ask user to choose

[10] LOOP:-ENDx10=pOPTION«MENU OPTIONS
[11] A Execute relevant function

[12] &OPTION

[13] A Repeat until EXIT

[14] ->LOOP

[15] A Now end

[16] END:
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Suppose the user chooses REP 3, and an unexpected error occurs in DIV. The good
news is that the System Administrator gets a snapshot copy of the workspace that he
can play about with:

JLOAD BUG.DIV A Load workspace

)SI A Where did error occur?
DIV[4]x*
REP3[6]

¢
REPORT([7]

+[IDM A What happened?
RANK ERROR
DIV[4] R<«A=B
A

v A Edit function on top of stack
[0]R«A DIV B

The bad news is, our user is locked out of the whole system, even though it may only
be REP3 that has a problem. We can get around this by making use of the CUT-
BACK action code.

V REPORT;OPTIONS;OPTION;[TRAP

[1] A Driver functions for report sub-system. If an
[2] A unexpected error occurs, cut the stack back
[3] Aa to this function, then take action

[4] n

[5] A Set global trap

[6] OTRAP<«<O 'C' '-ERR'

[7] a Available options

[8] OPTIONS<«'REP1' 'REP2' 'REP3' 'REPYH'
[9] A Ask user to choose

[10] LOOP:-ENDx10=pOPTION«MENU OPTIONS
[11] A Execute relevant function
[12] &OPTION

[13] A Repeat until EXIT
[14] ->LOOP

[15] A Tell user ...

[16] ERR:MESSAGE 'Unexpected error in',OPTION
[17] A ... what's happening

[18] MESSAGE'Removing from Llist'

[19] A Remove option from list

[20] OPTIONS<«~OPTIONS~cOPTION

[21] A And repeat

[22] -LOOP

[23] A End

[24] END:
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Suppose the user runs this version of REPORT and chooses REP3. When the
unexpected error occurs in DIV, APL will check its trap specifications, and see that
the relevant trap was set in REPORT with a cut-back code. APL therefore cuts back
the stack to the function in which the trap was localised, THEN takes the specified
action. Looking at the SI stack above, we can see that APL must jump out of DIV,
then REP3,then ¢, to return to line 7 of REPORT; THEN it takes the specified
action.

Signalling Events

It would be useful to be able to employ the idea of cutting back the stack and taking
an alternative route through the code, when a condition other than an APL error
occurs. To achieve this, we must be able to trap on errors other than APL errors, and
we must be able to define these errors to APL. We do the former by using error codes
in the range 500 to 999, and the latter by using JSIGNAL.

Consider our system; ideally, when an unexpected error occurs, we want to save a
snapshot copy of our workspace (execute BUG in place), then immediately jump back
to REPORT and reduce our options. We can achieve this by changing our functions a
little, and using JSTGNAL:

vV REPORT;:;OPTIONS;OPTION;:;[OTRAP

1 Driver functions for report sub-system. If an
[2] unexpected error occurs, make a snapshot copy
[3] of the workspace, then cutback the stack to
(4] this function, reduce the option list & resume
[5] Set global trap
[6] 0OTRAP«(500 'C' '-ERR')(O '"E' 'BUG')
[7] A Available options
[8] OPTIONS«'REP1' 'REP2' 'REP3' 'REPYH'
[9] A Ask user to choose
10] LOOP:->ENDx10=pOPTION«MENU OPTIONS
11] A Execute relevant function
12] &OPTION

13] A Repeat until EXIT
14]

15]

16]

17]

18]

19]

20]

21]

22]

23]

241]

DDO®XDO®DOD®DD

~LOOP

A Tell user ...

ERR:MESSAGE 'Unexpected error in',OPTION
A ... what's happening
MESSAGE 'Removing from Llist'
A Remove option from Llist
OPTIONS«OPTIONS~<OPTION

A And repeat

~LOOP

A End

END:
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vV BUG

A Called whenever there is an unexpected error
"*x%x UNEXPECTED ERROR OCCURRED IN: ',>14[]JSI
"x*x%x PLEASE CALL YOUR SYSTEM ADMINISTRATOR'
"xx%x WORKSPACE SAVED AS BUG.',>14[]ISI
A Tidy up ... reset OLX, untie files ... etc
OSAVE 'BUG.',>14[0SI
"*%%x RETURNING TO DRIVER FOR RESELECTION'
OSIGNAL 500

v

Lo N N e N N o N N e N ey |

ONOOTF WN
[ S T T S Y W S|

Now when the unexpected error occurs, the first trap specification catches it, and the
BUG function is executed in place. Instead of logging the user off as before, an
error 500 issignalled to APL. APL checks its trap specifications, sees that 500
has been set in REPORT as a cut-back, so cuts back to REPORT before branching to
ERR.

Flow Control

Error handling, which employs a combination of all the system functions and var-
iables described, allows us to dynamically alter the flow of control through our sys-
tem, as well as allow us to handle errors gracefully. It is a very powerful facility,
which is simple to use, but is often neglected.
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Index

NET Classes

exploring 190
A
ActiveX control 45
ActiveXControl object 163
APL files 271
APL fonts 265
APL CODE E MAGNITUDE 11
APL COMPLEX AS V12 12
APL_EXTERN_DECF 13
APL_FAST FCHK 13
APL_FCREATE_PROPS_C 12
APL FCREATE PROPS J 12
APL FHIST TIE 13
aplcore 14,17,53
aplcorename parameter 14,53
aplk parameter 14,129
aplkeys parameter 14,129
aplnid parameter 14,273
aplt parameter 15,130
apltrans parameter 15,130
aplunicd.ini 46-47
assemblies

exploring 190
auto_pw parameter 15,91, 138
AutoComplete 89

registry entries 31
AutoFormat parameter 15,143
Autolndent parameter 15,143
auxiliary processors 34
B
bridge dll 41-44,46

Browse .Net Assembly dialog box 191

Build runtime application 39

C

CancelKey (AutoComplete) parameter 146
charts

registry entries 31
class constructor 194
Classes

browsing 174
Classic Dyalog mode 238

multiple trace windows 246

single trace window 247

Classic Edition 10, 14,23,28,105,111, 121
ClassicMode parameter 16, 18-19,26-27, 142,

211
CloseAll system operation 106
CMD_POSTFIX parameter 16
CMD_PREFIX parameter 16
collapsing outlines 219,224,229
colour selection dialog 153
colours
registry entries 31
colourscheme parameter 124
Cols (AutoComplete) parameter 146
COM server
in-process 44
out-of-process 44
command line 8
command processor 34-35
CommandFolder parameter 149

CommonKey (AuotComplete) parameter 146
CompleteKey (AutoComplete) parameter 146

component files 272
access control 273
buffering 286
file design 283
internal structure 283
multi-user access 280

configuration dialog 123
.net framework tab 152
autocomplete tab 145
general tab 123
help/dmx tab 133
input tab 129
keyboard shortcuts tab 131
log tab 139
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object syntax tab 150 Dyalog APL DLL 50
output tab 130 classes, instances and cloning 50
session tab 137 workspace management 51
trace/edit tab 141 dyalog parameter 10, 14,19
unicode input tab 126 dyalog.chm 19
user commands tab 149 dyalog.exe.config 152
windows tab 134 dyalog32.dll 41,48
workspace tab 132 dyalog64.dll 42
configuration parameters 9 DyalogEmailAddress parameter 19
configuring the session 264 DyalogHelpDir parameter 19
confirm_abort parameter 16,143 DyaloglInstallDir parameter 19
confirm_close parameter 16,142 dyalognet dll 43-44,46
confirm_fix parameter 16,142 DyalogWebSite parameter 19
confirm_session_delete parameter 16
Constructors folder 194
context menu 87 E
COPY system command >4 edit window geometry 19
Create (session event) 261 .
. edit_cols parameter 19,135,208,211
Create bound file dialog 103 .
edit_first x parameter 19,211
CreateAplCoreonSyserror 57 dit £
CreateAplcoreOnSyserror parameter 17 edit_first_y parameter 19,135,211
. edit_offset x parameter 20,135,208,212
creating executables 37 .
: . edit_offset y parameter 20, 135,208,212
CurObj (session property) 63,262 .
. edit_rows parameter 19,135,208,211
CurPos (session property) 262 .
. editor
Current Object 63 .
CurSpace (session property) 262 class treeview 219,230
collapsing outlines 219
edit menu 216
D editing classes 228
Debuasing Thicad ;)l(panding outlines 219
ebugging Threads 251 € menu 214-215
default div parameter 17,138 function line numbers 219
default_io parameter 17,138 invoking 207
default_ml parameter 17,138 outlining 219,223
default pp parameter 17,138 refactor menu 218
default pw parameter 18 sections 231
default rl parameter 18,138 toolbar 213
default_rtl parameter 18,138 using 221
default wx parameter 18,110,138, 151 view menu 218
defaulthelpcollection parameter 133 windows menu 220
DefaultHelpCollection parameter 17 EditorState parameter 20
delay parameter 124 Enabled (AutoComplete) parameter 145
division method 17 endsection statement 225,231
dmxoutputonerror parameter 133 Enums 189
DMXOUTPUTONERROR parameter 18 environment variables 9-10
DockableEditWindows parameter 18,142 ErrorOnExternalException parameter 20
Docking 82 Event (session property) 263
DoubleClickEdit parameter 18,143 Event Sets 188
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event viewer

registry entries 31
executing expressions 90
execution (tracing) 244
exit codes 9,14
expanding outlines 219,224,229
Export menu item 37
external variables

sharing 36
F
fchk system function 287
File (session property) 263
file extensions 1
file stack size parameter 124
files

registry entries 32
find and replace dialogs 234

docking 235
Font (session property) 263
function line numbers 219
G
GetEnvironment method 10
global assembly cache 43-44,46
greet bitmap parameter 20
H
Handle (session property) 262
HintObj (session property) 263
History (AutoComplete) parameter 146
history size parameter 20, 140

HistorySize (AutoComplete) parameter 146
hot keys

syntax colouring 155
I
ILDASM 190
IME Configuration 66
index origin 17

inifile parameter 10,21, 124
InitialKeyboardLayout 21

InitialKeyboardLayout parameter 127
InitialKeyboardLayoutInUse parameter 21,
127
InitialKeyboardLayoutShowAll parameter 21,
127
Input (session property) 262
input codes 75
input line 88
input translate table 14
input_size parameter 21,140
interface with Windows 34
Interoperability 4
interrupt 64
K
keyboard layout
line-drawing 73
traditional 72
unified 70
keyboard shortcuts 61,74
registry entries 32
KeyboardInputDelay parameter 145
L
language bar 89
registry entries 32
line-drawing characters 73
line numbers 219,221
lines on_functions parameter 22,124
localdyalogdir parameter 22
Log (session property) 262
log_file parameter 140
log file inuse parameter 140
log size parameter 22,140
logfile parameter 22
logfileinuse parameter 22
M
manifest file 125
mapchars parameter 23
maxws parameter 23,33,51-52,132
Metadata 190, 192
Methods folder 196
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Microsoft Document Explorer 17 Properties folder 195
migration level 17 PropertyExposeRoot parameter 24,110, 151
mouse PropertyExposeSE parameter 25,110,151
using in session 62
Q
N
gcmd timeout parameter 25
Net asembly 45 QUADNA workspace 48
Net Classes 190
Net Metadata 179
New method 194 R
random link 18
o) registry entries
run-time installation 48
Object CoClasses 183 ResolveOverstrikes parameter 25,128
Object Properties response time limit 18
COM Propetties tab 205 return code 9
Monitor tab 204 Rows (AutoComplete) parameter 145
Net Properties tab 206 run-time
Properties tab 202 applications 41
Value tab 203 bound 43
Objects 185 stand-alone 42
OLEClIient object 179, 182 workspace based 43
OLEServer object 163 run-time applications 39
outlining 219,223 run-time dll 41-43,45-46
output translate table 15 run-time exe 41-44,48
OverstrikesPopup parameter 24,128 RunAsService parameter 25
P S
page width 18,91 SALT 147
PassExceptionsToOpSys parameter 24,57 registry entries 32
pfkey size parameter 24,140 SaveContinueOnExit parameter 25
Popup (session property) 263 SaveLogOnEXxit parameter 25
Posn (session property) 263 SaveSessionOnExit parameter 25
PrefixSize (AutoComplete) parameter 145 section statement 225,231
print configuration dialog 156 Serial parameter 26
header/footer Tab 159 session
margins tab 158 configuring 61,264
printer tab 162 file menu 100
setup tab 156 help menu 113
print precision 17 options menu 110
printing popup menu 114
registry entries 32 session menu 107
private 194 status bar 121
programfolder parameter 24 status field styles 121
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threads menu 112
tools menu 111 T
value tips 92

session action menu 108 TabStops parameter 15,26,143

session colour scheme 79 Threads Tool 248

session log 81, 88 TipObj (session property) 264

session log menu 108 trace tools 240

session menubar 100 trace window geometry 27
action menu 108 trace _cols parameter 27
edit menu 105 trace_first x parameter 27,135
file Menu 100 trace_first y parameter 27,135
help menu 113 Trace level warn parameter 27
log menu 108 trace_offset x parameter 27,135
options menu 110 trace_offset_y parameter 27,135
session menu 107 Trace _on_error parameter 27,237
threads menu 112 trace_rows parameter 27
tools menu 111 tracelevelwarm parameter 142
view menu 106 traceonerror parameter 142
windows menu 106 tracer

session object 26,61,81,107 automatic trace 237

session statusfields 122 break-points 245

session toolbars 116 Classic Dyalog mode 238
edit tools 119 controlling execution 244
object tools 118 invoking 237
session tools 120 naked trace 237
tools tools 119 tracing an expression 237
workspace tools 117 TraceStopMonitor parameter 28

session_file parameter 26,62,81, 138,261 trap control structure 291

SharpPlot Graphics Tools 96 trap system variable 293

Show trace stack on error 237 treeview 219,230

ShowFiles (AutoComplete) parameter 146 Type Libraries 171,179

ShowStatusOnError parameter 26

SingleTrace parameter 26-27,142 U

Size (session property) 263

sm_cols parameter 26,136 underscored characters 70

Sm_rows parameter 26,136 Unicode and Classic Editions 2

SPICE 147,269 Unicode Edition 10,21,24-25,28, 121

sqapl.dll 46-47 UnicodeToClipboard parameter 28,143

sqapl..erf 46-47 urlhighlight parameter 124

sqapl.ini . 46-47 usedefaulthelpcollection parameter 133

State (session property) 264 UseDefaultHelpCollection parameter 28

Status w1nd9w 82,163 user commands 269

StatusOnEdit parameter 26,142 UTIL workspace 36

syntax colouring 154

system error codes 54

system error dialog 24,53,55

system exceptions 54

system operations 62,107,266
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\%

value tips

colourscheme parameter

delay parameter

registry entries
valuetips

registry entries
Version

binding version information
Version information

for a bound executable
view menu

editor

session)

W

WantsSpecialKeys parameter
window expose
windowrects

registryentries
workspace explorer

registry entries
workspace integrity check
workspace size

WorkspaceLoaded (session event)
28,35,48,132

wspath parameter

X

xplookandfeel parameter
xplookandfeeldocker parameter
XVAR function

Y

year 2000 compliance
yy_window parameter

92
124
124

32

32
104

40

218
106

28
18,151

32

31
53

23,33,51

261

28,124
29,124
36

29
29
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